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ABSTRACT

Over 150 million years of mammalian evolution occurred in the Mesozoic. Mammalian
diet knowledge helps us understand the ecological structure of terrestrial communities
and prevailing environmental conditions. Jaws are commonly preserved in the fossil

record and inform on diet. In this thesis, I set out to investigate the relationship between
jaw functional performance and diet in small mammals, using a combination of biomechanics,
geometric morphometrics and phylogenetic comparative methods. Firstly, I used a combined
approach of 2D form and function. I analysed the jaw shape of small extant mammals of known
diets and the mechanical advantage of their adductor muscles. The combination of these data
revealed differences in form and function between herbivores, carnivores, and insectivores. I
found a very good correspondence between previously proposed diets of Mesozoic mammals
and the results of this analysis. Secondly, I wanted to use a 3D approach to the study of jaw
functional performance using Finite Element Analysis (FEA), commonly used in palaeontology
to study feeding behaviour. FEA largely uses tomography-based models, which are expensive
and time-consuming. Therefore, I decided to validate the use of simplified 3D models (called
extruded models) built from photographs using two early mammal jaws as a case study. I found
extruded models to be a viable alternative for large scale FEA studies. Thirdly, I used extruded
FE models to study jaw functional performance in modern small mammals. I found differences in
stress distribution between insectivores, hypercarnivores, mesocarnivores, and herbivores: most
Mesozoic mammals resembled insectivores, and a few hypercarnivores. Put together, modern
small mammals of different diets can be distinguished using jaw shape, mechanical advantage
values, and stress distribution patterns. We can use this information to infer diet in Mesozoic
mammals. Jaw functional performance corroborates the hypothesis that most Mesozoic mammals
were insectivores, and a few taxa were carnivores.
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mechanics. 16, 22, 47, 67

cladotherian Stem-based taxon comprising all the taxa that are more closely related to therian

mammals than to Spalacotherium ([12]). 14

Crown Mammalia see crown mammals. xv, xxiv, 3

crown mammals The group which contains the common ancestor of all living mammals (i.e.,

monotremes, placentals and marsupials) and all its descendants. xxiii, xxiv, 4–6, 8, 65

docodontan Elongated molars with two rows of tall cusps, which are connected by transverse

crests. Characteristic of the Order Docodonta. 4, 30–32, 72, 86, 90

ecomorphological Relates to the interplay between morphology and ecology of an organism.

14, 21, 23

eupantotherian Paraphyletic group encompassing peramurids, amphitheriids and dryolestoids.

xxiii, 6, 11

eupantotherians see eupantotherian. 10

Eutheria The group which contains the common ancestor of extant placentals and all its

descendants. xv, xxiii, xxiv, 3, 6

eutherian see Eutheria. 8, 41
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North America and Eurasia). 6, 8, 10

Mammalia The group containing the common ancestor Sinoconodon and crown Mammalia, and

all its descendants. xv, xxiv, 3

mammaliaform stem-mammal see mammaliaform stem-mammals. 4

mammaliaform stem-mammals Paraphyletic group. Mammalia, minus crown mammals.

These are the earliest mammals, all their representatives are extinct. xv, xxiv, 3, 4, 6, 8, 10,

12, 14, 16

masseter Muscle of mastication, which arises from the zygomatic bone in the skull and attaches

towards the ventral area of the ascending ramus of the mandible. Found only in mammals.

xi, xvi, xviii, xxiii, 12, 15, 21, 27, 34–41, 43, 44, 52, 69, 84, 90, 95

Metatheria The group which contains the common ancestor of extant marsupials and all its

descendants. xv, xxiv, 3, 6

metatherian see Metatheria. 8

metatherians see Metatheria. xxv, 8, 10, 33, 35, 41, 44, 84, 87

morphospace A mathematical representation of a series of morphological traits, as visualised

in a scatter plot. xvii, 24, 27, 30, 32, 33, 35, 72, 73

non-mammaliaform cynodonts Paraphyletic group containing the clade Cynodontia minus

the Mammalia. All their representatives are extinct. 4

non-therian crown mammals Paraphyletic group. Crown Mammalia, minus therians. In-

cludes the extant monotremes and several extinct orders. xv, xviii, 3, 10, 25, 32, 35, 43, 67,

68, 76
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relationships of the organisms studied. 16, 19, 89
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into the coronoid process of the jaw. xi, xvi, xviii, xxiii, 12, 15, 21, 27, 34–38, 40, 41, 43, 44,

52, 69, 84, 90, 93, 95

therian-crown mammals The group which contains the common ancestor of eutherians and

metatherians and its descendants. xv, xviii, 3, 6, 25, 67, 68, 76

trechnotherian The group including Zhangheotherium, therian mammals, their most common
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Monotremata. xv, 3, 6
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1
INTRODUCTION

Two-thirds of the evolutionary history of mammals took place during the Mesozoic (251.9-

66 Mya) [96, 98]. However, most research done into mammalian palaeobiology has been

focused on Cenozoic taxa. The Cenozoic (66-0 Mya), also known as the “Age of Mammals”,

is often portrayed as the era in which mammals, finally free of the constraint of dinosaurs,

diversified and became the dominant vertebrate group on the planet. On the other hand, Mesozoic

mammals were often depicted as rat-like, generalised insectivores living under the shadow of

dinosaurs. Recent discoveries, and research carried out in the past three decades, are gradu-

ally changing this story. In this thesis, I hope to contribute to our understanding of Mesozoic

mammals, from both an ecological and functional standpoint. In this introduction, I present an

overview of our current knowledge about Mesozoic mammals, including their taxonomic and

ecological diversity, their geographic distribution, and evolutionary history. Later, I describe the

biomechanical tools used in this thesis to analyse the dietary behaviour of these mammals, define

my thesis aims, and finish by briefly describing the research chapters presented in this thesis.

The taxonomic terminology used in this thesis is described in the Glossary. Unless specified

otherwise, the term ‘mammal’ will be used to refer to both mammaliaform stem-mammals and

crown mammals.

1.1 An overview of Mesozoic mammals

Mammals are a clade of vertebrates characterised by a series of distinct hard anatomical features,

including a craniomandibular joint formed by the dentary and squamosal, a promontorium

in the petrosal, and well-separated jugular and condylar foramina [98] (Figure 1.1). Fossil

evidence of mammals dates back to the Late Triassic, with some of the oldest examples including

Gondwanadon tapani from the Carnian of India [45] and Adelobasileus cromptoni from the
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Figure 1.1: Comparison of the skull and jaw of a mammal (Hadrocodium, on the left)
and the skull of a non-mammaliaform cynodont (Thrinaxodon, on the right). A) Articu-
lated skull and jaw of Hadrocodium in ventral view, B) Skull of Thrinaxodon in ventral view,
C) Articulated skull and jaw of Hadrocodium in lateral view, D) Articulated skull and jaw of
Thrinaxodon in lateral view. Modified from [98] and [116]

Norian of the United States [112].

Mesozoic mammals were taxonomically and ecologically diverse. During this era, there were

approximately 20 orders of mammals (compared to 31 extant orders), which had an almost

worldwide distribution [98, 156]. Although generally small, Mesozoic mammals had a wide

range of sizes, ranging from shrew-size (e.g., Microdocodon: 5-9 g; [247]) to badger-size (e.g.,

Repenomamus giganticus: 12-14 kg; [88]). Exceptionally preserved fossils show a diversity of

lifestyles, including swimming (Castorocauda, [94]), gliding (Volaticotherium, Maiopatagium,

Xianshou, and Vilevolodon, [122, 144, 145]), fossorial (Fruitafossor and Docofossor, [123, 124]),

and arboreal (Arboroharamiya and Agilodocodon, [146, 246]) forms. Mandibular and dental

morphology also show a diversity of dietary types: carnivory (including piscivory), herbivory,

insectivory and omnivory [30] (Figure 1.2). Here, I present an overview of the diversity of

mammals throughout the Mesozoic (Figure 1.2), including their geographic distribution and most

relevant morphological characteristics.
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1.1. AN OVERVIEW OF MESOZOIC MAMMALS

Figure 1.2: Time-scaled Mesozoic mammal phylogeny at order level. Includes dental
type and suggested diet for the different clades [98]. 1) Mammalia, 2) mammaliaform
stem-mammals, 3) Yinotheria, 4) Crown Mammalia, 5) non-therian crown mammals,
6) therian-crown mammals, 7) Eutheria, 8) Metatheria. Phylogeny based on [38].
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1.2 Mammals throughout the Mesozoic

1.2.1 Late Triassic (Figure 1.3)

Mammals first originated during the Late Triassic. During this time, the mammaliaform
stem-mammal orders Morganucodonta and Haramiyida, as well as the genera Sinoconodon

and Kuehneotherium, inhabited Europe [98]. The morganucodontid Gondwanadon tapani was

also present in India during the Late Triassic [45]. Morganucodontids were all small mammals

(shrew to mouse size: 20-80 g) characterised by the presence of triconodont-like teeth and a

double articulation of the jaw with the skull (dentary-squamosal and quadrate-articular). Like

other mammaliaform stem-mammals, they have a trough on the medial side of the jaw which

accommodates the postdentary bones, which eventually become the middle ear bones in crown
mammals [98].

Haramiyids are mammaliaform stem-mammals characterised by molariforms with complex

occlusal patterns, with two longitudinal rows of multiple cusps [98]; their dental morphology is

indicative of an omnivorous or herbivorous diet [117]. Triassic haramiyids are mostly known from

isolated teeth, except for Haramiyavia for which dentaries and scattered postcranial remains have

been found [117]. There is debate on whether Haramiyavia shows the presence of a postdentary

trough in the mandible, but later Jurassic haramiyids, like Arboroharamiya, lack this structure.

The lack of a postdentary trough indicates the development of middle ear ossicles [143].

Sinoconodon, whose common ancestry with extant mammals defines Mammalia, dates back

to the Rhaetian of France [76]. Like morganucodontids, it also has triconodont-like teeth

which, in Sinoconodon, has been associated with a carnivorous or insectivorous diet. Unlike

morganucodontids, Sinoconodon is placed in a more basal position due to its pattern of tooth

replacement: anterior teeth replaced multiple times, like non-mammaliaform cynodonts, and

postcanines replaced anteroposteriorly like mammals [98, 121].

The oldest records of Kuehneotherium come from the Rhaetian of Saint-Nicolas-de-Port,

France, and consist mainly of isolated teeth [49]. More recently a second genus of kuehneotherid

has been described from the same locality [49]. Kuehneotherium was originally considered a

symmetrodontan, given its reversed triangle molar pattern [98]; however, more recent studies

(e.g., [120]) recognise Kuehneotherium as a mammaliaform stem-mammal.

1.2.2 Early Jurassic (Figure 1.4)

By the Early Jurassic, a new order of mammaliaform stem-mammals joined the morganu-

codontids and haramiyids: the Docodonta. The oldest record of docodonts comes from India

(Gondtherium dattai 1) [174]. Docodonts were a very ecologically diverse group, characterised by

the presence of docodontan molars adapted for an omnivorous or faunivorous diet; however,

1Gondtherium, Dyskritodon, and Indobaatar were found in the Upper Member of the Kota Formation which might
be either Toarcian (Early Jurassic) or Aarlenian (Middle Jurassic) [95]
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1.2. MAMMALS THROUGHOUT THE MESOZOIC

Figure 1.3: Late Triassic distribution of mammals. Countries with known fossils of Triassic
mammals highlighted in orange. Map made with MapChart [149].

docodonts did not diversify taxonomically or ecologically until the Middle Jurassic.

The Early Jurassic also saw the appearance of the crown mammals; particularly, the Eutri-

conodonta and Multituberculata. The eutriconodontans were a very diverse order of mammals

named after their distinctive triconodont molar pattern: three main cusps aligned anteropos-

teriorly. They are also characterised by the lack of both an angular process of the mandible

and a postdentary trough. The taxa belonging to this order are considered to have been mostly

faunivorous, and had a large diversity of body sizes, including some of the largest among Mesozoic

mammals [98]. During the Early Jurassic, they were restricted to India (Dyskritodon indicus1),

but later gained a more widespread distribution across Laurasia [173].

Another group of highly successful mammals appeared during the Early Jurassic: the multi-

tuberculates. At this time, multituberculates were only found in India (Indobaatar zofiae1: [164]),

but would go on to become the single longest lived clade of mammals, as they did not go extinct

until the Late Eocene (38-33.9 Ma). Multituberculates are crown mammals characterised by

their intricate multicusped molar pattern and the complex morphology of their jaws, somewhat

reminiscent of extant rodents; likewise, their skulls were wide and compressed dorsoventrally.

Based on dental complexity studies, multituberculates probably had very diverse feeding prefer-

ences ranging from animal-dominated omnivory to herbivory [239]. Multituberculates were an

exceptionally diverse group of mammals which attained an almost worldwide distribution, with

the exception of Antarctica.

The best well-known fossil material of Kuehneotherium comes from the Early Jurassic of

Wales, which was extensively described by Gill [74], and includes isolated teeth and dentary
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fragments. The feeding ecology of Kuehneotherium has also been studied: Gill et al. [75] found

evidence of niche partitioning between mammaliaform stem-mammals, Morganucodon and

Kuehneotherium, in an Early Jurassic fauna.

1.2.3 Middle Jurassic (Figure 1.4)

All three orders of mammaliaform stem-mammals persisted into the Middle Jurassic. Docodonts

had their heyday during the Middle Jurassic, spreading across Asia and reaching the United

Kingdom. Docodonts were ecologically diverse during this time: putatively piscivorous swim-

ming forms, like Castorocauda, and arboreal forms, like Agilodocodon, were found in China

[94, 142, 146].

New orders of crown mammals evolved, including the Yinotheria (orders Shuotheridia

and Henosferida), as well as the Dryolestida, Amphitheriida and Peramura [98]. Members of

the subclass Yinotheria are grouped together by the presence of the postdentary trough and a

‘clear morphological break’ between the last and second to last premolar [98]. This subclass is

comprised of the order Shuotheridia and the clade Australosphenida: a Gondwanan radiation

of mammals that includes the extant monotremes. Shuotheridians are a Middle to Late Jurassic

order of mammals found only in Laurasia (China, Russia and the United Kingdom) which have

pseudo-tribosphenic molars [119]. On the other hand, australosphenidans are only found on

southern continents and are characterised by the presence of tribosphenic cheek teeth (lost in

extant monotremes), which were acquired independently to the tribosphenic molars of therians

[115]. Among australosphenidans, the order Henosferida is restricted to the Middle Jurassic of

Argentina (Henosferus and Asfaltomylos) and Madagascar (Ambondro) [98, 115].

Three more clades of crown mammals first appeared during the Middle Jurassic: the orders

Dryolestida, Amphitheriida and Peramura. The oldest fossil evidence of these clades has been

found in Morocco (Dryolestida and Amphitheriida, [83]), Ethiopia (possible Peramuran occurence,

[35]), and the United Kingdom (Amphitheriida and possibly Peramura and Dryolestida, [210]).

Both Dryolestida and Peramura persisted well into the Cretaceous, whereas Amphitheriida is

restricted to the Middle Jurassic. These groups are sometimes grouped together on the basis of

their ‘eupantotherian’ cheek teeth and the presence of an angular process in the dentary [98].

1.2.4 Late Jurassic (Figure 1.4)

The Late Jurassic saw the appearance of the therian-crown mammals and, more specifically,

eutherian mammals. The oldest eutherian mammal fossil is Juramaia sinensis, which lived 160

million years ago during the Middle-Late Jurassic in China [125]. Therian mammals comprise

Eutheria (the group which includes modern placentals) and Metatheria (the group which

includes modern marsupials); they are characterised by the presence of tribosphenic teeth

(acquired independently to those of australosphenidans) and viviparity, among many other

skeletal characteristics. Eutherians and metatherians differ in several respects, including the

6



1.2. MAMMALS THROUGHOUT THE MESOZOIC

Figure 1.4: Jurassic distribution of mammals. Top: Early Jurassic, middle: Middle Jurassic,
bottom: Late Jurassic. Countries with known fossils of Jurassic mammals highlighted in orange.
Map made with MapChart [149].
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lack of epipubic bones in most eutherians, the presence of an inflected angle of the mandible in

metatherians, and the extremely altricial newborns in marsupials [98]. During the Late Jurassic,

eutherians were only found in China, but would expand their distribution across Laurasia
during the Cretaceous [98, 125, 142].

1.2.5 Early Cretaceous (Figure 1.5)

In terms of ordinal diversity, the Early Cretaceous was the most successful period of Mesozoic

mammal evolution. All orders of mammaliaform stem-mammals still persisted in this period

(morganucodontans are represented by Purbeckodon, known from isolated teeth only: [25, 50]).

Eutriconodontans had diversified and spread to most of Asia, Europe, Africa and the United

States [98]. The largest Mesozoic mammal ever found, Repenomamus, lived during the Early

Cretaceous in China [88]. Repenomamus is also the only Mesozoic mammal with direct evidence

for carnivory: preserved stomach contents showed this mammal ate a juvenile dinosaur, Psitta-

cosaurus [88]. Multituberculates had also spread across Asia, Europe, Northern Africa, North

America and Australia [98, 188]; likewise, eutherians were now found in North America [34].

Two new families of crown mammals, Spalacotheriidae and Zhangheotheriidae, first ap-

peared in the fossil record of the Early Cretaceous. Earlier studies had grouped them together

(with other taxa, such as the mammaliaform stem-mammal Kuehneotherium) in the clade "sym-

metrodonta", based on their reversed-triangular teeth pattern [98, 211]. Both families are also

characterised by small body sizes, and very slender jaws with no angular process [98]. Later

studies, revealed that symmetrodontans are either paraphyletic or polyphyletic, and that the

families Spalacotheriidae and Zhangheotheriidae are stem trechnotherians [10, 12, 98, 120].

Early Cretaceous spalacotheriidans and zhangheotheriidans have been found in Western Europe,

Eastern Asia and North America; the family Zhangheotheriidae is restricted to the Early Creta-

ceous [12, 98].

Both monotremes [6, 187] and metatherians [17, 47] appeared during the early Cretaceous.

The earliest monotreme found to this date is Teinolophos trusleri (known from several partial

mandibles and an isolated premolar) and, unlike modern monotremes (e.g., the platypus and

echidna), Teinolophos was a toothed monotreme [186]. The order Ausktribosphenida (included

in the clade Australosphenida with monotremes) also dates back to the Early Cretaceous but,

unlike monotremes, fossil material of ausktribosphenidans has only been found in this period.

There are only two genera of ausktribosphenidans, both restricted to Australia: Bishops and

Ausktribosphenos [187].

Even though most modern metatherians (i.e., marsupials) live in Australia, this group

might have originated in China [17]. The oldest metatherian known was thought to have been

Sinodelphys slazayi [118]; however, its identity as a metatherian is now being debated and it is

now thought to have been a eutherian mammal [17]. If that is the case, the oldest metatherian

fossils known are from the late Early Cretaceous of North America (order Deltatheroida) [17, 47].
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Given that the earliest eutherian known are at least 50 million years older, there is a large gap

in knowledge regarding Late Jurassic/Early Cretaceous metatherian fossils [17, 125].

Figure 1.5: Cretaceous distribution of mammals. Top: Early Cretaceous, bottom: Late Creta-
ceous. Countries with known fossils of Cretaceous mammals highlighted in orange. Map made
with MapChart [149].
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1.2.6 Late Cretaceous (Figure 1.5)

By the Late Cretaceous, haramiyids were the only remaining order of mammaliaform stem-
mammals [4]. Among non-therian crown mammals, eutriconodontans and spalacotheriidans

were restricted in distribution to North America [72, 98]. Dryolestids went extinct by the end

of the Early Cretaceous, but the clade Meridiolestida (suggested by some authors to belong to

the clade Dryolestoidea, [32]) was found in South America (as opposed to the Laurasian dis-

tribution of dryolestids) [32, 98]. More recently, the hypothesis that meridiolestidans belong to

the clade Dryolestoidea has been disputed, and meridiolestidans are now thought to be more

closely related to spalacotheriidans [12]. Multituberculates were widespread across Laurasia,

but a couple of records indicate their presence in Madagascar [98, 104]. To this date, there are

no records of Late Cretaceous monotremes [168], but were likely still found in Australia. As far

as we know, most monotremes (with the exception of Monotrematum from the Early Paleocene

of Argentina [165]) remained in Australasia for all their evolutionary history. By the Late Cre-

taceous, the australosphenidans (except for the monotremes) and the ‘eupantotherians’ were

extinct [98, 168]. Eutherians and metatherians were now widespread across North America,

Asia and Western Europe [98]. Out of all the mammalian clades that lived during the Mesozoic,

eutherians, metatherians, monotremes, multituberculates, and meridiolestidans survived the

K/Pg extinction event [32, 98, 159]. Multituberculates survived until the Late Eocene, although

their taxonomic diversity during the Cenozoic was lower than in the Mesozoic [229, 239]. The

fossil record of meridiolestidans spans from the Late Cretaceous to the Early Miocene [32, 159].

Mesozoic mammals were widespread geographically and were taxonomically diverse (over 300

genera spread across around 25 lineages) [98, 113]. Many orders, such as the multituberculates,

haramiyidans, eutriconodontans and docodontans were longer lived (>70 million years) than

most extant mammal orders. Compared to extant mammals, Mesozoic taxa were small, but they

still had a wide range of body sizes: going from approximately 5 grams all the way up to 14

kilograms [88, 98, 247]. Exceptionally preserved fossils of these mammals are prime evidence

that they were more ecologically diverse than once thought [113]; however, the vast majority of

the fossil record of Mesozoic mammals are isolated teeth and jaws. Fortunately for us, teeth and

jaws are the main sources of evidence regarding the diets of mammals. Understanding their diets

contributes to our knowledge of the ecological structure of Mesozoic mammalian communities,

which can, in turn, aid our understanding of the prevailing vegetation and climatic conditions in

these palaeocommunities [30]. So, how can we infer the diets of Mesozoic mammals?

1.3 Feeding ecology in Mesozoic mammals

Direct evidence regarding the diet of Mesozoic mammals is restricted to the preserved stomach

contents of the eutriconodontan Repenomamus robustus, which contained the remains of a juve-

nile dinosaur [88]. Indirect evidence for the diet of the earliest mammals is much more abundant,

10



1.3. FEEDING ECOLOGY IN MESOZOIC MAMMALS

and comes from teeth and jaws.

There are two main ways the diets of Mesozoic mammals have been inferred by using their

teeth: by looking at their overall morphology and by using advanced analytical techniques which

look at the wear and complexity of the occlusal surface (e.g., microwear and orientation patch

count, [26, 60, 232]). By looking at the overall morphology of the teeth of Mesozoic mammals, most

orders are considered insectivores, including most clades with tribosphenic, symmetrodont

and eupantotherian cheek teeth. A few orders, like the Docodonta and Eutriconodonta are

considered to have been more faunivorous (Figure 1.2). The feeding ecology of orders with pairs

of longitudinally-arranged series of cusps, like the haramiyidans and multituberculates [98], has

long been debated and ranges from herbivory to faunivory and omnivory [239].

Microwear analysis and dental complexity allow us to more accurately determine the diets of

individual taxa, and independently corroborate observations made on overall morphology alone.

Dental microwear analysis is used to correlate a microscopic pattern of pits and scratches in the

surface of a tooth with the physical properties of the food items consumed by the individual [26].

This technique has been widely used to infer the physical properties of the food ingested during

the last meals of an animal [147]. Dental microwear has been used to infer the diet of a large

number of mammals, including ungulates, carnivorans, rodents, kangaroos, among others [26].

Among Mesozoic mammals, it has been used in a few taxa, including Morganucodon watsoni,

Kuehneotherium praecursoris [75], and Didelphodon vorax [238]. In both of these studies, extant

taxa of known diets were used as a comparative basis to infer the diets of Mesozoic mammals:

bats in the case of Morganucodon and Kuehneotherium [177], and various small- to medium-sized

marsupials and placentals in the case of Didelphodon [238].

Orientation patch count (OPC) is a measure of dental complexity, which has been shown

to correlate well with feeding ecology in extant rodents, carnivorans and bats [60, 203]. This

technique has been used to infer the diet of Late Jurassic to late Eocene multituberculates.

Late Jurassic to Early Cretaceous taxa were shown to be carnivorous or animal-dominated

omnivores and, towards the latest Cretaceous, multituberculates were mainly herbivores or

plant-dominated omnivores [239]. Although OPC is a powerful tool for inferring diets in extinct

mammals, it requires the teeth to be preserved three-dimensionally and many Mesozoic mammal

teeth are preserved two-dimensionally in flattened slabs [30].

Another source of evidence regarding the dietary performance of mammals is the lower jaw.

Jaw shape has been used to infer diet in Mesozoic mammals by Grossnickle and Polly [80]. This

study found that non-allotherian mammals (i.e., Mesozoic mammals not belonging to the orders

Haramiyida or Multituberculata) and Late Jurassic-Early Cretaceous multituberculates have

similar jaw shape to extant faunivorous taxa, while Late Cretaceous multituberculates are

more akin to extant herbivores.

Biomechanical analyses have also been used to study the feeding ecology of mammals. Of

special relevance is the study by Gill et al., [75], who used a suite of biomechanical techniques
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to study niche partitioning between the Early Jurassic mammaliaform stem-mammals Mor-

ganucodon and Kuehneotherium. Their study used three biomechanical techniques: mechanical

advantage, finite element analysis and second moment of area. Below I describe in detail the first

two analyses, as they form the basis for this thesis.

1.4 Mechanical advantage

A lever is a system consisting of beam-like object rotating around a fixed point, with the purpose

of transmitting energy from one point of the beam to another (Figure 1.6). There are three main

parts of a lever: the fulcrum (i.e., fixed point), the effort (or input force) acting upon the system

and the load (or resistance) placed upon the system [138]. There are three types of lever, defined

by the position of the fulcrum, effort and load relative to each other. First-class levers have the

fulcrum placed between the effort and the load (e.g., seesaw and scissors), second-class levers

have the load placed between the fulcrum and the effort (e.g., wheelbarrow and nutcracker), and

in third-class levers the effort is located between the fulcrum and the load (e.g., tweezers and

hammer) [14]. Jaws function as a lever system: a beam-like bone rotates around a fixed point

(the jaw condyle), to transmit energy input by the jaw-closing muscles (i.e., adductor muscles)

at the back of the jaw, to the bite point towards the front of the jaw. With the exception of some

rodents, the mammalian jaw is generally regarded to work as a third-class lever [40].

Levers transmit a force input into the system (e.g., jaw adductor muscle input force) to provide

a greater output force (e.g., bite force) to displace a load (e.g., food); this is known as leverage.

The ratio of these two forces is known as mechanical advantage. Another way to describe the

leverage of a system is by calculating the velocity ratio of a lever, which is calculated by dividing

the length of the in-lever (i.e., distance moved by the effort) by the length of the out-lever (i.e.,

distance moved by the load). In the case of the mammalian jaw, it corresponds to the moment arm

of the adductor musculature (i.e., temporalis, masseter and pterygoid) divided by the distance

from the jaw condyle to the biting point [75, 87] (Figure 1.7). In an ideal system with no energy

losses, mechanical advantage and velocity ratio are equivalent. Therefore, the former is often

known as actual mechanical advantage and the latter is known as ideal mechanical advantage

[14]. Leverage represents a trade-off between force production and speed: higher mechanical

advantage values denote a system with a higher force output and lower values indicate a system

optimised for speed. Changing the length of the in- and out-levers (and therefore the position of

the effort and load relative to the fulcrum) will alter the leverage of a system for increased speed

or force output [14].

Animals can optimise their speed or force output for feeding by using different strategies: the

length of the jaw, the relative position of the condyle, the length of the coronoid process and the

presence of an angular process, among others, are all different means to modify the mechanical

advantage of the jaw. Skulls and jaws optimised for either speed or force production relate to the
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Figure 1.6: Types of lever. This diagram describes the three different types of lever and explains
how the mammalian jaw works as a third-class lever using a dog biting on a tennis ball as an
example.

dietary behaviour of the animals. For example, extant parrots (Order Psittaciformes) optimise

their short beaks for force production (i.e., high mechanical advantage) for cracking/ripping

tough seeds, while sand-pipers, snipes and phalaropes (Order Scolopacidae) optimise their long

beaks for faster bites (i.e., low mechanical advantage) and for probing in sediment for small prey

[154]. Within different lizard families, herbivorous species have higher mechanical advantage

values than carnivorous species [217] and among natricine snakes, piscivore species have lower

mechanical advantage (and faster gapes) than frog-eating snakes [85].

Mechanical advantage studies have also been performed in mammals, both modern and

extinct. Among extant mammals the relationship between diet and mechanical advantage has

been studied in primates [101, 231], squirrels [27, 102], bats [57, 202], otters [223], and bears
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Figure 1.7: Graphical representation of mechanical advantage, shown in A) a traditional
third-class lever, and B) the mammalian jaw.

[199], among others. By establishing a relationship between mechanical advantage and feeding in

certain extant clades, the dietary behaviour of closely related extinct taxa can be assessed using

this functional parameter. Such studies include the analysis of the killing behaviour of sabertooths

[59], the feeding behaviour of dire wolves [5], the dietary evolution of giant armadillos [48], and the

feeding habits of early Miocene South American ungulates [28]. Mechanical advantage data has

also been used in functional studies of Mesozoic mammal jaws. Among these, Gill et al. [75] used

comparative mechanical advantage data to study the feeding behaviour of mammaliaform stem-
mammals Morganucodon and Kuehneotherium, Grossnickle [78] analysed the yaw and pitch in

the jaws of cladotherian mammals, and Benevento et al. [16] studied the ecomorphological
disparity of mammals along the Mesozoic/Cenozoic transition.

1.5 Finite Element Analysis

Another way of analysing how a system (in this case the mammalian jaw) responds to its envi-

ronment, is to use an engineering-based technique called Finite Element Analysis (FEA) [183].

This computational technique is commonly used in the design of aircraft, buildings, cars, among

other things, to understand how these structures would interact with their surroundings. For

example, if a large number of lorries were to cross a bridge at the same time: how much stress

and deformation would the structure be subjected to? Would the bridge remain intact under

the weight or would it collapse? The intricacy of structures such as these makes it difficult to

readily evaluate how they would perform when subjected to a complex loading scenario. By using

the Finite Element Method (FEM), we can break down these complex structures into a discrete

number of units, whose response to loading can be more easily assessed using mathematical

equations [52, 100].

FEA is a computational method which involves several stages (Figure 1.8, also see Appendix

E for a more detailed explanation of the process). First, we need a digital representation of the
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structure of interest, which can be 2D or 3D. Biological FE models in 2D are generally built from

photographs and 3D models are typically built from tomographic data. These models can be built

in a variety of software: 2D models are built in computer-aided design (CAD) software (e.g., Au-

todesk Inventor) or 3D computer graphic software (e.g., Blender [Blender Foundation], Autodesk

Maya [Alias System Corporation]), while 3D models are built in tomographic visualisation and

analysis software (e.g., Avizo [Thermo-Fisher Scientific], Mimics [Materialise NV], 3D Slicer [The

Slicer Community], Dragonfly [ORS], among others). Once the model has been built, it is then

imported into computer-aided engineering and finite element analysis software (e.g., HyperMesh

[Altair Engineering] and/or Abaqus [Simulia]).

The second stage involves breaking down the structure into a series of smaller interconnected

units: this is called meshing. A mesh consists of a series of elements of known shape and size and

the points in which elements are connected to each other are known as nodes. Mesh convergence

tests are needed to determine the ideal number of elements present in a mesh (i.e., mesh density)

[23]; this entails running a series of analyses where everything remains equal except for the

number of elements. The ideal number of elements will be achieved when the results of the

analysis remain relatively similar despite increasing the number of elements.

During the third stage, the material properties of the structure of interest are assigned to the

model. In the case of bone, the elastic material properties Young’s modulus and Poisson’s ratio

are specified. Young’s modulus is the relationship between stress and strain of the material; it

is a measure of stiffness. Poisson’s ratio describes the transverse strain (perpendicular to the

direction of loading) of a material relative to its axial strain (in the direction of loading): it is

the ratio of relative contraction to relative expansion of a material. For example, when a rubber

band is stretched it contracts perpendicular to loading and expands in the direction of loading;

this relative expansion and contraction is known as Poisson’s effect and is numerically expressed

as Poisson’s ratio. The Poisson’s ratio of cortical bone ranges between 0.15 and 0.45, but it is

typically set to 0.3 [198].

The fourth stage consists of indicating the points along the structure where movement will

be impaired, these are known as boundary conditions. For example, the movement of a jaw will

be restricted to particular degrees of freedom at the articulation with the skull and at the bite

point. The fifth stage involves assigning virtual loads to the model. It is important to note that

‘loading’ in FEA and the load on a lever (in the mechanical advantage section) refer to different

things; loading in the construction of FE models is actually equivalent to the ‘effort’ in a lever

system. By assigning loads to an FE model, we virtually replicate the pull of the adductor
muscles of the mandible (i.e., temporalis, masseter and pterygoid): we need to specify both

the direction and the force (in Newtons) these muscles are pulling with. Taking into account the

geometry and material properties of the structure, the last stage of the FEM is to analyse how

the model responds to the loads and boundary conditions applied upon it. Generally, data on

stress, strain and deformation are used to assess the performance of the structure. There are
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two ways of visualising these parameters: graphically using ‘heatmaps’ (see Figure 1.8, step 6)

that indicate where the highest or lowest areas of stress or strain are located in the structure,

or numerically (the FE software being used can generate a spreadsheet with individual stress,

strain and deformation values by element or node).

This numerical output can be further analysed using different approaches. Descriptive statis-

tics, including measurements of central tendency (e.g., mean, median), are generally presented

to summarise the overall stress and strain experienced by the structures. Such measurements,

however, are not informative unless the mesh used is homogeneous in size; Marce-Nogue et al.,

[130] proposed the alternative ‘mesh-weighted arithmetic mean’ which accounts for the element

size heterogeneity of the mesh. More recently, Marce-Nogue et al., [131] introduced the ‘intervals

method’, which presents a new way of analysing FEA output data. This method sorts the ele-

ments in the mesh based on their stress values and assigns them to particular intervals of known

volume, allowing the FEA output to be analysed in a multivariate comparative framework. This

output can then be analysed using other methods such as linear discriminant analysis. This

method has been successfully used to discriminate between different feeding ecologies among

armadillos [131] and to elucidate the mode of life of the primate, Paralouatta [178].

The use of FEA in biomechanics has been widely validated [21], using both in vivo (e.g.,

[44, 136, 148, 171]) and ex vivo (e.g., [22]) data from modern animals. The precision which

models should be built with has also been thoroughly tested, including the choice of material

properties, mesh generation and density, boundary conditions, and loading, among others (e.g.,

[23, 105, 132, 161, 193, 218, 227]).

Finite Element Analysis has mainly been used to evaluate the mechanical performance of the

skull and jaw of a broad number of extinct and modern species; to a lesser extent, the mechanical

performance of limb elements has also been assessed (Table 2). In particular, FEA has been

performed on Mesozoic mammal cranial material, but these studies are scarce. Firstly, Gill et al.,

[75] analysed the biomechanical performance of the jaws of mammaliaform stem-mammals
Morganucodon and Kuehneotherium with the aim of elucidating their dietary behaviour. A sec-

ond study using FEA, explored how the miniaturisation of the mammalian jaw influenced the

evolution of the middle ear [110]. Finally, Adams and colleagues (2019) studied the skull and

jaw performance of the multituberculate Kryptobaatar as a means of testing the competitive

exclusion hypothesis for the extinction of multituberculates [2].

1.6 Thesis aims, objectives, and chapter breakdown

1.6.1 Thesis aims

The main aim of this thesis is to infer diet in Mesozoic mammals by analysing their jaw shape

and functional performance, using a combination of biomechanical techniques, geometric mor-
phometrics and phylogenetic comparative methods. To do so, small extant mammals of
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Figure 1.8: Generalised summary of the stages of Finite Element Analysis, using the jaw
of a dog biting at the canine as an example.
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Study material Description of the study Reference
Extant taxa

Skull Mechanical performance of the skull of crocodilians [169]
Mastication mechanics of catarrhine primates [192]

Functional evolution of the feeding system of rodents [41]
Feeding behaviour of marmosets and tamarins [55]

Feeding behaviour of bats [56]
Feeding behaviour of bears [212]

Jaw Bite force capabilities of the great white shark [242]
Digestive physiology of ungulates [67]
Dietary behaviour of armadillos [209]
Dietary behaviour of primates [134]
Dietary behaviour of ungulates [248]

Extinct taxa
Skull Feeding ecology and biting capabilities of Miocene piranhas [82]

Dietary behaviour of capitosaurs [71]
Mode of life and feeding strategies of temnospondyls [70]

Cranial mechanics of theropods [180–182, 184]
Bite force and cranial biomechanics of the largest fossil rodent [42]

Dietary behaviour of Australopithecus [219]
Feeding behaviour of the thylacine [241]

Feeding behaviour of the marsupial lion [240]
Feeding behaviour of giant bear Agriotherium africanum [158]

Jaw Dietary behaviour of Acanthostega and other tetrapodomorph jaws [155]
Dietary behaviour of an Upper Jurassic pliosaur [68]

Dietary behaviour of the giant hyena-like carnivore Dinocrocuta [225]
Mechanical performance of ceratopsid dinosaur jaws [127]

Limb elements Hindlimb posture and locomotion in extinct tetrapods [18]
Hindlimb posture and locomotion in extinct theropods [19]

Analysis of the prey dispatching capabilities of dromaeosaurid claws [128]
Functional study of the tyrannosaurid arctometatarsus [214]

Fossil trackways Analysis of the formation of fossilised trackways [62, 62, 135]

Mesozoic mammals
Skull & jaw Skull and jaw performance of the multituberculate Kryptobaatar [2]

Jaw Dietary behaviour of Morganucodon and Kuehneotherium [75]
On the miniaturisation of the mammalian jaw & the evolution of the middle ear [110]

Table 1.1: Select examples of FEA studies in vertebrates. Includes studies on extinct and
extant taxa (highlighting those on Mesozoic mammals) focusing on either the skull, jaw, limb
elements or fossilised trackways.

known diets are used as a comparative basis. This thesis aims to study diet in Mesozoic mammals

because two-thirds of the evolutionary history of mammals took place during this era; therefore,

understanding the ecology of these extinct mammal lineages is key to our knowledge of Mesozoic

palaecommunities and underpins our knowledge of the later Cenozoic burst in mammalian

diversity.

1.6.2 Thesis objectives

• Chapter 2:
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– To establish a relationship between jaw shape and diet in small extant mammals,

using 2D geometric morphometrics

– To explore the relationship between mechanical advantage and diet among extant

mammals

– To use our knowledge of how jaw shape and mechanical advantage relate to diet

in extant mammals to infer the diets of Mesozoic mammals, using Principal Com-

ponents Analysis and phylogenetic comparative methods, such as phylogenetic

generalised least squares regressions

• Chapter 3:

– To validate the use of the novel extruded FE models (i.e., simplified 3D models built

from photographs) for their use in Finite Element Analysis

• Chapter 4:

– To explore the relationship between jaw functional performance and diet in extant

mammals using Finite Element Analysis

– To analyse FEA stress output data in a comparative multivariate framework using

the recently developed Intervals Method

– To infer diet in Mesozoic mammals by comparing their jaw stress distribution with

those of extant mammals of known diets.

• Chapter 5:

– To discuss the findings of the previous research chapters, in terms of the contribution

of this thesis to our knowledge of Mesozoic mammals and in terms of the use of

biomechanical techniques for the study of mammal diets.

1.6.3 Chapter breakdown

Chapter 2 explores the relationship between jaw shape, mechanical advantage and diet in

small extant mammals, with the purpose of using these data to infer diet in Mesozoic mammals.

Establishing proxies for diet is our paramount importance, since ecological traits such as diet

are essential for better understanding Mesozoic community dynamics. Here, jaw shape analysis

is performed with 2D geometric morphometrics, using a combination of fixed landmarks

and sliding semi-landmarks. This study is based on the paper by Grossnickle and Polly [80]

and expanded to include a functional metric (i.e., mechanical advantage). The relationship

between jaw shape and diet is tested in a phylogenetic context using Procrustes ANOVAs. Finally,

using these two metrics, a phylogenetic flexible discriminant analysis is performed to infer

probable diets in Mesozoic mammals. The results indicate that the combination of jaw shape and
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mechanical advantage data is a powerful predictor of diet among small mammals and thus we

can use these proxies for confidently inferring diet in Mesozoic mammals. The findings of this

study corroborate the hypothesis that most Mesozoic taxa were insectivorous, but some clades

(e.g., eutriconodontans) had a carnivorous diet. This chapter has been submitted for publication

in Nature Communications Biology (Morales-García et al., 2020).

Chapter 3 presents a validation study on the use of simplified 3D jaw models for FEA,

henceforth called “extruded FE models”. Traditionally, 3D FE models are built using tomography

data, which can be expensive and sometimes inaccessible. Here I devise the novel extruded FE
models, which are relatively easy and quick to produce, and are built using only photographs in

freely available software. The utility of these models was then validated using Early Jurassic

mammals Morganucodon and Kuehneotherium by comparing their resulting stress and strain

with those of Gill et al., [75]. I find that extruded FE models can closely replicate stress patterns,

as well as absolute stress and strain values (in comparison to those obtained from tomography-

based models), and their ease of building proves ideal for performing large scale studies. This

validation study is published as Morales-García, N. M., Burgess, T. D., Hill, J. J., Gill, P. G.,

& Rayfield, E. J. (2019). The use of extruded finite-element models as a novel alternative to

tomography-based models: a case study using early mammal jaws. Journal of the Royal Society

Interface, 16(161), 20190674.[150]

Chapter 4 presents a large-scale study on the biomechanical jaw performance of extant small

mammals and Mesozoic mammals. Having validated the use of extruded FE models in Chapter 3,

this chapter uses these models to perform FEA. First, I explore the relationship between stress

distribution in the jaws of extant mammals and their dietary preferences, using the Intervals

Method of Marcé-Nogué et al., [131]. I found that stress distribution patterns in the jaws of small

mammals can distinguish between insectivores, mesocarnivores, hypercarnivores and herbivores.

Having established this relationship, I compare the resulting stress distribution in the jaws

of Mesozoic mammals to those of modern mammals, with the purpose of inferring the diets of

the extinct taxa: most Mesozoic mammals have stress distribution patterns similar to modern

insectivores and a few taxa are similar to modern placental hypercarnivores. As in Chapter 2,

this study seeks to establish new proxies for diet among small mammals, in order to enrich our

knowledge of Mesozoic community dynamics. Additionally, this chapter aims to identify functional

traits unique to different dietary groups which can be used to not only study Mesozoic mammals,

but other clades of small mammals. This study was performed in collaboration with former MSc

student Kit Lam (Wilfred) Tang and has been submitted to PLoS Biology as Morales-García, N.
M., Tang, K.L., Gill, P.G., Janis, C.M., and Rayfield, E.J.

Chapter 5 presents a summary of all the key findings of the previous chapters, and explores

future perspectives.
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JAW SHAPE AND MECHANICAL ADVANTAGE ARE INDICATIVE OF

DIET IN MESOZOIC MAMMALS

This chapter has been accepted in Nature Communications Biology as: Morales-Garcia,
N.M., Gill, P.G., Janis, C.M., and Rayfield, E.J. 2021. Jaw shape and mechanical advan-

tage is indicative of diet in Mesozoic mammals.

Nuria Melisa Morales co-designed the study, collected the data, ran the analyses, and wrote the

manuscript. Pam Gill, Christine Janis and Emily Rayfield contributed to the design of the study,

supervised the project and commented on the manuscript.

2.1 Abstract

Jaw morphology is closely linked to both diet and biomechanical performance, and jaws are one

of the most common Mesozoic mammal fossil elements. Knowledge of the dietary and functional

diversity of early mammals informs on the ecological structure of palaeocommunities throughout

the longest era of mammalian evolution: the Mesozoic. Here, we analyse the relationship between

form and function in the jaws of 70 extant and 45 extinct mammals spanning the Late Triassic-

Late Cretaceous, using geometric morphometrics and mechanical advantage of the masseter
and temporalis. In extant mammals, jaw shape discriminates well between dietary groups.

Mechanical advantage values on their own are not very informative of dietary ecology. The

combination of both metrics provides a clear separation between insectivores, carnivores and

herbivores. This relationship is informative of diet among Mesozoic mammals. We provide

an explanation for this difference in jaw shape and function, which sets the basis for future

ecomorphological studies.
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2.2 Introduction

Our understanding of Mesozoic mammals has drastically improved in the past three decades.

Once thought to have been conservative in locomotory modes and dietary preferences, Mesozoic

mammals are now considered to have been more ecologically diverse [30, 96, 98]. In a similar

fashion, it was thought that they were restricted to small sizes (< 5 kg), but some taxa, like

Repenomamus giganticus (approx. 12-14 kg) indicate greater body size diversity among Mesozoic

mammals [88, 96, 98]. Fossils of complete skeletons reveal a diversity of locomotor lifestyles, in-

cluding swimming, gliding, fossorial, and arboreal forms; craniodental morphology also indicates

a diversity of diets (see [81, 113] and references therein). The majority of the evolutionary history

of mammals (127 million years [ 65%]) took place during the Mesozoic [98], and so the study of

Mesozoic mammal evolution also underpins our understanding of their later radiation. Although

the most abundant remains of Mesozoic mammals are their teeth, lower jaws are also relatively

common. Study of jaw shape and jaw biomechanics can increase our understanding of their

dietary and functional evolution, and has the potential to contribute to our knowledge of the

ecological structure of Mesozoic mammalian communities, in turn aiding our understanding of

the prevailing vegetation and climatic conditions [30].

Ecomorphological analyses, which study potentially predictive relationships between organ-

ismal morphology and ecology (see ref. [63] for review), are one approach to the study of the

dietary preferences of Mesozoic mammals. Such analyses have widely been used in mammals; in

particular, the correlation of jaw morphology with dietary preferences. For example, the position

of the condyle with respect to the tooth row [43]; the dimensions of the jaw (e.g., the length of the

diastema and the coronoid process, and the depth of jaw ramus) [93]; and the predominance of

one or other of the adductor muscles [233] have all been used to inform on diet. With respect

to Mesozoic mammals: morphometry-driven approaches include landmark-based geometric
morphometrics studies on jaw shape (e.g., [80]), and functionally-informed studies include

analyses of jaw ratios (e.g., [16]), jaw mechanics and tooth wear [75]. For example, Grossnickle

and Polly [80] compared the jaw shapes of extant and Mesozoic mammals and found a clear

separation between Mesozoic herbivores (multituberculates) and those with other diets. Gill et al.

[75] employed a suite of biomechanical techniques to show diverging dietary preferences in an

Early Jurassic faunal assemblage, between stem mammals Morganucodon and Kuehneotherium.

More recently, Grossnickle [79] analyzed a comprehensive set of functional metrics in the jaws

of extant therian mammals and identified a set of characteristics distinguishing herbivorous

from faunivorous taxa across different clades, including the size of the angular process and the

length of the posterior portion of the jaw.

Here we use a combination of morphometric- and functionally-driven approaches to study the

relationship between mechanical advantage (used as a proxy for adductor muscle performance)

and jaw shape in Mesozoic mammals and small extant mammals. Mechanical advantage is the

ratio of the length of the in-lever (i.e., lever arm of the muscle) divided by the length of the
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out-lever (i.e., distance from the jaw condyle to the biting point) (see Fig. 2.3b) [75, 87], and so is

a measure of the performance of the adductor muscles (i.e., how much force is produced at the

bite point as a result of force being input by the muscles). A high mechanical advantage indicates

a jaw optimized for bite force, while a low mechanical advantage indicates a jaw optimized for

closure at speed. This metric has been used to study adductor muscle performance in Cenozoic

mammals (including extant taxa) such as carnivorans (e.g., [5]), rodents (e.g., [27]), and bats (e.g.,

[201]), among others. Comparative mechanical advantage of the jaw (or a similar biomechanical

metric) has been used as a proxy for prey choice and feeding ecology in stem mammals [75], to

study the yaw and pitch of the jaws of Mesozoic therian mammals and relatives [78], and to

analyze ecomorphological disparity during the Mesozoic/Cenozoic transition [16].

The aim of our study is to determine whether there is a large-scale functional relationship

between shape and function in the jaws of small mammals that could be used as an ecomor-
phological proxy to elucidate the dietary preferences and behavior of Mesozoic taxa. While

the jaw shapes of many multituberculates indicate a herbivorous or omnivorous diet [80], there

is no clear consensus on the diets of many Mesozoic taxa typically considered as “generalized

Figure 2.1: Summary of the phylogeny used in this study. Overall topology from refs. [38,
91]. Other references in Methods section. Red crosses indicate clades not included in the study.
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insectivores”. Here we include only such generalized taxa (Fig. 2.1) and exclude multitubercu-

lates and haramiyidans. We use extant taxa of small mammals of known diets to explore the

relationship between jaw shape and mechanical advantage, and to evaluate suitable proxies for

diet in Mesozoic mammals. A list of taxa used in this study is presented in Table 2.1.

2.3 Materials and Methods

2.3.1 Materials

For a diagram of the methods used in this paper, refer to Figure 2.2. We used photographs of

the jaws of 70 small extant mammals and 45 extinct Mesozoic mammalian taxa spanning the

Late Triassic to the Late Cretaceous. The full list of taxa can be seen in Table 2.1. The extant

taxa chosen for this study (29 marsupials in six orders, 41 placentals in six orders) are based

on those used in Grossnickle and Polly [80]; new taxa were added for greater taxonomic and

dietary diversity. Following ref. [31], most extant mammals in our sample weigh under 5 kg as

most Mesozoic mammals were under this body mass threshold. Five extant species over 5 kg

were included in the sample (i.e., Sarcophilus harrisii, Lynx rufus, Lontra canadensis, Taxidea

taxus and Procyon lotor) to reflect the upper body size limit of larger Mesozoic mammals such as

Repenomamus (12 to 14 kg, [88]).

For this study, we chose to exclude the Mesozoic haramiyids and multituberculates, and only

to focus on non-allotherian Mesozoic taxa. Grossnickle and Polly [80] had previously deter-

mined that the jaw shape of multituberculates is different from other non-allotherian Mesozoic

mammals. We attempted to include allotherians of different diets in the sample, but they all

plotted in their own area of morphospace, far away from other non-allotherian Mesozoic

mammals. They were also dissimilar to any extant mammals in our sample (Fig. A.5). Compared

to non-allotherian Mesozoic mammals and extant mammals of different diets, multituberculates

and haramiyids had higher mechanical advantage values, which skewed posterior analyses and

prevented us from seeing clear differences between dietary groups among extant mammals (Fig.

A.9). Allotherians have a very derived jaw morphology, dissimilar to other Mesozoic mammals

and extant small mammals, they also had palinal jaw movements, unlike any other extant or

extinct mammal [103], which could lead to a unique biomechanical biting performance. Therefore,

we decided to exclude allotherians from this sample, with the exception of Haramiyavia, which is

probably not closely related to later Jurassic euharamiyids, following ref. [99].

Photographs of extant mammal jaws were obtained from the online databases: Animal Diver-

sity Web (ADW) of the University of Michigan [153] (https://animaldiversity.org), the Natural

History Museum (NHM) online database (https://data.nhm.ac.uk) and the Field Museum online

database (https://collections-zoology.fieldmuseum.org). For a detailed list of the extant mammal

specimens used in this study refer to Table 2.1 and S2 Data. All photographs were reviewed by

NMMG to ensure the jaws were all captured in the same orientation; some photographs were
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rotated in order to have the horizontal ramus of the jaw parallel to the x axis.

The extinct taxa considered in this study include ten stem mammals, 19 non-therian crown
mammals, and 16 therian-crown mammals. Photographs were primarily obtained from the

literature (for a full list of the literature used to source these photographs refer to Supplementary

Data 1). Additionally, photographs were taken from specimens held at the Institute of Paleobiol-

ogy, Polish Academy of Sciences (Warsaw, Poland), at the Oxford University Museum of Natural

History (Oxford, United Kingdom), at the Natural History Museum (London, United Kingdom),

and at the Steinmann Institut, Universität Bonn (Bonn, Germany). Photographs were taken by

NMMG.

Dietary information for extant taxa was obtained from the Animal Diversity Web [153].

Proposed dietary preferences for Mesozoic mammals were obtained from the literature. The full

list of taxa, their dietary preferences, and the detailed sources of this information can be seen in

Tables A.1, A.2 and A.3 in Appendix A and in S2 Data. While no Mesozoic mammals specialized

for herbivory (i.e., some multituberculates and haramiyidans) were included in our sample, we

decided to include some extant herbivores whose jaw morphology is not as derived as that of

rodents for comparative purposes.

Figure 2.2: Summary of the methods, figures and tables presented in this paper.
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Extinct mammals Extant mammals
Stem mammals Marsupialia Placentalia

1 Haramiyavia Diprotodontia Scandentia
2 Sinoconodon 46 Bettongia penicillata 75 Tupaia splendidula
3 Morganucodon 47 Potorous tridactylus 76 Tupaia dorsalis
4 Dinnetherium 48 Thylogale billardierii 77 Tupaia glis
5 Castorocauda 49 Dendrolagus goodfellowi Carnivora
6 Haldanodon 50 Dorcopsulus vanheurni 78 Nandinia binotata
7 Docofossor 51 Petaurus breviceps 79 Leopardus wiedii
8 Docodon 52 Pseudocheirus peregrinus 80 Lynx rufus
9 Agilodocodon 53 Acrobates pygmaeus 81 Felis margarita

10 Microdocodon 54 Phalanger orientalis 82 Prionodon pardicolor
Non-therian crown mammals 55 Trichosurus vulpecula 83 Genetta genetta
11 Fruitafossor Dasyuromorphia 84 Paradoxurus hermaphroditus
12 Henosferus 56 Dasyurus hallucatus 85 Fossa fossana
13 Teinolophos 57 Dasyurus geoffroii 86 Galidia elegans
14 Phascolotherium 58 Sarcophilus harrisi 87 Crossarchus oscurus
15 Yanoconodon 59 Parantechinus apicalis 88 Herpestes javanicus
16 Triconodon 60 Phascogale tapoatafa 89 Lycalopex griseus
17 Trioracodon 61 Antechinus swainsonii 90 Vulpes corsac
18 Volaticotherium 62 Antechinus flavipes 91 Mephitis macroura
19 Argentoconodon 63 Sminthopsis crassicaudata 92 Conepatus humboldtii
20 Gobiconodon 64 Planigale ingrami 93 Nasua narica
21 Repenomamus 65 Myrmecobius fasciatus 94 Bassaricyon gabbii
22 Spalacotherium Peramelemorphia 95 Procyon lotor
23 Origolestes 66 Perameles gunnii 96 Taxidea taxus
24 Zhangheotherium Microbiotheria 97 Eira barbara
25 Maotherium 67 Dromiciops gliroides 98 Lontra canadensis
26 Crusafontia Didelphimorphia 99 Mustela nivalis
27 Amblotherium 68 Philander andersoni Chiroptera
28 Amphitherium 69 Chironectes minimus 100 Pteropus vampyrus
29 Vincelestes 70 Metachirus nudicaudatus 101 Noctilio leporinus

Therian crown-mammals 71 Marmosa robinsoni 102 Artibeus jamaiciensis
30 Deltatheridium 72 Monodelphis americana 103 Chrotopterus auritus
31 Didelphodon 73 Caluromys derbianus 104 Myotis lucifugus
32 Eodelphis Paucituberculata 105 Plecotus auritus
33 Alphadon 74 Rhyncholestes raphanurus Eulipotyphla
34 Sinodelphys 106 Blarina brevicauda
35 Juramaia 107 Atelerix albiventris
36 Eomaia 108 Parascalops breweri
37 Maelestes 109 Solenodon paradoxus
38 Asioryctes Afrosoricida
39 Sasayamamylos 110 Microgale cowani
40 Kennalestes 111 Microgale brevicaudata
41 Daulestes 112 Tenrec ecaudatus
42 Uchkudukudon 113 Potamogale velox
43 Kulbeckia Macroscelidea
44 Barunlestes 114 Elephantulus rufescens
45 Zalambdalestes 115 Elephantulus brachyrhynchus

Table 2.1: Complete list of all the taxa used in this study. Taxa numbers used in Figures
2.4, 2.7, and 2.8
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2.3.2 Methods

2.3.2.1 Phylogenetic Information

We built a phylogeny in Mesquite incorporating all the taxa used in this study (see the Figs.

A.1, A.2, A.3, and A.4. The overall topology of the phylogeny of the Mesozoic taxa was from

refs. [38, 91]; additional sources were used to refine the position of Haramiyavia [99], and the

phylogenetic relationships within Morganucodonta [146] Docodonta [247], Australosphenida

[197], Eutriconodonta [73, 113], Symmetrodonta [129], Dryolestidae [11], Metatheria [237], and

Eutheria [7, 8, 17, 106]. Similarly, the overall topologies of the Placentalia and Marsupialia

phylogenies were obtained from refs. [215] and [137], respectively. Supporting literature was

needed to account for all taxa included within Scandentia [190], Carnivora [157], Chiroptera [3],

Eulipotyphla [216], and Afrosoricida [208].

The phylogeny was time-scaled using the ‘equal’ method of Brusatte et al., [24] using the

package ‘paleotree’ 3.3.0 [13] in RStudio 1.2.1335 (RStudio team). Appearance dates for extinct

taxa were obtained from the Paleobiology Database (http://fossilworks.org) and ref. [197]. Diver-

gence dates to constrain the nodes were obtained from a diversity of phylogenies of Mesozoic taxa

[38, 91, 99], Marsupialia [137], Scandentia [190], Carnivora [157], Chiroptera [3], Eulipotyphla

[216], Afrosoricida [172] and Macroscelidea [213].

2.3.2.2 Geometric Morphometrics

We performed a 2D geometric morphometrics study using fixed landmarks and sliding semi-

landmarks in the jaws of small extant and extinct Mesozoic mammals. We used the same fixed

landmarks as Grossnickle and Polly [80], with the exception of landmark 7 (i.e., posteroventral-

most point of the angular process). We removed this from our analysis because many taxa in our

study did not have an angular process. Additionally, we incorporated 58 sliding semi landmarks

as seen in Figure 2.3. All jaws were landmarked using TPS software by Rohlf [191]: tpsUtil

was used in the construction of a file containing all images to landmark, tpsDig was used to

digitize landmarks and semi-landmarks, and tpsRELW was used for Procrustes alignment and

relative warp analysis. The resulting XY coordinates for the extant data were submitted to a

Principal Components Analysis (PCA) in RStudio, using the package ‘geomorph’ [1]; convex hulls

were drawn to indicate the morphospace occupation of the different dietary categories. The

Mesozoic mammal jaw shape data was then projected onto the extant mammal morphospace by

multiplying their XY coordinates by the PC variable loadings of the extant taxa (i.e., PC rotation

scores).

2.3.2.3 Mechanical Advantage

We measured the moment arms of resistance at the m1 and at the anterior end of the jaw, as

well as the lever arms of the temporalis and masseter muscles in ImageJ following Figure 2.3
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(modified from ref. [5]); these measurements roughly estimate the lever arms of both superficial

and deep heads of the adductor muscles of the jaw. The lever arm of the medial pterygoid muscle,

although not considered here, is probably very similar to that of the masseter. The approach taken

here represents an oversimplification of muscle architecture and does not take into consideration

any features of skull morphology that might change the lever arms of the adductor muscles.

We calculated the mechanical advantage of the adductor muscles as follows: lever arm of the

muscle divided by the moment arm of resistance at the bite point (m1 or jaw tip). A limitation of

this technique lies on its 2D approach: using this method, we can only calculate the lever arms

for pitch rotation, while any three-dimensional movement of the jaw (i.e., jaw or roll) cannot

be quantified). Additionally, these measurements assume that the position of the pitch axis of

rotation is at the jaw joint in all taxa.

2.3.2.4 Data visualisation

Jaw shape and mechanical advantage were plotted together in a morphofunctional landscape in

MATLAB R2019a 9.6.0 (The MathWorks, Inc., Natick, Massachusetts) following a protocol from

Dr. J. A. Bright and previously used in Navalón et al., [154]. Mechanical advantage values were

plotted on a phylogeny of the taxa of interest using the package ‘phytools’ version 0.6.99 [185] in

RStudio.

2.3.2.5 Statistical and phylogenetic comparative methods

Statistical analyses follow Navalón et al., [154] who quantitatively tested the relationship

between beak shape, mechanical advantage and feeding ecology in modern birds. In order to

test for significant differences in jaw shape between dietary groups, Procrustes ANOVAs were

run in R using the package geomorph 3.1.2 [1]. Phylogenetic Generalized Least Squares (PGLS)

regressions were run in R using the package geomorph 3.1.2 [1] to test the relationship between

jaw shape and mechanical advantage in a phylogenetic context. One way PERMANOVAs were

run in PAST 3.24 [84] to test for significant differences between dietary groups on the basis of

their mechanical advantage values.

A phylogenetic flexible discriminant analysis (phylo FDA) was performed following ref.

[152]. We performed this analysis to determine the posterior probability of the Mesozoic taxa of

belonging to one of our established dietary categories (i.e., herbivore, carnivore or insectivore),

while considering their phylogenetic relationships. Extant omnivores were not included in this

study because of their large dietary variability. The analysis was performed in R Studio 1.2.1335

using the packages ape 5.3 [163], class 7.3-15 [189], geiger 2.0.62 [166], lattice 0.20-38 [204], mda

0.4-10 [86], nnet 7.3-12 [189], using the source data (phylo.fda.v0.2.R) of ref. [152]. This analysis

was performed by using the scores obtained from the PGLS regressions, for both muscles (MAM
and MAT) and biting points (m1 and jaw tip).
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Figure 2.3: Data acquired from the jaws of Mesozoic and extant small mammals. A) Jaw
landmarking regime used in this study. Modified from [80]. In orange: 6 fixed landmarks; in
blue: 58 sliding semi landmarks. B) Lever and moment arm measurements taken in this study.
Modified from [5].

2.4 Results

2.4.1 Jaw shape variation and diet in small mammals

Using 2D geometric morphometrics (Fig. 2.3a), we found that jaw shape is a good proxy for

diet among small extant mammals. In Figure 2.4, taxa with negative PC1 scores have shorter

jaws, and taxa with positive PC1 scores have longer jaws; taxa with positive PC2 scores have

taller ascending rami and taxa with negative PC2 scores have shorter ascending rami. Among

extant mammals, most dietary categories (excluding omnivores) can be distinguished along PC1
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(Fig. 2.4a): herbivores plot at the negative end of PC1, insectivores towards the positive end, and

carnivores in between. These categories are also statistically different from each other (Table

2.2), showing that jaw shape can distinguish between most major dietary types. However, our

data cannot distinguish between carnivores and omnivores.

Data on the jaw shape of Mesozoic mammals were projected onto the extant taxa mor-
phospace (Fig. 2.4b). In order to determine whether jaw shape could be used as a dietary proxy

in Mesozoic mammals, we obtained previous independent determinations of likely diets, which

variously employed dental morphology, tooth wear facets and body size (e.g., [20, 30, 39, 75, 80,

94, 98, 124, 167, 194, 195, 207, 235]). We saw a very good correspondence between previous

proposed diets for Mesozoic mammals and their position on the morphospace.

2.4.1.1 Stem mammals

Most stem mammals plot within the morphospace of extant insectivores and have positive

PC1 scores. One exception is Sinoconodon (taxon #2, Fig. 2.4), which plots in the morphospace

of extant carnivores; Sinoconodon is considered a carnivore based on dental morphology [113].

Haramiyavia (#1) is thought to have been a plant-dominated omnivore [117] based on dental

morphology, but here it plots within the morphospace of extant insectivores. Both morganucodon-

tans in this study, Morganucodon (#3) and Dinnetherium (#4), have similar PC1 scores to extant

insectivores, echoing the findings of Gill et al. [75].

Molar morphology indicates omnivorous or faunivorous diets for docodontans; here they

mostly plot within the morphospace of extant insectivores, with the exception of Haldanodon

(#6) and Docofossor (#7). Agilodocodon (#9) was previously considered a plant-dominated omni-

vore, with exudativorous dental features which indicated a diet mainly composed of plant sap

[146]; more recently, Wible and Burrows [234] contradicted this hypothesis and suggested that

the teeth of Agilodocodon most closely resemble those of extant insectivores. Here, Agilodocodon

plots firmly within the morphospace of extant insectivores, close to the insectivorous dusky

antechinus (Antechinus swainsonii, #61) and the elephant shrews (Elephantulus rufescens [#114]

and E. brachyrhynchus [#115]), which are insect-dominated omnivores.

According to Ji et al., [94] the swimming docodontan, Castorocauda (#5), has dental features

Carnivore vs Herbivore vs Insectivore vs
Statistic Herbivore Insectivore Omnivore Insectivore Omnivore Omnivore

R2 0.15795 0.1455 0.03417 0.25987 0.06404 0.06499
F 4.1266 4.5973 1.6628 6.6712 2.6686 3.0582
Z 3.0431 3.0556 1.2966 3.4824 2.1976 2.4708
P 0.003 0.001 0.098 0.001 0.017 0.005

Table 2.2: Summary of the Procrustes ANOVA (Type II, Conditional SS) performed for
jaw shape data as a function of dietary group. Significant p values (<0.05) in bold letters.
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indicative of feeding on aquatic invertebrates and small vertebrates, like fish. Castorocauda is

often depicted as being carnivorous and, particularly, piscivorous [30, 94, 146]. The jaw shape of

Castorocauda is similar to that of modern day insectivores, supporting the notion of this docodon-

Figure 2.4: Scatter plots of the Principal Component Analysis (PCA) results (PC1 vs
PC2). a) Extant taxa, b) Extinct taxa. Convex hulls shown for extant insectivores (yellow),
carnivores (red), omnivores (purple) and herbivores (blue). Icon colours indicate known dietary
categories of extant mammals and suggested dietary categories for Mesozoic mammals (obtained
from the literature). See Table 2.1 for taxon names.
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tan feeding on aquatic invertebrates (Fig. 2.4). The other Mesozoic semiaquatic mammal in our

sample, Teinolophos (#13), plots in a similar area of the morphospace to Castorocauda. Our

extant sample also includes a semiaquatic carnivore, the water opossum (Chironectes minimus,

#69), which plots in the middle of the carnivore morphospace, far away from Castorocauda and

Teinolophos.

Docofossor (#7) has skeletal features indicative of a fossorial lifestyle and a dentition simi-

lar to those of extant mammals foraging underground, such as moles, solenodons, and tenrecs

[123]. This docodontan has previously been considered an insectivore [30]. Here, Docofossor

plots within the morphospace of extant carnivores; however, it plots close to the burrowing

Hispaniolan solenodon (Solenodon paradoxus, #109), which has an insectivorous diet. Among

the extant insectivores in our sample, the burrowing vermivores (e.g., the hairy-tailed mole,

Parascalops breweri [#108], and the Hispaniolan solenodon) have more negative PC1 scores than

other insectivores (similar to that of Docofossor), and their PC1 values are more similar to those

of carnivores.

The dental morphology of Haldanodon (#6) is indicative of an insectivorous diet. Here, it plots

within the carnivore morphospace (very near extant herbivores), because of its tall coronoid pro-

cess and comparatively shorter jaw. Docodon (#8) likely ate insects and other small invertebrates

[167] and, based on its diminutive size [247], Microdocodon (#10) was probably insectivorous.

Both of these docodontans plot within the insectivore morphospace.

2.4.1.2 Non-therian crown mammals

The jaw shape of non-therian crown mammals varies widely, plotting mostly within the mor-
phospace of insectivores and carnivores. Fruitafossor (#11), a fossorial mammal with teeth

similar to extant armadillos, has been considered an omnivore eating insects, small invertebrates

and some plants [124]. Here, it plots within the insectivore morphospace, closely to the insectivo-

rous and fossorial hairy-tailed mole (Parascalops breweri, #108), and shares similar PC1 scores

with other fossorial taxa, such as Docofossor (#7) and the Hispaniolan solenodon (#109).

Extant monotremes eat insects and other small invertebrates. It has been proposed that the

Early Cretaceous monotreme Teinolophos (#13) had a semi-aquatic lifestyle and ate in a similar

manner to the insectivorous Kuehneotherium [186]. Here, Teinolophos and the australosphenidan

Henosferus (#12), have PC1 scores similar to insectivores and omnivores.

The eutriconodontans are a very diverse group of insectivores and carnivores which had a

wide range of body sizes, including some of the largest Mesozoic mammals known [97]. Here all

eutriconodontans fall within or very close to the extant carnivore morphospace. In particular,

Triconodon (#16) and Argentoconodon (#19) plot within the carnivore morphospace, Trioracodon

(#17) and Volaticotherium (#18) plot between the carnivore and insectivore morphospace, and

Yanoconodon (#15) plots within the insectivore morphospace. Both gobiconodontids, Gobiconodon

(#20) and Repenomamus (#21), have more negative PC1 scores and plot closer to the herbivore
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morphospace, but still remain within or close to the carnivore morphospace. Triconodon, Trio-

racodon, Gobiconodon and Repenomamus are all considered carnivores based on craniodental

morphology and body size [30, 98, 195]; additionally, there is direct evidence for the carnivorous

diet of Repenomamus from fossilized stomach contents [88]. Yanoconodon and Volaticotherium

are considered insectivores[30].

Symmetrodontans like Spalacotherium (#22), Zhangheotherium (#24) and Maotherium (#25)

have often been considered insectivores based on their craniodental morphology [30, 98]. Here, all

symmetrodontans plot within the insectivore morphospace. Dryolestids are also commonly con-

sidered insectivorous [98, 207]. Here, Crusafontia (#26) plots between the morphospace of extant

carnivores and insectivores, while Amblotherium (#27) plots within the insectivore morphospace.

Vincelestes (#29) has previously been considered a carnivore on the basis of jaw shape [80]. Here,

it plots near the morphospaces of both omnivores and herbivores. Bonaparte [20] considered the

incisor wear of Vincelestes reminiscent of Cenozoic carnivores, and Rougier [194] considered its

jaw morphology indicative of a forceful bite enabling the incorporation of tough plant matter into

a primarily carnivorous/insectivorous diet.

2.4.1.3 Therian crown mammals

While extant marsupials have a large diversity of diets, including herbivory, extinct metatheri-
ans are considered to have been limited in diet to insectivory and carnivory. Their jaw shape is

very similar to that of extant carnivores and insectivores (Fig.2.4). Dental morphology indicates

that Eodelphis (#32) and Deltatheridium (#30) were carnivores, Didelphodon (#31) durophagous

or molluscivorous [39, 195], and Alphadon (#33) has been considered to be insectivorous, on the

basis of its jaw shape and body size[80]. Here, Eodelphis, Deltatheridium and Didelphodon plot

closely to the extant carnivores, while Alphadon plots closely to the extant insectivores.

Extant placentals also have a wide range of diets, but many of the extinct eutherians in this

study (i.e., Sinodelphys [#34], Juramaia [#35], Eomaia [#36], Kennalestes [#40], Barunlestes [#44]

and Kulbeckia [#43]) are considered insectivorous [30, 80]. Here, we corroborate this hypothesis

(Fig. 2.4): all extinct eutherians plot within the insectivore morphospace, with the exception

of Asioryctes (#38) which plots in the insectivore/carnivore morphospace, and Juramaia and

Sinodelphys, which plot just outside the insectivore morphospace.

2.4.2 Mechanical advantage of the jaws of small mammals

We obtained mechanical advantage (MA) data to test whether extant mammals of different dietary

groups have distinct MA values: while many dietary groups are statistically different from each

other (Table 2.3), mechanical advantage values on their own do not obviously correspond to a

particular dietary category. The mechanical advantage of the jaws was standardized across all

jaws to account for differences in jaw morphology (e.g., presence or absence of the angular process)

(Fig. 2.3b); the outlever was measured at the anterior end of the jaw and at the first lower molar
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(m1). When measuring mechanical advantage at the jaw tip and considering extant taxa only,

we find statistically significant differences in the mechanical advantage of the masseter (MAM)

values in all pairwise dietary combinations except for carnivore-insectivore (Table 2.2). The

mechanical advantage of the temporalis (MAT) is statistically distinct only between herbivores

and insectivores, and carnivores and insectivores (Table 2.3). Herbivores and carnivores do not

have statistically distinct MAT values. This may differ in a sample of larger (> 5kg) therians.

When measuring the outlever at the m1, we find statistically significant differences in all pairwise

comparisons of MAM between dietary groups, except for herbivore-omnivore and carnivore-

insectivore. When considering MAT, we only find significant differences between omnivores and

carnivores, insectivores and herbivores, and insectivores and carnivores.

Measured at jaw tip

MAM

F=6.664 Insectivore Herbivore Omnivore Carnivore

Insectivore
Herbivore 0.001
Omnivore 0.0295 0.04
Carnivore 0.7612 0.0006 0.0309

F=3.314 MAT

Insectivore
Herbivore 0.0045
Omnivore 0.2725 0.0847
Carnivore 0.0048 0.4721 0.1139

Measured at m1

MAM

F=6.813 Insectivore Herbivore Omnivore Carnivore

Insectivore
Herbivore 0.0011
Omnivore 0.0008 0.189
Carnivore 0.0603 0.0093 0.0817

F=3.817 MAT

Insectivore
Herbivore 0.0197
Omnivore 0.1682 0.3622
Carnivore 0.0022 0.3922 0.0376

Table 2.3: Pairwise p values (uncorrected significance) of one way PERMANOVAs of
the mechanical advantage values of the masseter (MAM) and temporalis (MAT) ob-
tained in this study on extant taxa of known dietary preferences only (permutation
N=9999). Significant p values (<0.05) in bold letters.

With respect to mechanical advantage (measured at the jaw tip) and shape, our results show

that generally, shorter jaws (negative PC1) have higher mechanical advantage and longer jaws
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have lower mechanical advantage, as predicted by the lever-like nature of the system (Figs. 2.5a

and 2.5b). Comparing Figs. 2.4 and 2.5, we can see that taxa with negative PC1 scores (i.e.,

those with shorter jaws and high MA) are largely herbivores and carnivores, while taxa with

positive PC1 scores (i.e, those with longer jaws and low MA) are typically insectivores. Mesozoic

mammals largely plot in areas of morphospace with low to intermediate MAM and MAT, with

some exceptions (Fig. 2.5). For example, Vincelestes has some of the highest MAM and MAT

values, congruent with an omnivorous diet consisting of meat and hard plant matter (or possibly

durophagy) [20, 194], and putative carnivorous taxa, such as Triconodon and Repenomamus,

have high MAT values congruent with their proposed diets (Fig. 2.4b) [88, 196].

Fig. 2.6 shows the mechanical advantage of the masseter (left) and temporalis (right),

measured at the jaw tip, in a phylogenetic context (see also Fig. A.6 for individual taxon names).

Phylogeny seems to play a large role on the mechanical advantage and diet of the jaws of small

mammals.

Most Mesozoic taxa have low (blue) to intermediate (green) MAM values. Most stem mammals

have intermediate (green) to high (red) MAM values and non-therian crown mammals have

low MAM values, with the exception of Fruitafossor and Vincelestes, which has the highest

MAM value of all taxa (both extinct and extant). Most eutherians, both extinct and extant,

have intermediate to low MAM values, with the exception of the relatively high values (yellow

to orange) seen in elephant shrews (order Macroscelidea) and the four-toed hedgehog (order

Eulipotyphla, Atelerix albiventris). Some members of the orders Carnivora (including canids

and euplerids) and Afrosoricida have some of the lowest MAM values. Metatherians have MAM

values ranging from low to intermediate (in the orders Dasyuromorphia and Didelphimorphia, as

well as in the Mesozoic metatherians) to some of the highest in the order Diprotodontia (e.g.,

the sugar glider [Petaurus breviceps], the woylie [Bettongia penicillata], the cuscus [Phalanger

orientalis]).

Most taxa have intermediate MAT values (Fig. 2.6, A.6). Very low MAT values are seen in

the extinct non-therian crown mammals Teinolophos and Zhangheotherium and a few extant

taxa, including marsupials like the Western barred bandicoot (Perameles bougainville) and

the numbat (Myrmecobius fasciatus), and placentals such as the striped treeshrew (Tupaia

dorsalis) and the short-snouted elephant shrew (Elephantulus brachyrhynchus). The highest

MAT values belong to members of the order Carnivora, including skunks (Mephitis macroura and

Conepatus humboldtii), the least weasel (Mustela nivalis) and the tayra (Eira barbara). Some

diprotodontians like the common ringtail possum (Pseudocheirus peregrinus) and the sugar glider

(Petaurus breviceps) also have relatively high MAT values. Some extinct taxa also have relatively

high MAT values, including the stem mammal Docofossor, and the non-therian crown mammals,

Triconodon and Vincelestes.
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Figure 2.5: Morphofunctional landscape comparing a functional metric (i.e., mechan-
ical advantage of the masseter [a, MAM] and temporalis [b, MAT] when biting at the
anterior end of the jaw) with jaw shape (PC1 and PC2 axes). Silhouette colours are in-
dicative of the mechanical advantage values of the taxa. Convex hulls in dashed lines as in Fig.
2.4
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Figure 2.6: Mechanical advantage values of the temporalis (left) and masseter (right)
when biting at the jaw tip visualised in the context of the phylogeny used in this study.
See Supplementary Fig. S8 for individual taxon names.

2.4.3 The relationship between jaw shape, mechanical advantage and diet in
small mammals

The relationship between jaw shape and mechanical advantage was tested in a phylogenetic

context using a Phylogenetic Generalized Least Squares (PGLS) regression. There is a signifi-

cant correlation between jaw shape and mechanical advantage of the masseter and temporalis
(p=0.001) measured at the tip of the jaw in small mammals (Fig. 2.7 and 2.8). R2 values are

greater in the plot of jaw shape against mechanical advantage of the temporalis, implying a

tighter predictive relationship between jaw shape and MAT than jaw shape and MAM: this

might be a result of measuring the temporalis lever arm between two fixed landmarks (Fig. 2.3b).

In Figures 2.7 and 2.8, the regression vector (axis y) shows differences in jaw shape. In Figure

2.7, jaws with taller and more robust ascending rami (and hence longer masseter lever arms)

have more positive regression scores and jaws with shorter, more gracile ascending rami (and

shorter masseter lever arms) have more negative regression scores. In Figure 2.8, jaws with

more ventrally positioned condyles (and hence longer temporalis lever arms) have more positive
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regression scores, and jaws with more dorsally positioned condyles (and shorter temporalis lever

arms) have more negative regression scores. In both Figures 2.7 and 2.8, longer jaws tend have

lower mechanical advantage values (i.e., when biting: less forcefulness, more speed), and shorter

jaws tend to have higher mechanical advantage values (i.e., when biting: more forcefulness, less

speed).

In Figures 2.7a and 2.8a, dietary categories among extant mammals can be roughly dis-

tinguished (with the exception of omnivores). In Figure 2.7a, carnivores and insectivores have

similar MAM values (intermediate to low), while herbivores have intermediate to high MAM

values. Carnivores tend to have higher regression scores than insectivores, and herbivores have

the highest regression scores. Omnivores have low to high MAM values and regression scores.

In Figure 2.8a, insectivores have intermediate to low MAT values. Carnivores have inter-

mediate MAT values, although some mustelids (i.e., the least weasel [Mustela nivalis, #99], the

American badger [Taxidea taxus, #96], and the North American river otter [Lontra canadensis,

#98]), have the highest MAT values among extant mammals. Herbivores have intermediate to

high MAT values. Insectivores tend to have lower regression scores, and carnivores and herbi-

vores tend to have higher regression scores.

We also found a significant relationship between jaw shape and mechanical advantage of the

masseter and temporalis (p=0.001) measured at the first lower molar (m1) in small mammals

(Figs. A.10, A.11). We made this alternative measurement because Grossnickle ([79]) found that

the length of the posterior portion of the jaw (measured from the jaw joint to the m1) is a strong

predictor of diet in mammals. Compared to the mechanical advantage (MA) measurements at

the jaw tip (Fig. 2.7 and 2.8), we see a less clear distinction between dietary groups among extant

mammals. There is considerable overlap between dietary groups in Fig. A.10 (jaw shape~MAM
regression). In Fig. A.11 (jaw shape~MAT regression), there is a better separation between

dietary groups.

In both cases, Mesozoic mammals have comparable regression and mechanical advantage

scores to extant insectivores, carnivores and, in some instances, herbivores (Figs. 2.7b and 2.8b).

Can we use a combination of jaw shape data and mechanical advantage values to infer diet in

Mesozoic mammals?

2.4.4 Jaw shape and mechanical advantage as proxies for diet in Mesozoic
mammals

We performed a phylogenetic flexible discriminant analysis using the regression scores of jaw

shape on mechanical advantage (of both jaw tip and m1 measurements) following Motani and

Schmitz [152] to determine the posterior probability of the Mesozoic taxa of belonging to one of

three dietary categories: insectivore, carnivore or herbivore. The results of the analysis can be

seen in Figure 2.9 and the posterior probability values can be seen in S2 Data. For the most part,

we see a good separation between dietary groups among extant mammals (Fig. 2.9a), with some
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Figure 2.7: Relationship between jaw shape and mechanical advantage of the masseter.
PGLS regression of Procrustes coordinates on mechanical advantage of the masseter on extant
taxa (a) and extinct taxa (b). Colours indicate known dietary categories of extant mammals and
suggested dietary categories for Mesozoic mammals (obtained from the literature). Ovals indicate
where extant taxa of known dietary categories plot, as in part (a).
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Figure 2.8: Relationship between jaw shape and mechanical advantage of the tempo-
ralis. PGLS regression of Procrustes coordinates on mechanical advantage of the masseter on
extant taxa (a) and extinct taxa (b). Colours indicate known dietary categories of extant mammals
and suggested dietary categories for Mesozoic mammals (obtained from the literature). Ovals
indicate where extant taxa of known dietary categories plot, as in part (a).

exceptions: the primarily herbivorous olingo (Bassaricyon gabbii, #94) plots within the carnivores

(although mainly frugivorous, it can consume small vertebrates), as does the insectivorous His-
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paniolan solenodon (Solenodon paradoxus, #109).

The Mesozoic mammals included in our sample have largely been considered faunivorous
and Figure 2.9b corroborates this hypothesis. The majority of them are classified as insectivorous,

including most stem mammals, australophenidans, symmetrodonts and eutherians, among

others. With the exception of Phascolotherium (#14), all eutriconodontans (including the gobi-

conodontids) were classified as carnivorous, alongside most metatherians in the sample (i.e.,

Didelphodon [#31], Deltatheridium [#30], Eodelphis [#32]), the stem mammal Sinoconodon (#2),

the dryolestid Crusafontia (#26), and the eutherian Sasayamamylos (#39). Two taxa in the

analysis were classified as herbivorous, because of their relatively tall ascending rami: Vince-

lestes (#29) and Haldanodon (#6). The dental morphology of Vincelestes points to a primarily

faunivorous diet [20], but it has been noted before that its jaw morphology is indicative of a

forceful bite; Rougier [194] suggested that this jaw morphology might have enabled Vincelestes to

incorporate tough plant matter into its diet, but it might also be indicative of durophagy. The

dental morphology [167] and body size of Haldanodon point towards an insectivorous diet; in this

analysis, the posterior probability of Haldanodon being a herbivore is not high (only 50.3%). The

evidence thus far suggests Haldanodon had a faunivorous diet; its jaw morphology might be

indicative of the incorporation of tougher food sources into its diet.

2.5 Discussion

In this study we found that jaw shape is largely indicative of dietary category (with the exclusion

of omnivores) in small extant mammals. This reflects the findings of Grossnickle and Polly [80];

however, we find a clearer discrimination of jaw shape between carnivores and insectivores, which

might be related to our larger sample size and landmarking regime. In Fig. 2.4 there is some

overlap between these two dietary categories but, in general, hypercarnivores such as the felids

(#79, 80, 81) and the Tasmanian devil (Sarcophilus harrisi, #58) are clearly distinguished from the

insectivores, while some mesocarnivores like the quolls (genus Dasyurus, #56, 57) and the Corsac

fox (Vulpes corsac, #90) are more similar to the insectivores. This is in agreement with the study

by ref. [175] who also found a clear separation of hypercarnivorous mammals from mesocarnivores

and insectivores. As hypothesized by Prevosti et al., [175] and previous authors, hypercarnivores

have shorter jaws to increase the mechanical advantage of the adductor musculature and deliver

a stronger bite; alongside other morphological features, this configuration proves advantageous

for prey subduing and meat consumption.

Generally, it is expected that herbivores would have a high mechanical advantage (i.e.,

increased bite force) of the masseter (MAM) and that carnivores would have a high mechanical

advantage of the temporalis (MAT). Interestingly, we found that herbivores not only tend to

have high MAM, but also high MAT, while carnivores have high MAT, but low MAM. A study on

cranial morphology of rodents [200] found a similar pattern: herbivores have enlarged masseter
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and temporalis muscles, while carnivores have and enlarged temporalis and a reduced masseter.

Despite their different diets, the enlarged temporalis muscle in herbivores and carnivores might

serve a similar function: to resist dislocating forces when biting at the front of the jaw, either when

dealing with struggling prey (in carnivores) or biting hard plant material (in herbivores) [200].

On the other hand, insectivores have lower mechanical advantage (i.e., increased biting speed)

Figure 2.9: Phylogenetic flexible discriminant analysis results, showing discriminant axis
one (DA1) and two (DA2), of extant mammals (a) and Mesozoic mammals (b). Extinct taxa are
colour coded based on their posterior probability of belonging to one of the established dietary
categories. Convex hulls show the position of the extant taxa in the plot and are colour coded
based on their dietary categories. Note the different scale between the two plots.
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in both muscles, which would be beneficial for catching fast moving prey. This low mechanical

advantage is a byproduct of their long snouts, advantageous for both speedy jaw closure and for

some foraging strategies (e.g., capturing prey inside holes or burrows).

Mechanical advantage values are closely related to jaw shape, which are in turn related to

phylogeny. On their own, mechanical advantage values do not obviously correspond to particular

dietary categories; however by combining jaw shape with mechanical advantage values of both

the masseter and temporalis, we find a good correspondence with dietary categories in extant

mammals. Herbivores tend to have shorter jaws and high mechanical advantage of both the

masseter and temporalis; carnivores tend to have jaws intermediate in length, high mechanical

advantage of the temporalis and low mechanical advantage of the masseter; and insectivores

have longer jaws, and low mechanical advantage of both muscles.

The position of taxa in Figs. 2.4, 2.7 and 2.8 is related to both the length of the jaw and

the length of the lever arms of the temporalis and masseter. Grossnickle [79] noted that the

posterior portion of the jaw in non-rodents tends to be shorter in herbivores than in faunivorous
taxa; while we did not include a similar measurement in our study, we can observe here that

herbivores tend to have shorter jaws than faunivorous taxa (as well as higher mechanical

advantage values).

Grossnickle [79] found that, among non-rodent therians, the jaw joint to angular process

(JAPr) distance is longer in herbivores than in faunivorous taxa, consequently increasing the lever

arm of the masseter. Our results corroborate these findings, and can be seen in the silhouettes

along the regression score axis in Figure 2.7. We also found a tighter predictive relationship

between MAT and jaw shape than between MAM and jaw shape. This is mainly related to two

issues: 1) the lever arm of the temporalis was measured in between two fixed landmarks and 2)

the differential presence of an angular process in jaws across the sample, which in turn affects

the mechanical advantage of the masseter. Having explored the relationship between jaw shape,

mechanical advantage and diet in small extant mammals, now we can evaluate whether these

morphometric and functional metrics are good proxies for diet in Mesozoic mammals.

Overall, we found good correspondence between jaw shape, mechanical advantage and diet in

Mesozoic mammals. We corroborate the hypothesis that most Mesozoic taxa were insectivorous

and some clades, like eutriconodontans, had a carnivorous diet.

In Figure 2.7 we see that many stem mammals have higher masseter mechanical advantage

values than ‘expected’ for their proposed dietary categories (also seen in Fig. 2.6). Stem mammals

have a very anteriorly positioned angle of the mandible. This is related to the presence of retained

postdentary bones (located posteriorly to the angle) that are incorporated into an enclosed middle

ear to a greater or lesser extent in more derived mammals [114]. The anterior position of the angle

in turn increases the lever arm of the masseter. In contrast, non-therian crown mammals that

have not attained a fully-enclosed middle ear, such as Yanoconodon (#15) and Maotherium (#25),

do not have longer masseter lever arms because their mandibles lack an anteriorly positioned
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angular process, possibly related to the fact that the middle ear ossicles that have now become

medially separated from the dentary [114]. Therian mammals with a fully enclosed middle ear

do not have anteriorly positioned angular processes.

2.6 Conclusions

In this study, we analyzed the relationship between jaw shape and mechanical advantage of the

adductor muscles in small extant mammals of known diets to determine whether there is a

relationship between jaw shape, function and dietary ecology in extant taxa, and furthermore,

whether these proxies can be useful to infer dietary categories in Mesozoic mammals. Jaw shape

alone can be used as a good indicator to roughly distinguish among herbivores, carnivores and

insectivores, but cannot distinguish omnivores. Overall, this holds true for most Mesozoic mam-

mals.

Mechanical advantage values on their own cannot be used to confidently assign a taxon to

a particular dietary category; phylogeny also plays an important role. However, by combining

mechanical advantage data, of both the masseter and temporalis, with jaw shape we can

distinguish between most dietary categories: herbivores have high MAM and MAT values, tall

ascending rami and shorter jaws; carnivores have low MAM values, medium to high MAT values,

medium to short ascending rami and jaw length; and insectivores have low to medium MAM and

MAT values, short ascending rami and longer jaws.

These morphological and functional characteristics reflect the differential need of these ani-

mals for acquiring and processing particular types of food, which can be aided by having either

stronger or faster jaw closure. Other factors, such as different foraging strategies and phylo-

genetic history, also play a role in determining the morphological configuration and functional

traits of the mammalian jaws. The fact that the jaw shape and mechanical advantage of extant

mammals could be successfully used as the basis for inferring the diet of mammals living during

the Mesozoic (even those with retained postdentaries), highlights that ecological pressures and

principles of jaw design were similar today and in the past.

We corroborate the hypothesis that most non-allotherian Mesozoic mammals had a fau-
nivorous diet. Considering the taxa in our sample, most stem mammals, symmetrodonts, dry-

olestids, amphitheriids and eutherians seem to have had an insectivorous diet (or one con-

sistent of aquatic invertebrates in the case of semi-aquatic mammals such as Castorocauda

and Teinolophos), while the eutriconodontans and metatherians studied here probably had a

more carnivorous diet. Fossorial or semi-fossorial mammals with a potentially vermivorous diet

can also be distinguished from other insectivores as their jaw shape is more similar to that of

carnivores.
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VALIDATING THE USE OF EXTRUDED FINITE-ELEMENT MODELS

USING EARLY MAMMAL JAWS

This chapter has been previously published in Journal of the Royal Society Interface:

Morales-Garcia, N.M., Burgess, T.D., Hill, J.J., Gill, P.G., and Rayfield, E.J. 2019. The

use of extruded finite-element models as a novel alternative to tomography-based models:

a case study using early mammal jaws. Journal of the Royal Society Interface, 16: 20190674.

The idea of creating extruded models for their use in Finite Element Analysis (FEA) was

originally proposed by Emily Rayfield. Initial validation experiments were carried out in extant

animal jaws by Thomas Burgess during his MSc in Palaeobiology at the University of Bristol,

under the supervision of Jennifer J. Hill and Emily Rayfield. Nuria Melisa Morales redesigned

the process of making the models and created enhanced extruded models for their use in FEA.

The use of these models was validated using the jaws of stem mammals Morganucodon and

Kuehneotherium. Nuria Melisa Morales built all the models used in this paper, ran all the FE
and sensitivity analyses and wrote the manuscript. This project was performed under the super-

vision of Pam Gill and Emily Rayfield, who contributed to the development of the method and

commented on the manuscript.

3.1 Abstract

Finite Element Analysis (FEA) has been used in palaeobiology to assess the mechanical perfor-

mance of the jaw. It uses two types of models: tomography-based 3D models (very accurate, not

always accessible) and 2D models (quick and easy to build, good for broad scale studies, cannot

obtain absolute stress and strain values). Here we introduce extruded FE models, which provide
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fairly accurate mechanical performance results, while remaining low-cost, quick and easy to

build. These are simplified 3D models built from lateral outlines of a relatively flat jaw and

extruded to its average width. There are two types: extruded (flat mediolaterally) and enhanced

extruded (accounts for width differences in the ascending ramus). Here we compare mechanical

performance values resulting from four types of FE models (i.e., tomography-based 3D, extruded,

enhanced extruded and 2D) in Morganucodon and Kuehneotherium. In terms of absolute values,

both types of extruded model perform well in comparison to the tomography-based 3D models, but

enhanced extruded models perform better. In terms of overall patterns all models produce similar

results. Extruded FE models constitute a viable alternative to the use of tomography-based 3D

models, particularly in relatively flat bones.

3.2 Introduction

Finite element analysis (FEA) is an engineering technique that reconstructs stress, strain and

deformation patterns in digital structures [183, 249, 250]. This method allows for a complex 3D

structure to be broken down into a finite number of elements of known material properties, size

and shape whose response to a force can be readily quantified [183, 249, 250]. In vertebrates,

FEA has mainly been used to assess feeding behaviour and mechanical performance of the skull

in a wide array of groups, including cartilaginous fish [240], ray-finned fish [82], crocodilians

[169], non-avian dinosaurs [184], birds [44], mammaliaforms [75], rodents [41, 42], primates

[55, 219, 225], bats [56], ungulates [22], and carnivorous mammals [158, 212, 240, 241]. To a

lesser extent it has been used in the study of locomotion and behaviour, for example to assess the

loading regime of the metatarsus in a theropod dinosaur [214], to study the mechanical potential

of the manual ungual of dromaeosaurids in prey dispatching [128], to simulate sauropod trackway

formation [61] and theropod dinosaur locomotion [18, 18].

For its use in palaeontology, FEA has been validated using experimental approaches, includ-

ing the in-vivo analysis of primate [192] and American alligator skulls [148, 171], ex-vivo studies

using a domestic pig cranium [22] and the mandible of an ostrich [44], and in macaque mandibles

using in-vitro data [136], as well as combined in-vivo and ex-vivo data [161]. Additionally, a

comprehensive set of sensitivity analyses have been performed to improve FE models in terms

of elastic properties and loading regimes [105, 193, 218, 227], boundary conditions [136], mesh

density [22] and generation [133], as well as element size and homogeneity [130].

In palaeontology, finite element (FE) models are traditionally built using computed-tomography

(CT) scan data. This method of data capture is widely used for FEA because it allows for the con-

struction of very precise three-dimensional models and because it captures the internal anatomy

of the structures of interest [183]. Other approaches to 3D data capture, like photogrammetry,

laser scanning and mechanical digitisation, have been used to completely or partially build

models for FEA [21, 68, 109, 110, 220] although these techniques are not able to capture internal
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anatomy. Alternatively, 2D FE-models (also known as planar models) have been used to study

feeding biomechanics across the fish-tetrapod transition [155], analyse the skull mechanics of

temnospondyls [70, 71] and crocodilians [169], study the mechanical performance of dinosaur

skulls [127, 182, 182] and cingulate xenarthrans [209], analyse the relationship between jaw

shape and diet in primates [134] and assess the digestive physiology of ruminants using the

robustness of their jaws [67], among others. It is simple, easy and quick to build 2D planar

FE-models and they represent a first approximation for performing large scale studies and

looking into general trends among clades [127, 134, 155, 169]. Additionally, they do not require

CT scan data, which can sometimes be inaccessible or very expensive. The simplicity of 2D planar

models can be problematic however, because they do not capture the three-dimensionality of the

structure and the muscle configuration and the forces acting upon it, and must assume that the

stresses and strains act only in the sagittal 2D plane [155]. It is therefore unclear to what extent

2D planar models can replicate the stress environment of a three-dimensional shape. Until this

relationship is assessed, the utility of 2D planar models and the potential for studying large scale

macroevolutionary trends cannot be fully realised.

Here we test the utility of simple 2D planar FE models and simplified 3D models, to predict

the stress response of a complex three-dimensional structure. Recent 2D FE studies have focused

on the vertebrate mandible, based on the assumption that it is a simple and largely planar

structure that retains information about the feeding ecology of the individual. Here we create

simplified FE models of relatively flat mandibles, built digitally using a lateral 2D outline of the

jaw and data on its mediolateral width. We focus on the Early Jurassic mammaliaforms Mor-

ganucodon and Kuehneotherium, two of the earliest and most basal representatives of the total

group Mammalia. The biomechanical performance of the jaws of these taxa has been previously

studied using 3D FE models built from CT scan data, alongside other biomechanical techniques

[75]; therefore, they constitute ideal subjects for the validation of novel FE models. We create

three types of FE model of increasing complexity: a) 2D planar models, b) extruded models, which

have been extruded to the average width of the jaw and maintain a uniform thickness, and c)

enhanced extruded models, similar to extruded models, but where the ascending ramus has been

modified to more closely resemble the 3D geometry of the jaw. We compare stress and strain

within the jaws of these simplified FE models to the complex 3D models to assess the utility

of simplified approaches. Given that these models were built using fossil material, no in-vivo

validation was possible. Because these models represent isolated jaws only and the orientation

of the adductor muscles cannot be accurately determined without a skull, we perform a series

of sensitivity analyses to determine how the orientation of the muscle loads impacts the overall

results when using the enhanced extruded models, as a means of helping us quantify uncertainty

for incompletely preserved fossils.
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3.3 Materials

We used the mandibles of two Early Jurassic (Hettangian–Early Sinemurian) stem mammals

from Glamorgan, Wales, UK following [75]: Morganucodon watsoni [reconstructed from speci-

mens UMZC Eo.D.61, UMZC Eo.D.45 (University Museum of Zoology in Cambridge, UK) and

NHMUK PV M85507 (Natural History Museum, London, UK)] and Kuehneotherium praecursoris

(reconstructed from specimens NHMUK PV M19766, NHMUK PV M19749, UMZC Sy.97 and

NHMUK PV M92779). We used the FE models created by [75] as the basis for building 2D planar

and extruded FE models and for comparison with the results from 3D FEA. The models in [75]

are based on slightly incomplete specimens and the extruded models in this paper replicate this

incomplete morphology.

3.4 Methods

3.4.1 Model creation

An example of all the models used in this study are shown in Figure 3.1 for Morganucodon and

Kuehneotherium.

3.4.1.1 2D planar FE models

Lateral view screenshots of the mandibles were taken from Figure 1 in [75]. The mandibles were

outlined in ImageJ v.1.46r [205] using the multi-point feature. The resulting data were processed

in Microsoft Excel to include only the XY coordinates of the outline. These data were imported

into the computer aided design (CAD) software Inventor Professional 2016 (Autodesk, USA)

where a 2D model of the mandible was sketched using the spline function. The models (Figure

3.1D) were then exported to a .STEP file for later use in the FEA software, Abaqus v.6.14-1

(SIMULIA, USA).

3.4.1.2 Extruded FE models

2D planar FE models were constructed as above. These models were extruded medially to an

average width in Inventor Professional 2016 (Autodesk, USA). The average width of the mandible

was obtained from 10 equidistant measurements taken along the length of the mandible (in the

3D models used in [75]) in ImageJ v.1.46r [205]. For Morganucodon, the length of the mandible

was 21.11 mm and the average width was 0.81 mm. For Kuehneotherium, the length of the

mandible was 20.76 mm (incisor region missing from original model) and the average width was

0.85 mm. The resulting extruded FE models (Figure 3.1) were exported to a .STEP file for later

use in the FEA software, Abaqus v.6.14-1 (SIMULIA, USA).
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Figure 3.1: FE models analysed in this paper. Morganucodon on the left and Kuehneotherium
on the right. From top to bottom: CT scan-based models, enhanced extruded models, extruded
models and 2D planar models.

3.4.1.3 Enhanced extruded FE models

Alternative models to the simple, flat extruded FE models were generated. Using the 3D computer

graphics software Blender v 2.78, the mandibles were outlined and transformed into simple

extruded models. Posteriorly, the ascending rami of the mandibles were modified in width to

account for a more complex geometry (as shown in Figure 3.1) in three main areas: the coronoid

process, the condyle and the angular process (i.e., those regions in which the lateromedial

width of the ascending ramus was markedly different from that of the horizontal ramus). The

region between the condyle and the top of the coronoid process, as well as the concavity of the
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angular, were likewise modified to obtain a gradual transition in width between areas. These

structures were modified by taking additional width measurements from dorsal and posterior

view screenshots of the 3D models of the jaws of Morganucodon and Kuehneotherium from [75] in

ImageJ v.1.46r [205]. These models were exported into .STL in Blender and converted to .STEP

using the CAD software FreeCAD v 0.16 for later use in the FEA software, Abaqus.

3.4.2 Meshing

Finite element analysis requires models to be meshed into a finite number of elements of known

size and shape. For all models, meshing was performed in the FEA software, Abaqus v.6.14-1

(SIMULIA, USA). As in [75], the mesh of extruded and enhanced extruded FE models used

linear four-noded tetrahedral (C3D4) elements; the mesh of 2D planar models used 3 node linear

triangular (CPE3) elements. For a summary on the number of elements used in each mesh see

Table 3.1.

Morganucodon Kuehneotherium

CT scan-based model 115,213 68,555
Enhanced extruded model 111,770 68,074

Extruded model 115,420 68,239
2D planar model 7,192 3,550

Table 3.1: Summary of elements in the mesh of Morganucodon and Kuehneotherium.
Note that the CT scan-based, enhanced extruded and extruded models use linear four-noded
tetrahedral (C3D4) elements, while the planar 2D model uses 3 node linear triangular (CPE3)
elements.

3.4.3 Finite Element Analysis

3.4.3.1 Material properties

Mandibles were assigned isotropic and homogenous material properties of bone following [75],

with a Young’s modulus of 18 GPa and Poisson’s ratio of 0.3. As in [75], none of the models created

included tooth crowns because edentate jaw models have been shown to perform better than

dentate ones [136] and because the fossil specimens lacked some or all of the teeth. However, the

models by Gill et al. [75] did include the tooth roots which had the material properties of dentine

(i.e., Young’s modulus of 25 GPa and Poisson’s ratio of 0.3). In order to test whether the inclusion

of dentine had a significant effect on the FEA results, the original [75] models were re-run with

only one material (i.e., bone) in both mandible and tooth roots. The summary of the results can

be found in Table 3.2. The stress, strain and reaction forces produced by the set of models with

only the material properties of bone was almost identical to those produced by models with two
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different material properties (i.e., bone and dentine); therefore, the original models (with two

material properties) do represent a good basis for validating the extruded models.

Morganucodon Kuehneotherium

A B A B

von Mises stress (MPa)
Mean 3.99 3.96 4.21 4.18
Median 3.00 2.93 2.08 2.04
Maximum 53.8 53.41 82.7 82.84

Maximum principal strain (microstrain)
Mean 142 142 156 158
Median 102 101.5 73.5 75.1
Maximum 3,100 3,084 4,920 4,930

Reaction forces (N)
Jaw joint 2.38 2.38 3.12 3.12
Bite 2.00 2.00 1.14 1.14

Table 3.2: Comparative results of biomechanical analyses- Morganucodon and
Kuehneotherium under the two different FE models: A-Two material properties: bone
and dentine (Young’s modulus=25 GPa, Poisson’s ratio=0.3), B-One material property: bone.
Green: more than 75% similarity with values obtained from 3D model; Yellow: between 50-74%;
Red: less than 50% similarity.

3.4.3.2 Constraints and boundary conditions

Following [75], multi-point constraints with master (i.e., a single point representing the muscle

attachment area in the absent skull in which the lines of action of the slave nodes converge)

and slave nodes (i.e., a set of points that represent the muscle attachment area in the jaw) were

applied at the mandibular condyle and at the biting point: m2 in Morganucodon and m3 in

Kuehneotherium. There were approximately 32 slave nodes constrained at the condyle and 26

slave nodes constrained at the biting point in Morganucodon and approximately 23 slave nodes

constrained at the condyle and 31 slave nodes constrained at the biting point in Kuehneotherium

(muscle attachment regions across models encompass comparable areas but have slightly different

number of nodes). Boundary conditions in all taxa were constrained in four degrees of freedom

at the mandibular condyle (U1=U2=U3=UR1=0) and in four degrees of freedom at the biting

point (U1=U2=UR1=UR2=0). U1 is the mesiodistal axis, U2 is the dorsoventral axis and U3 is

the axis along the length of the jaw; U refers to translational movement, UR refers to rotational

movement.
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3.4.3.3 Muscle attachment simulation

For Morganucodon and Kuehneotherium, four muscles were modeled: superficial temporalis,

deep temporalis, superficial masseter and deep masseter (Figure 3.2). Multi-point constraints

with master and slave nodes were used to simulate areas of muscle attachment at the mandible

(slave nodes) and at the point they would attach to the skull (master nodes). Muscle loadings

were different for each taxon and relative contributions of each muscle were calculated to obtain

an overall bite force of 2N in Morganucodon and 1.14 N in Kuehneotherium. The actual loading

forces, obtained from [75], were as follows: superficial temporalis, 2 N; deep temporalis, 1.6 N;

superficial masseter, 1.6 N; deep masseter, 1.6 N.

3.4.3.4 Jaw performance

Reaction forces at the biting point and condyle were queried after running the model. Field output

reports including maximum principal strain (i.e., tensile strain experienced by a bone following

the application of a load [183]) and von Mises stress (i.e., parameter that predicts failure under

ductile fracture [183]) were recorded for each model. Mesh-weighted arithmetic means were also

calculated to account for differences in element size in the mesh following [130].

3.4.4 Sensitivity analyses

In order to evaluate the relevance of the accurate positioning of the master nodes of the muscle

attachments (and the concomitant orientation of the muscle loads) in the absence of a skull, sev-

eral sensitivity analyses were performed in the enhanced extruded FE models of Morganucodon

and Kuehneotherium. These analyses involved moving the position of the master nodes of the

temporalis, deep masseter and superficial masseter by 1%, 5% and 10% of the total jaw length

in x, y and z, using a series of different transformation combinations (pictured in Figure 3.2 and

fully described in Appendix B). A total of 156 analyses were performed: 78 for Morganucodon and

78 for Kuehneotherium. The full compendium of the resulting stress and strain values obtained

from these analyses can be found in Table 3.3.

3.5 Results

3.5.1 Finite Element Analysis

The comparative stress, strain and reaction forces of Morganucodon and Kuehneotherium ob-

tained from FEA, using the four different models are summarised in Table 3.4 and displayed

as comparative plots in Figure 3.5. Figure 3.3 shows the the von Mises stress plots of all jaws.

Particularly in Table 3.4, the mesh-weighted arithmetic mean (MWAM) values calculated to

account for element size differences in the mesh, is fairly consistent to the arithmetic mean. This

indicates that the size of the elements in the mesh is fairly homogeneous. Deformation patterns,
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Analysis number Change in x axis Change in y axis Change in x axis

1 0 Negative 0
2 0 Positive 0
3 Positive 0 0
4 Negative 0 0
5 Positive Negative 0
6 Negative Negative 0
7 Negative Positive 0
8 Positive Positive 0
9 0 Negative Negative

10 0 Negative Positive
11 0 Positive Positive
12 0 Positive Negative
13 Positive 0 Negative
14 Positive 0 Positive
15 Negative 0 Positive
16 Negative 0 Negative
17 0 0 Negative
18 0 0 Positive
19 Positive Positive Positive
20 Negative Negative Negative
21 Positive Positive Negative
22 Negative Negative Positive
23 Positive Negative Positive
24 Negative Positive Negative
25 Negative Positive Positive
26 Positive Negative Negative

Table 3.3: Sensitivity analyses method. The sensitivity analyses were carried out by moving
the muscle loads 1%, 5% and 10% of the total length of the jaw in the x, y and z axis as described
below. x axis: positive=towards the anterior end of the jaw, negative= towards the posterior end
of the jaw; y axis: positive= towards the dorsal end of the jaw, negative= towards the ventral
end of the jaw; z axis: positive= towards the labial end of the jaw, negative= towards the lingual
end of the jaw.
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Figure 3.2: Sensitivity analyses. Jaw of Morganucodon in (a) lateral view, and (b) posterior
view, depicting the range of distance (i.e., 1, 5, 10% of the total length of the jaw) the muscles
were moved during the sensitivity analyses

fairly consistent across all models, are shown in Figure 3.4. In broad terms, the mean and

median von Mises stress values resulting from both types of extruded FE models (enhanced and

non-enhanced) were similar (75-92%) to those obtained from 3D models built from CT scan data.

Particularly, enhanced extruded models produce more similar stress values to those obtained

from the original 3D models, although they slightly overestimate ( 2.75%) the maximum stress

experienced by the jaw. The mean and median von Mises stress values resulting from the 2D

planar models were less than 0.05% similar to those obtained from 3D models built from CT

scan data. Overall, the von Mises stress patterns in the jaws (Figure 3.3) are fairly consistent

across models, including the 2D planar models, with most of the stress being experienced around

the muscle attachments and the biting point in both Morganucodon and Kuehneotherium. In

Figure 3.3 (B and F), this pattern is not evident in the enhanced extruded FE models because the

von Mises stress scale was standardised for all 3D and extruded FE models, and the enhanced

models experienced the lowest maximum stress values.

In terms of maximum strain magnitude, we obtained different results in both taxa. In the

case of Morganucodon, the extruded FE model performed better than its enhanced counterpart,
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Figure 3.3: Finite-element stress plots. Morganucodon (a-d) and Kuehneotherium (e-h), using
CT scan-based 3D models (a,e), extruded FE models: enhanced (b,f), and flat (c,g), and 2D models
(d,h). Reaction forces (in N), depicted by black triangles, shown for the jaw joint and the bite
point (m2 in Morganucodon and m3 in Kuehneotherium).
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Morganucodon Kuehneotherium
A B C D A B C D

von Mises stress (MPa)
arithmetic mean 3.99 3.57 3.05 0.002 4.21 3.68 3.26 0.002
MWAM 4.03 3.44 3.04 0.002 4.20 3.55 3.38 0.002
median 3.00 2.77 2.34 0.001 2.08 1.65 1.56 0.001
max 53.8 55.4 46.6 0.024 82.7 84.8 67.8 0.016
Max. principal strain (microstrain)
arithmetic mean 142 136 115 0.074 156 132 118 0.065
MWAM 149 131 115 0.073 153 128 122 0.063
median 102 90.8 82.7 0.036 73.5 55.8 53.6 0.032
max 3,100 2,590 2,830 0.89 4,920 5,400 4,250 0.79
Reaction forces (N)
jaw joint 2.38 2.15 2.05 2.02 3.12 3.07 3.1 2.99
bite 2.00 1.85 1.96 2.39 1.14 1.19 1.19 1.53

Table 3.4: Comparative results of biomechanical analyses. Morganucodon and
Kuehneotherium under the four different FE models: A, CT scan-based model; B, enhanced
extruded model; C, extruded model; D, 2D planar model. MWAM, Mesh-weighted arithmetic
mean (following [15] and [37]). Green, more than 75% similarity with values obtained from 3D
model; yellow, between 50 and 74%; red, less than 50% similarity.

Figure 3.4: Deformation patterns of all FE models evaluated in this study. Morganucodon
(left) and Kuehneotherium (right). From top to bottom: CT scan-based models, enhanced extruded
models, extruded models, and 2D planar models
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with the former achieving 91% of the original strain value and the latter only recovering 84%. In

contrast, for Kuehneotherium the enhanced extruded FE model performed better than the simple

extruded model, although it overestimated the maximum strain value by approximately 10%. In

both taxa, the mean and median microstrain values were more similar between the original and

enhanced extruded models, with the former recovering strain values of between 90-96% of the 3D

model in Morganucodon and 76-85% in Kuehneotherium. In both taxa, the mean, median and

maximum strain values resulting from the 2D planar models were less than 0.05% similar to

those obtained from 3D models built from CT scan data.

The reaction forces experienced at the jaw joint were similar across all FE models. In Mor-

ganucodon, the enhanced model recovered 90% of the original reaction force value, the flat

extruded model recovered only 86%, and the 2D planar model was 85% similar. In the case of

Kuehneotherium both extruded FE models recovered approximately 99% of the original reaction

force and the 2D model recovered 96%.

Both extruded FE models also performed well in terms of the reaction forces experienced

at the biting point. In the case of Morganucodon, the flat extruded model produced a reaction

force 98% similar to that produced by the original 3D model, while the reaction force produced

by the enhanced extruded FE model was only 93% similar. For Kuehneotherium, the reaction

forces in both models were identical, with both slightly overestimating the original value by

approximately 4%. In the case of the 2D models, the reaction forces experienced at the biting

point were overestimated in both models, by 20% in Morganucodon and 34% in Kuehneotherium.

3.5.2 Sensitivity Analyses

The summary of the results of the 156 sensitivity analyses, comparing the mean, median and

maximum stress and strain values experienced in the enhanced extruded models with varying

muscle positions to the original 3D models built from CT scan data, can be found in Table 3.5.

However, not all of these models depict a realistic orientation of the adductor muscles. Muscles

were moved by a value determined as a percentage of jaw length. In some cases, moving muscles

by 5% or 10% of jaw length resulted in muscle lines of action that were impossible; for example

passing through the ascending ramus of the jaw. In broad terms, the largest source of deviation

from the original mean, median and maximum stress and strain values experienced by the jaw,

can be attributed to the unrealistic modeling of the adductor muscles, as can be seen when

comparing Table 3.5 (all iterations) with Table 3.6 (only realistic muscle iterations). Overall, this

unrealistic positioning is largely related to moving the muscle loads in the z axis (Figure 3.2) past

the anteroposterior axis of the jaw, effectively making the muscle pull in the opposite mediolateral

direction of its natural orientation. Therefore, these models with unrealistic muscle orientations

were removed, meaning that only 22 models were determined realistic for Morganucodon and 27

for Kuehneotherium (refer to Appendix B for detailed results). These results are summarised in

Table 3.6 and graphically depicted in Figure 3.6.
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Figure 3.5: Comparative performance of the different FE models, in terms of von Mises
stress (MPa) (a: median, b: mean, c: maximum), maximum principal strain (d: median, e: mean, f:
maximum) and reaction forces (in newtons: N) at the jaw joint (g) and bite point (h). Morganu-
codon in blue and Kuehneotherium in green.
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Figure 3.6: Results of the sensitivity analyses. Bar chart depicting the range of the mean
and median stress and strain values observed in the sensitivity analyses for (a) Morganucodon
and (b) Kuehneotherium. 100% line represents the original stress and strain results obtained
from the enhanced extruded FE models, the green bar represents up to how much these results
were underestimated in the sensitivity analyses, and the orange bar shows up to how much these
results were overestimated.

When considering only the models with realistic muscle orientations (Figure 3.6) it is apparent

that, in broad terms, the more the muscle loads are moved from their original position, the

more the resulting stress and strain values deviate from the original values (i.e., those of

the enhanced extruded FE models depicted in Table 3.4). However, in all cases these values

proportionally deviate more in Kuehneotherium than in Morganucodon. Additionally, the mean

and median stress and strain values tend to change fairly consistently throughout iterations, but

the maximum values, particularly when moving the muscles over 5% of the total length of the

jaw, deviate considerably (Table 3.6).

In Morganucodon, the mean and median stress and strain values resulting from the 1%

muscle movement sensitivity analyses did not deviate more than 4% from the original values
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Morganucodon Kuehneotherium
range (min-max) s.d. % similarity range range (min-max) s.d. % similarity range

moving all muscles 1%
von Mises stress (MPa)
mean 3.5-3.8 0.1 97-106% 3.6-3.8 0.1 98-104%
median 2.7-2.9 0.04 99-104% 1.5-1.8 0.1 90-109%
max 54.7-56.1 0.4 99-101% 77.8-91.9 4.5 92-108%
maximum principal strain (microstrain)
mean 131.1-146 5.3 96-107% 130.2-138.7 2.5 98-105%
median 90.1-96.2 2.04 99-106% 47.2-65.0 5.9 85-116%
max 2529.4-2968.2 121.01 98-115% 4952.9-5845 285.5 92-108%

moving all muscles 5%
von Mises stress (MPa)
mean 3.5-5.3 0.6 98-148% 3.5-5.6 0.7 95-153%
median 2.7-4.0 0.42 96-143% 1.4-4.0 0.9 82-246%
max 52-120 20 94-217% 65.4-121.1 17.4 77-143%
maximum principal strain (microstrain)
mean 132.1-209.6 25.8 97-154% 125.9-214.9 29.6 95-162%
median 87.2-139.5 16.8 96-154% 43.9-151.2 35.5 79-271%
max 2760.7-5426.1 712.5 107-210% 3834.1-7794.5 1288.1 71-144%

moving all muscles 10%
von Mises stress (MPa)
mean 3.5-7.7 1.4 99-216% 3.5-8.8 1.8 95-238%
median 2.5-5.5 1.0 91-198% 1.1-6.8 2 65-414%
max 56.2-202.6 41.1 101-366% 63.8-187 32.8 75-220%
maximum principal strain (microstrain)
mean 134-311.2 58.7 98-228% 125.8-343.6 75.4 95-259%
median 82.7-203.1 40.5 91-224% 38.7-259.8 74.4 69-465%
max 3108.3-8894.3 1560.9 120-343% 4064.2-11561.8 2026.5 75-214%

Table 3.5: Comparative stress and strain results of the sensitivity analyses- Includes:
range (minimum and maximum values of all the iterations), standard deviation and % similarity
range (percentual value that represents the range of how much the stress and strain values, in
all iterations of the sensitivity analyses, deviated from the original results from the enhanced
extruded FE models).

obtained from the enhanced extruded model. The 5% movement sensitivity analyses results did

not deviate more than 7% and the 10% movement sensitivity analyses did not deviate by more

than 16%. The sensitivity analyses models tended to overestimate the mean and median stress

and strain values in this taxon.

In Kuehneotherium, the mean and median stress and strain values resulting from the 1%

muscle movement sensitivity analyses deviated up to 16% from the original values obtained from

the enhanced extruded model. The 5% movement sensitivity analyses results deviated up to 21%

and the 10% movement sensitivity analyses deviated up to 34%. The sensitivity analyses models

tended to both underestimate and overestimate the mean and median stress and strain values in

this taxon.
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Morganucodon Kuehneotherium
range (min-max) s.d. % similarity range range (min-max) s.d. % similarity range

moving all muscles 1%
von Mises stress (MPa)
mean 3.5-3.6 0.1 97-101% 3.6-3.8 0.1 98-104%
median 2.7-2.8 0.02 99-102% 1.6-1.8 0.1 96-109%
max 54.7-55.7 0.3 99-101% 77.8-86.9 3 92-102%
maximum principal strain (microstrain)
mean 131.3-137.7 2.5 96-101% 130-139 2.7 98-105%
median 90.1-92.1 0.7 99-101% 54.0-65.0 4 96-116%
max 2529.4-2735.8 66.8 98-106% 4952.9-5530.4 192.9 92-102%

moving all muscles 5%
von Mises stress (MPa)
mean 3.7-3.8 0.1 102-105% 3.6-4.1 0.2 97-112%
median 2.7-2.8 0.1 97-103% 1.4-1.9 0.3 82-117%
max 54.6-66 5 99-119% 75-99.7 9.8 88-117%
maximum principal strain (microstrain)
mean 139.6-145.1 2.4 102-107% 127.8-150.9 8.6 96-114%
median 89.4-94.9 2.3 98-104% 43.9-62.5 8 79-112%
max 2985.1-3366.7 117.2 115-130% 4774.1-6065.8 623.6 88-112%

moving all muscles 10%
von Mises stress (MPa)
mean 3.78-4.06 0.12 106-114% 3.5-4.8 0.46 95-129%
median 2.74-3.02 0.11 99-109% 1.07-2.2 0.53 65-133%
max 58.87-92.91 14.09 106-168% 65.2-141.7 28.47 77-167%
maximum principal strain (microstrain)
mean 145.8-157.9 5.46 106-116% 125.8-176.9 18.72 95-134%
median 93.23-102 3.85 103-113 38.7-70.4 15.39 69-126%
max 3399.8-4305.9 415.52 131-166% 4152.7-8022.6 1410.94 77-149%

Table 3.6: Comparative stress and strain results of the sensitivity analyses with re-
alistic muscle configurations- Includes: range (minimum and maximum values of all the
iterations), standard deviation and % similarity range (percentual value that represents the
range of how much the stress and strain values, in all iterations of the sensitivity analyses,
deviated from the original results from the enhanced extruded FE models).
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3.6 Discussion and conclusions

The more the geometric configuration of the digitally built models resembles that of the most

accurate 3D digital representation of the jaw (i.e., the 3D models built from CT scan data), the

closer their stress and strain values. In descending order of similarity these are a) the enhanced

extruded FE models, b) the extruded FE models, and finally c) the 2D planar FE models. Both

types of extruded FE models produced results which, in most cases, recuperated more than 75%

of the stress and strain values observed in the original 3D models. However, 2D planar FE models

achieved less than 0.05% of these values. Regardless, the von Mises stress plots across all models

show fairly similar patterns, and the reaction forces in the jaw joint and biting point are closely

comparable in most cases, including in the 2D models.

2D planar FE models are a popular alternative to the use of 3D models built from CT
scan data because of their efficiency when performing large scale studies and because they are

valuable as a first approximation to evaluate the overall von Mises stress patterns experienced

in the jaw [127, 155, 169]. However, as previously mentioned by these authors and further

demonstrated here, 2D planar models cannot replicate the absolute stress and strain magnitudes

experienced by the jaw because they represent an oversimplification of the geometry of the jaw

and of the line of action of the adductor muscles. 2D models can, however, represent reaction

forces and comparative patterns of stress and strain, presumably so long as muscle lines of action

do not deviate far from the 2D plane of the model (although this remains to be tested). The

use of extruded FE models can better approximate the 3D geometry of the jaw and its muscle

configuration and produce similar stress and strain values to those obtained from 3D models

built with CT scan data, while still preserving the economy and efficiency of 2D models. In terms

of replicating absolute stress and strain magnitudes, enhanced extruded FE models constitute

one of the best alternatives to the use of 3D models when no CT scan or photogrammetry data is

available. Extruded FE models also constitute a viable alternative because they are easier and

quicker to build than their enhanced counterparts, while still producing similar stress and strain

values. Similar results have been obtained from Rahman and Lautenschlager’s box models [179]

in Finite Element Analysis (FEA) using a skull of Allosaurus and a vertebra of Stegosaurus. Their

models, which also represent a 3D simplification of the geometry of bone, have been assessed

qualitatively (e.g., von Mises stress plots) and quantitatively (e.g., stress, strain, deformation)

and perform in a similar manner to extruded models.

A large number of FE analyses evaluating the mechanical performance of the jaw have been

performed without the cranium (e.g., [75, 127, 130, 136, 155, 171, 209, 209]). Given that both

types of extruded FE models presented here are only built for the jaw and not the cranium, we

cannot be certain we are realistically modelling muscle lines of action. Therefore, sensitivity

analyses were performed in the enhanced extruded models to evaluate how much the resulting

stress and strain values would change if the muscle loads were moved in various directions.

As previously mentioned, the unrealistic modelling of the muscle loads in the z direction was
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the largest source of deviation from the original stress and strain values, as well as moving

the muscle loads by more than 10% of the total length of the jaw in both Morganucodon and

Kuehneotherium; therefore, the understanding of how the adductor muscles attach to the cranium

should be as thorough as possible.

The stress and strain values resulting from both types of extruded FE models represent

a close approximation to the results obtained from 3D FE models built from CT scan data in

relatively flat bones, particularly jaws. These models are still subject to the same assumptions

as any other biological FE-model, in terms of estimating material properties and boundary

conditions such as muscle loads and constraints. The economy and efficiency with which they can

be both built and analysed, while still providing reliable approximations of the stress and strain

magnitudes experienced in the jaw, makes them a good alternative to the use of 2D planar models

when performing large scale studies where questions of comparative shape performance are

warranted. Given the nature of how these models are built, reconstructions based upon a number

of incomplete specimens is possible in a relatively easy manner, which is advantageous when

dealing with fossil material. The use of early mammal jaws for building extruded FE models has

proven useful since they are relatively flat and lack considerable anterior or other curvature along

their length. How more three-dimensionally complex jaws may lend themselves to the extruded

approach deserves further attention. Likewise, and to explore the full potential of this method,

further studies can be made on the validation of extruded FE models on different morphologies

(e.g., skull, limb bones, etc.). Enhanced extruded models, which provide more accurate results

than simple extruded models, can be made as geometrically complex as needed; however, this can

be a time-consuming process and could generate problems with meshing (further validation is

needed). Other tools, like photogrammetry, can be performed at low cost to obtain 3D structure;

however, other factors, like the size of the specimen, can present considerable obstacles to this

technique. Additionally, the presence of an obscuring matrix around the fossil can be challenging

for both photogrammetry and for building extruded models. While extruded models can be built

from the reconstruction of several specimens, it is important to understand the limitations of

the technique (e.g., must have a dorsal view picture to accurately estimate width of the jaw). On

the other hand, enhanced extruded FE models are advantageous because they can be built using

only a reduced number of pictures (i.e., lateral view, dorsal view, posterior view and, optionally,

ventral view) as opposed to photogrammetry. Enhanced or simple extruded FE models therefore

offer an alternative to 2D planar and CT scan-based 3D models for representing the mechanical

behaviour of relatively flat geometric structures, such as the mammalian mandible.
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4
FUNCTIONAL PERFORMANCE OF THE JAWS OF MESOZOIC

MAMMALS AS REVEALED BY FINITE ELEMENT ANALYSIS

This chapter is in review at PLoS One as: Morales-Garcia, N.M., Tang, K.L., Gill, P.G.,

Janis, C.M., and Rayfield, E.J. Functional performance of the jaws of Mesozoic mammals

as revealed by finite element analysis.

This project was performed in collaboration with former Palaeobiology MSc student Kit Lam

Tang. He built the original FE models of extant mammals and performed the corresponding

analyses; he also updated the method to build the enhanced extruded FE models I devised and

validated in Chapter 3 and contributed to the manuscript. Nuria Melisa Morales designed the

study, built the Mesozoic mammal models, updated the extant mammal models, performed the

Finite Element Analysis and posterior analyses on all taxa, and wrote the manuscript. Pam Gill,

Christine Janis and Emily Rayfield supervised the project and commented on the manuscript.

4.1 Abstract
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4.2 Introduction
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4.3 Materials and methods

4.3.1 Materials

4.3.2 Model construction
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4.3.3 Finite Element Analysis
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4.3.4 Intervals Method

4.3.5 Linear measurements

4.3.6 Geometric morphometrics

71





4.4. RESULTS

73



CHAPTER 4. FUNCTIONAL PERFORMANCE OF THE JAWS OF MESOZOIC MAMMALS AS
REVEALED BY FINITE ELEMENT ANALYSIS

4.4.1 Finite Element Analysis

74







4.4. RESULTS

4.4.2 Intervals Method

4.4.2.1 Convergence study

Table 4.1:

Taxon Status Diet Mean stress Taxon Status Diet Mean stress

Pteropus vampyrus Extant HR 3.24
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Principal Components Analysis
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4.5 Discussion
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CONCLUSIONS

The main aim of this thesis was to analyse the relationship between jaw morphology,

functional performance and diet in Mesozoic mammals. To do so, I used a robust sample

of modern mammals of known diets as a comparative basis and I employed a variety

of techniques, including geometric morphometrics, mechanical advantage, finite element

analysis, and phylogenetic comparative methods. I also developed a new technique to aid

in the biomechanical analysis of fossil jaws. I found clear differences in the morphology and

functional performance of the jaws of small mammals of different diets, and used this knowledge

to infer diet in Mesozoic mammals. Below, I summarise the findings of each chapter.

5.1 Jaw shape and mechanical advantage are indicative of diet
in Mesozoic mammals

Chapter 2 involved analysing the relationship between 2D jaw shape, mechanical advantage (i.e.,

a functional metric describing jaw leverage), and diet in small extant mammals, to later infer

diet in Mesozoic mammals. I decided to use this 2D approach, based on photographic data, for

several reasons: 1) after teeth, jaws are one of the most commonly preserved fossils of Mesozoic

mammals; 2) lateral view photographs of mammal jaws, both extinct and extant, are ubiquitous

in the literature and they are also easy to access in museum collections; 3) this allowed me to

gather a considerable sample size, which I would not have been able to do with other types of

data; 4) jaw morphology is intertwined with diet and, because I was able to gather a substantial

sample of both extinct and extant mammals, I had the opportunity of investigating how jaw form

and function related to the feeding ecology of small mammals; and finally 5) jaw shape analysis

of Mesozoic mammals already existed [80], but functional studies of their jaws were lacking.
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Differences in jaw morphology, which in turn relates to differences in function, between

carnivorous and herbivorous mammals have long been highlighted in the literature. For example,

the position of the condyle with respect to the tooth is a common difference observed when

comparing carnivorans with herbivorous ungulates. The condyle of carnivores tends to be in line

with the tooth row and, together with shearing teeth and large areas for the insertion of the

temporalis muscle in the jaw and, the skull and jaw morphology of carnivores allows them to

have a large gape and delivers a strong bite for slicing and crushing [43]. In contrast, ungulates

have a very dorsally positioned condyles, which increases the mechanical advantage of their main

adductor muscle: the masseter. Likewise, the tall ascending ramus of herbivorous ungulates

allows for a larger attachment area for the masseter. Together with their specialised dentition,

these traits prove ideal for grinding tough plant material [43]. Based on these ideas and, following

on from the results of Grossnickle and Polly, [80], I was hoping to find clear differences in jaw

shape between faunivorous and herbivorous extant mammals (note Grossnickle and Polly, [80]

did not find differences between the jaw shapes of carnivores and insectivores).

In contrast to Grossnickle and Polly, [80], I used a more detailed landmarking regime and a

bigger sample size, which allowed me to find a better separation between herbivores, carnivores,

and insectivores. I was also expecting that most Mesozoic mammals would have similar jaw

shapes to insectivores, and only a few specialised clades would resemble carnivores (e.g., eutri-

conodontans). I was surprised to find an extremely good correspondence between the proposed

diets of Mesozoic mammals (which were largely based on skull and dental morphology, as well as

body size, e.g., [30, 80, 98]) and the results of my study, and my findings also contributed further

evidence to support or reject the proposed diets of some Mesozoic mammals. For example, the

diet of Agilodocodon has been a matter of debate. Meng et al., [146] suggested this docodontan
had dental adaptations for an exudativorous feeding behaviour, while Wible and Burrows, [234]

refuted this hypothesis and suggested an insectivorous diet for this taxon; the latter hypothesis

is fully supported by my results.

I also expected to find a clear separation between the mechanical advantage values of the dif-

ferent dietary categories, with carnivores having high mechanical advantage of the temporalis
(MAT) and herbivores high mechanical advantage of the masseter (MAM). My results were

not so straightforward: I found that mechanical advantage values on their own do not obviously

correspond to a particular dietary category and rather should be used in a comparative manner,

alongside jaw shape. I was surprised to find that carnivores are not the only dietary group with

high MAT, but that herbivores do as well, highlighting the fact that certain morphological and

functional traits can have more than one purpose. In both herbivores and carnivores, an enlarged

temporalis muscle is key in avoiding dislocating forces when feeding but as a result of widely

different needs (i.e., struggling prey in carnivores and biting hard plant material in herbivores)

[200].

Based on the results of this chapter, I believe the methodology I used to be effective in dis-
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tinguishing dietary categories among small mammals and has the potential to be used in, not

only Mesozoic mammals, but also in other Cenozoic small mammals. It would be interesting to

analyse how this relationship between jaw shape, function and diet changes when using larger

mammals, and analyse how it changes throughout the evolution of mammals. There is room

for improvement in this study, including analysing a larger sample size of extant mammals for

further discriminant analyses of jaw shape. A limitation of this study lies on the quality of the

jaw reconstructions of some Mesozoic mammals; however, some studies that have re-evaluated

old reconstructions of fossil material using more recently developed techniques. For example,

Schultz et al., [206] re-examined the jaw morphology of Docodon victor and found that manual

reconstructions of its jaw from previous decades were incorrect; with the use of CT scan data, a

more accurate reconstruction of its jaw was achieved (and this jaw reconstruction was used in

the analyses of Chapter 2 and 4). This type of data is useful in uncovering morphology hidden in

matrix and reconstructing distorted material (see [108])

5.2 Validating the use of extruded finite-element models using
early mammal jaws

Having analysed jaw function using a 2D metric (i.e., mechanical advantage), I was interested

in analysing the three-dimensional functional performance of the jaws of small mammals using

Finite Element Analysis (FEA). However, building finite element models using tomographic data

is expensive and time-consuming, particularly because I wanted to analyse a large sample of

mammalian jaws. Building on from the MSc project of Thomas Burgess, I decided to validate

the use of simplified 3D models of early mammal jaws built from photographs for their use in

FEA. This idea, while novel in palaeontology, is common in engineering as FEA is used as a

technique to evaluate the performance of structures before they are built- paraphrasing Colin

Palmer “engineers do not CT scan bridges and perform FEA on structures that are already

operational”.

When performing this study, I anticipated that the results of these simplified 3D models,

which I called “enhanced extruded FE models” would be somewhat similar to those produced

by tomography based models: I expected the stress distribution heatmaps to be similar, but the

numerical values of stress and strain to not be identical. However, when analysing the output of

the enhanced extruded FE models, I was surprised to find that their resulting stress and strain

absolute values very closely resembled those produced by tomography-based FE models, making

enhanced extruded models a viable alternative. I believe this to be of paramount importance

regarding accessibility to techniques such as FEA. When building tomography-based models, one

needs the monetary resources to pay for at least CT scanning, segmentation software, and finite

element analysis software, which could very well amount to thousands of pounds. Hailing from a

developing country myself, I fully understand and support the need to make these cutting-edge
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techniques more accessible, and I believe the use of extruded FE models can at least reduce

the cost of performing FEA by eliminating the costs of CT scanning and segmentation software.

Extruded FE models are built in freely available software such as ImageJ and Blender, and I will

make the protocol for building these models available when publishing Chapter 4 (see Appendix

D).

Overall, I found the use of extruded FE models to be a viable alternative to the use of

tomography-based models. An extruded FE model can be built in under an hour, which makes

them ideal for performing large scale studies (as seen in Chapter 4). When compared to 2D FE

models, extruded models might take longer to build, but produce more accurate results. So far,

extruded models have only been tested on mammal jaws, but it would be relevant to test whether

other structures, like long bones or teeth, could be accurately analysed using simplified 3D models

such as these. The complexity the model is built with depends on the user, but I would advise

against building overly-complicated models because 1) it would partly defeat the purpose of the

model by taking a long time to build, and 2) errors with meshing might occur. Finally, I must

highlight a couple of limitations of this technique: 1) internal structures cannot be accounted for,

and 2) if a fossil is flattened and preserved within a slab, it might not be possible to acquire the

measurements needed for building the model. However, in general, extruded FE models can be

very useful when analysing the three-dimensional functional performance of simple structures

like the mammalian jaw.

5.3 Functional performance of the jaws of Mesozoic mammals
as revealed by Finite Element Analysis
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CHAPTER 5. CONCLUSIONS

5.4 Future avenues of research

As with any PhD, my project began with a number of goals which I did not have the time to achieve,

but are still very much viable avenues of research including 1) quantifying the jaw functional

diversity and disparity of individual Mesozoic mammal faunas, bearing in mind that there are not

a large number of faunas with pristine jaw preservation, 2) performing macroevolutionary studies

of the functional evolution of the mammalian jaw, 3) studying the functional performance and

evolution of the teeth of Mesozoic mammals, and 4) analysing the dynamics of Mesozoic terrestrial

communities and their evolution in the context of the changing environmental conditions of the

Mesozoic and relevant events like the Cretaceous Terrestrial Revolution.

5.5 Summary

In summary, this thesis has used functional, morphometric, and phylogenetic tools to identify

differences among extant small mammals of known diets, and used that knowledge to infer diet

in Mesozoic mammals. I highlighted the advantages and limitations of the approaches taken

and the level of resolution one might expect from using these techniques. Finally, I introduced a

new tool for building finite element models which I hope contributes to the accessibility of this

technique and furthers the use of large scale finite element analysis studies. Lastly, I would like

to finish with a graphic summarising the results of my thesis:
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This appendix has the supplementary information of Chapter 2.

S2 Data Supplementary Data Chapter 2. All the supporting data used in this manuscript

can be found in the following link: https://data.bris.ac.uk/webshare/Palaeobiology_Users/

ae9909fc-f5e4-48ac-82db-4a97cc12728d/.

This appendix includes the following figures and tables:

1. Complete list of taxa used in this study, and their diets (Tables A.1, A.2 and A.3).

2. Genus-level phylogenies of placentals, marsupials, and Mesozoic mammals (Figs. A.1,

A.2,A.3)

3. Time-scaled phylogeny of all the taxa considered in this study (Fig. A.4)

4. PCA and PGLS plots including allotherians (Figures A.5 and A.9)

5. All MA values obtained in this study (Table A.4)

6. Visualisations of MA values on the time-scaled phylogeny used here (Figs. A.6, A.7)

7. Morphofunctional landscape showing MA values (m1 outlever) in the context of jaw shape

(Fig. A.8)

8. PGLS plots of jaw shape and MA of the masseter and temporalis (m1 outlever) (Figs. A.10,

A.11)
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Order Common name Species name Diet

Afrosoricida Short-tailed shrew tenrec Microgale brevicaudata Insectivore
Cowan’s shrew tenrec Microgale cowani Insectivore
Giant otter shrew Potamogale velox Carnivore
Tailless tenrec Tenrec ecaudatus Omnivore

Carnivora Northern olingo Bassaricyon gabbii Herbivore
Humboldt’s hog-nosed skunk Conepatus humboldtii Omnivore
Common kusimanse Crossarchus obscurus Omnivore
Tayra Eira barbara Omnivore
Sand cat Felis margarita Carnivore
Malagasy civet Fossa fossana Carnivore
Ring-tailed vontsira Galidia elegans Omnivore
Common genet Genetta genetta Carnivore
Javan mongoose Herpestes javanicus Omnivore
Margay Leopardus wiedii Carnivore
South American gray fox Lycalopex griseus Omnivore
Hooded skunk Mephitis macroura Omnivore
Least weasel Mustela nivalis Carnivore
African palm civet Nandinia binotata Omnivore
White-nosed coati Nasua narica Omnivore
Asian palm civet Paradoxurus hermaphroditus Omnivore
Spotted linsang Prionodon pardicolor Carnivore
Corsac fox Vulpes corsac Carnivore

Chiroptera Jamaican fruit bat Artibeus jamaicensis Herbivore
Big-eared woolly bat Chrotopterus auritus Omnivore
Little brown bat Myotis lucifugus Insectivore
Greater bulldog bat Noctilio leporinus Carnivore
Brown long-eared bat Plecotus auritus Insectivore
Large flying fox Pteropus vampyrus Herbivore

Eulipotyphla Four-toed hedgehog Atelerix albiventris Omnivore
Northern short-tailed shrew Blarina brevicauda Omnivore
Hairy-tailed mole Parascalops breweri Insectivore
Hispaniolan solenodon Solenodon paradoxus Insectivore

Macroscelidea Short-snouted elephant shrew Elephantulus brachyrhynchus Omnivore
Rufous elephant shrew Elephantulus rufescens Omnivore

Scandentia Striped treeshrew Tupaia dorsalis Omnivore
Common treeshrew Tupaia glis Omnivore
Ruddy treeshrew Tupaia splendidula Omnivore

Table A.1: List of extant placental taxa used in this study and their dietary categories.
Dietary information obtained from [153]. Yellow=Insectivore; Red= Carnivore; Purple= Omnivore;
Blue= Herbivore
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Order Common name Species name Diet

Dasyuromorphia Yellow-footed antechinus Antechinus flavipes leucogaster Insectivore
Dusky antechinus Antechinus swainsonii Insectivore
Western quoll Dasyurus geoffroii Carnivore
Northern quoll Dasyurus hallucatus Carnivore
Numbat Myrmecobius fasciatus Insectivore
Dibbler Parantechinus apicalis Insectivore
Brushed-tailed phascogale Phascogale tapoatafa Omnivore
Long-tailed planigale Planigale ingrami Insectivore
Fat-tailed dunnart Sminthopsis crassicaudata Insectivore

Didelphimorphia Derby’s woolly opossum Caluromys derbianus Omnivore
Water opossum Chironectes minimus Carnivore
Robinson’s mouse opossum Marmosa robinsoni Omnivore
Brown four-eyed opossum Metachirus nudicaudatus Omnivore
Northern three-striped opossum Monodelphis americana Omnivore
Anderson’s four-eyed opossum Philander andersoni Omnivore

Diprotodontia Feathertail glider Acrobates pygmaeus Omnivore
Woylie Bettongia penicillata Omnivore
Goodfellow’s tree kangaroo Dendrolagus goodfellowi Herbivore
Small dorcopsis Dorcopsulus vanheurni Herbivore
Sugar glider Petaurus breviceps Omnivore
Northern common cuscus Phalanger orientalis Herbivore
Long-nosed potoroo Potorous tridactylus Omnivore
Common ringtail possum Pseudocheirus peregrinus Herbivore
Tasmanian pademelon Thylogale billardierii Herbivore
Common brushtail possum Trichosurus vulpecula Omnivore

Microbiotheria Monito del monte Dromiciops gliroides Insectivore

Paucituberculata Long-nosed caenolestid Rhyncholestes raphanurus Omnivore

Peramelemorphia Western barred bandicoot Perameles bougainville Omnivore

Table A.2: List of extant marsupial taxa used in this study and their dietary categories.
Dietary information obtained from [153]. Yellow=Insectivore; Red= Carnivore; Purple= Omnivore;
Blue= Herbivore
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Higher clade Genus Suggested diet Source

Stem mammals

Haramiyavia Herbivore/omnivore [117]
Sinoconodon Carnivore/scavenger [97, 98]

Morganucodonta Morganucodon Insectivore [75]
Dinnertherium Unknown

Docodonta Agilodocodon Omnivore [30]
Castorocauda Carnivore [30]
Haldanodon Insectivore [167]
Docodon Insectivore [167]
Docofossor Insectivore [30]
Agilodocodon Insectivore [234]
Microdocodon Unknown

Non-therian crown mammals

Fruitafossor Omnivore [124]

Australosphenida Henosferus Unknown
Teinolophos Invertivore [186]

Eutriconodonta Volaticotherium Insectivore [30]
Phascolotherium Unknown
Yanoconodon Insectivore [30]
Triconodon Carnivore [98, 195]
Trioracodon Carnivore [98, 195]
Argentoconodon Unknown
Gobiconodon Carnivore [30]
Repenomamus Carnivore [30, 88]

"Symmetrodonta" Spalacotherium Unknown
Origolestes Unknown
Zhangheotherium Insectivore [30]
Maotherium Insectivore [30]

Dryolestidae Crusafontia Unknown
Amblotherium Unknown

Amphitherium Unknown
Vincelestes Carnivore/omnivore [20, 194]

Therian crown mammals

Eutheria Sinodelphys Insectivore [30]
Juramaia Insectivore [30]
Eomaia Insectivore [30]
Maelestes Unknown
Asioryctes Unknown
Sasayamamylos Unknown
Kennalestes Insectivore [80]
Daulestes Unknown
Uchkudukodon Unknown
Kulbeckia Insectivore [80]
Barunlestes Insectivore [80]
Zalambdalestes Unknown

Metatheria Deltatheridium Carnivore [195]
Alphadon Insectivore [80]
Didelphodon Carnivore [39, 195]
Eodelphis Carnivore [39]

Table A.3: List of extinct taxa used in this study and their suggested dietary categories.
Dietary information obtained from [20, 30, 39, 75, 80, 88, 97, 98, 117, 124, 167, 186, 194, 195, 234].
Yellow=Insectivore; Red= Carnivore; Purple= Omnivore; Blue= Herbivore.
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Figure A.1: Genus-level phylogeny of the Mesozoic taxa used in this study. Phylogeny
assembled from [38, 91] (overall topology), [99] (Haramiyavia), [146] (Morganucodonta), [247]
(Docodonta), [197] (Australosphenida), [73, 113] (Eutriconodonta), [129] (Symmetrodonta) [11]
(Dryolestidae), [237] (Metatheria), [7, 8, 17, 106] (Eutheria)
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Figure A.2: Species level phylogeny of the marsupial taxa used in this study. Phylogeny
modified from [137]
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Figure A.3: Species level phylogeny of the placental taxa used in this study. Phylogeny
assembled from [215] (overall topology), [190] (Scandentia), [157] (Carnivora), [3] (Chiroptera),
[216] (Eulipotyphla), [208] (Afrosoricida).
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Figure A.4: Time scaled phylogeny. Dated using the ’equal’ method of [24]. Phylogeny assem-
bled using sources detailed in Figs. A.1, A.2, A.3
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Figure A.5: Scatter plots of the Principal Component Analysis (PCA) results (PC1 vs
PC2), including allotherians (i.e., multituberculates and haramiyids). a) Extant taxa, b)
Extinct taxa. Convex hulls shown for extant insectivores (yellow), carnivores (red), omnivores
(purple) and herbivores (blue). Icon colours indicate known dietary categories of extant mammals
and suggested dietary categories for Mesozoic mammals (obtained from the literature).

105



APPENDIX A. APPENDIX A

Figure A.6: Mechanical advantage values of the temporalis (left) and masseter (right)
visualised in the context of the phylogeny used in this study, with taxa names. Moment
arm of resistance measured at the jaw tip. Taxon numbers as in Figure 2.1
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Figure A.7: Mechanical advantage values of the temporalis (left) and masseter (right)
visualised in the context of the phylogeny used in this study, with taxa names. Moment
arm of resistance measured at the m1.
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Figure A.8: Morphofunctional landscape comparing a functional metric (i.e., mechan-
ical advantage of the masseter [A, MAM] and temporalis [B, MAT]) with jaw shape
(PC1 and PC2 axes). Moment arm of resistance for mechanical advantage measured
at the m1. Silhouette colours are indicative of the mechanical advantage values of the taxa.
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Figure A.9: PGLS regression of Procrustes coordinates (i.e., jaw shape) on mechani-
cal advantage of the masseter (a) and temporalis (b). Only extinct taxa are shown;
includes allotherians. Colours indicate suggested dietary categories for Mesozoic mammals
(obtained from the literature). Colored ovals indicate where extant taxa of known dietary cate-
gories plot.
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Figure A.10: Relationship between jaw shape and mechanical advantage of the mas-
seter measured at the m1. PGLS regression of Procrustes coordinates on mechanical advan-
tage of the masseter on extant taxa (a) and extinct taxa (b). Colours indicate known dietary
categories of extant mammals and suggested dietary categories for Mesozoic mammals (obtained
from the literature). Ovals indicate where extant taxa of known dietary categories plot.
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Figure A.11: Relationship between jaw shape and mechanical advantage of the tempo-
ralis measured at the m1. PGLS regression of Procrustes coordinates on mechanical advantage
of the temporalis on extant taxa (a) and extinct taxa (b). Colours indicate known dietary cate-
gories of extant mammals and suggested dietary categories for Mesozoic mammals (obtained
from the literature). Ovals indicate where extant taxa of known dietary categories plot.
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Taxon MAT
(m1)

MAM
(m1)

MAT
(jaw tip)

MAM
(jaw tip)

1 Haramiyavia 0.388 0.628 0.254 0.410
2 Sinoconodon 0.403 0.532 0.281 0.371
3 Morganucodon 0.427 0.523 0.288 0.353
4 Dinnetherium 0.307 0.473 0.208 0.321
5 Castorocauda 0.277 0.395 0.183 0.261
6 Haldanodon 0.389 0.490 0.295 0.373
7 Docofossor 0.496 0.511 0.335 0.341
8 Docodon 0.384 0.370 0.302 0.291
9 Agilodocodon 0.307 0.504 0.183 0.300
10 Microdocodon 0.320 0.456 0.183 0.261
11 Fruitafossor 0.468 0.628 0.297 0.399
12 Henosferus 0.426 0.411 0.220 0.212
13 Teinolophos 0.263 0.426 0.141 0.229
14 Phascolotherium 0.375 0.397 0.241 0.256
15 Yanoconodon 0.417 0.361 0.289 0.249
16 Triconodon 0.549 0.385 0.360 0.252
17 Trioracodon 0.425 0.354 0.273 0.228
18 Volaticotherium 0.503 0.345 0.312 0.214
19 Argentoconodon 0.511 0.441 0.318 0.274
20 Gobiconodon 0.416 0.397 0.323 0.307
21 Repenomamus 0.472 0.415 0.346 0.305
22 Spalacotherium 0.281 0.393 0.186 0.260
23 Origolestes 0.211 0.496 0.136 0.318
24 Zhangheotherium 0.237 0.397 0.164 0.274
25 Maotherium 0.288 0.419 0.204 0.296
26 Crusafontia 0.360 0.360 0.253 0.253
27 Amblotherium 0.273 0.407 0.187 0.279
28 Amphitherium 0.288 0.402 0.205 0.286
29 Vincelestes 0.505 0.654 0.333 0.431
30 Deltatheridium 0.401 0.458 0.284 0.323
31 Didelphodon 0.376 0.450 0.280 0.335
32 Eodelphis 0.437 0.448 0.311 0.319
33 Alphadon 0.386 0.399 0.259 0.268
34 Sinodelphys 0.350 0.374 0.188 0.201
35 Juramaia 0.361 0.479 0.200 0.265
36 Eomaia 0.493 0.421 0.270 0.229
37 Maelestes 0.439 0.405 0.239 0.221
38 Asioryctes 0.450 0.436 0.271 0.262
39 Sasayamamylos 0.403 0.431 0.249 0.266
40 Kennalestes 0.382 0.361 0.225 0.207
41 Daulestes 0.415 0.424 0.242 0.248
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42 Uchkudukudon 0.389 0.366 0.256 0.241
43 Kulbeckia 0.418 0.430 0.275 0.282
44 Barunlestes 0.366 0.546 0.220 0.328
45 Zalambdalestes 0.332 0.478 0.187 0.269

46 Bettongia penicillata 0.306 0.607 0.211 0.418
47 Potorous tridactylus 0.243 0.479 0.186 0.366
48 Thylogale billardierii 0.403 0.519 0.269 0.347
49 Dendrolagus goodfellowi 0.383 0.538 0.284 0.399
50 Dorcopsulus vanheurni 0.396 0.496 0.286 0.358
51 Petaurus breviceps 0.426 0.487 0.352 0.403
52 Pseudocheirus peregrinus 0.416 0.476 0.364 0.416
53 Acrobates pygmaeus 0.366 0.388 0.311 0.330
54 Phalanger orientalis 0.414 0.535 0.304 0.394
55 Trichosurus vulpecula 0.401 0.552 0.296 0.408
56 Dasyurus hallucatus 0.335 0.348 0.252 0.262
57 Dasyurus geoffroii 0.391 0.376 0.301 0.290
58 Sarcophilus harrisi 0.339 0.377 0.272 0.303
59 Parantechinus apicalis 0.303 0.403 0.230 0.305
60 Phascogale tapoatafa 0.287 0.428 0.210 0.314
61 Antechinus swainsonii 0.273 0.347 0.193 0.246
62 Antechinus flavipes 0.227 0.428 0.166 0.315
63 Sminthopsis crassicaudata 0.249 0.404 0.183 0.297
64 Planigale ingrami 0.349 0.285 0.270 0.220
65 Myrmecobius fasciatus 0.214 0.431 0.124 0.250
66 Perameles bougainville 0.197 0.409 0.114 0.237
67 Dromiciops gliroides 0.294 0.470 0.204 0.326
68 Philander andersoni 0.370 0.395 0.254 0.271
69 Chironectes minimus 0.386 0.420 0.275 0.299
70 Metachirus nudicaudatus 0.350 0.398 0.251 0.285
71 Marmosa robinsoni 0.322 0.439 0.217 0.296
72 Monodelphis americana 0.268 0.413 0.175 0.270
73 Caluromys derbianus 0.402 0.486 0.283 0.342
74 Rhyncholestes raphanurus 0.337 0.411 0.241 0.293

75 Tupaia splendidula 0.262 0.415 0.175 0.277
76 Tupaia dorsalis 0.185 0.390 0.117 0.247
77 Tupaia glis 0.374 0.389 0.252 0.261
78 Nandinia binotata 0.521 0.468 0.293 0.263
79 Leopardus wiedii 0.436 0.468 0.256 0.275
80 Lynx rufus 0.451 0.494 0.267 0.292
81 Felis margarita 0.491 0.497 0.298 0.301
82 Prionodon pardicolor 0.482 0.419 0.266 0.231
83 Genetta genetta 0.507 0.473 0.248 0.231
84 Paradoxurus hermaphroditus 0.482 0.446 0.307 0.284
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85 Fossa fossana 0.447 0.415 0.244 0.226
86 Galidia elegans 0.530 0.390 0.305 0.224
87 Crossarchus oscurus 0.461 0.471 0.262 0.268
88 Herpestes javanicus 0.607 0.437 0.311 0.224
89 Lycalopex griseus 0.421 0.440 0.230 0.240
90 Vulpes corsac 0.470 0.412 0.256 0.224
91 Mephitis macroura 0.590 0.386 0.414 0.271
92 Conepatus humboldtii 0.551 0.410 0.368 0.274
93 Nasua narica 0.360 0.496 0.202 0.278
94 Bassaricyon gabbii 0.561 0.489 0.332 0.289
95 Procyon lotor 0.492 0.474 0.310 0.299
96 Taxidea taxus 0.615 0.484 0.372 0.293
97 Eira barbara 0.618 0.516 0.378 0.315
98 Lontra canadensis 0.616 0.422 0.394 0.271
99 Mustela nivalis 0.659 0.408 0.404 0.250
100 Pteropus vampyrus 0.429 0.486 0.274 0.311
101 Noctilio leporinus 0.305 0.392 0.260 0.334
102 Artibeus jamaiciensis 0.432 0.359 0.334 0.277
103 Chrotopterus auritus 0.428 0.411 0.276 0.265
104 Myotis lucifugus 0.372 0.358 0.254 0.245
105 Plecotus auritus 0.324 0.288 0.246 0.218
106 Blarina brevicauda 0.425 0.419 0.358 0.354
107 Atelerix albiventris 0.394 0.476 0.307 0.371
108 Parascalops breweri 0.437 0.385 0.323 0.284
109 Solenodon paradoxus 0.467 0.445 0.290 0.276
110 Microgale cowani 0.399 0.372 0.226 0.210
111 Microgale brevicaudata 0.481 0.394 0.296 0.243
112 Tenrec ecaudatus 0.443 0.478 0.231 0.249
113 Potamogale velox 0.498 0.355 0.295 0.211
114 Elephantulus rufescens 0.227 0.584 0.150 0.387
115 Elephantulus brachyrhynchus 0.198 0.608 0.130 0.399

Table A.4: Mechanical advantage values of the temporalis (MAT) and masseter (MAM) obtained
in this study. Outlever measured at the m1 and the jaw tip.
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This appendix has the detailed results of the sensitivity analyses (Subsection 3.5.2) of

Chapter 3. It includes 6 tables with the raw strain and stress values of across all itera-

tions, and 6 tables which depict these results using percentages (of how they compare to

the original values).

For the supporting data of this Chapter, refer to:

S3 Data Supplementary Data Chapter 3. All the supporting data used in this paper can be

found in the following link: https://www.doi.org/10.5523/bris.2b5w9l61qc6vl2rrkhv0sdex6v.

It includes all the finite element models and field output reports used to validate the use of

extruded finite element models.
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Strain Stress Validity
Mean Median Max Mean Median Max

1 137.2 90.9 2722.7 3.6 2.8 55.5 Valid
2 135.5 90.9 2719.1 3.6 2.8 55.3 Invalid
3 136.8 91.5 2665.0 3.6 2.8 55.2 Valid
4 135.8 90.4 2610.1 3.6 2.7 55.6 Valid
5 136.0 91.5 2797.9 3.6 2.8 55.2 Invalid
6 135.0 90.5 2641.3 3.6 2.8 55.5 Invalid
7 136.7 90.2 2735.8 3.6 2.7 55.7 Valid
8 137.7 91.4 2718.5 3.6 2.8 55.3 Valid
9 142.9 94.5 2805.2 3.7 2.9 55.7 Invalid
10 131.6 92.0 2637.4 3.5 2.8 54.9 Valid
11 132.3 90.5 2641.1 3.5 2.8 55.1 Valid
12 145.4 95.6 2942.7 3.8 2.9 55.9 Invalid
13 144.7 95.7 2829.8 3.8 2.9 55.7 Invalid
14 132.2 91.5 2583.3 3.5 2.8 54.8 Valid
15 131.6 90.9 2581.5 3.5 2.8 55.2 Valid
16 143.6 94.4 2787.5 3.7 2.8 56.0 Invalid
17 144.1 95.1 2805.0 3.8 2.9 55.8 Invalid
18 131.9 91.2 2529.4 3.5 2.8 55.0 Valid
19 132.7 90.8 2600.8 3.5 2.8 54.9 Valid
20 142.4 93.9 2725.4 3.7 2.8 55.9 Invalid
21 146.0 96.2 2968.2 3.8 2.9 55.8 Invalid
22 131.3 91.8 2561.9 3.5 2.8 55.1 Valid
23 131.9 92.1 2714.0 3.5 2.8 54.7 Valid
24 144.9 95.1 2924.1 3.8 2.8 56.1 Invalid
25 132.0 90.1 2689.6 3.5 2.8 55.3 Valid
26 143.5 95.1 2885.8 3.7 2.9 55.6 Invalid

Original 136.3 90.9 2590.0 3.6 2.8 55.4
Min 131.3 90.1 2529.4 3.5 2.7 54.7
Max 146.0 96.2 2968.2 3.8 2.9 56.1
STD 5.3 2.0 121.0 0.1 0.04 0.4

Table B.1: Raw stress (MPa) and strain (microstrain) results of the sensitivity analyses:
Morganucodon, moving all muscles 1%. Min= minimum, Max= maximum, STD= standard
deviation.
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Strain Stress Validity
Mean Median Max Mean Median Max

1 100.67 100.04 105.13 100.45 99.56 100.20 Valid
2 99.41 99.96 104.98 99.63 100.30 99.85 Invalid
3 100.38 100.63 102.89 100.33 100.54 99.73 Valid
4 99.67 99.51 100.78 99.72 99.12 100.33 Valid
5 99.79 100.69 108.03 99.96 100.97 99.55 Invalid
6 99.09 99.54 101.98 99.35 99.54 100.16 Invalid
7 100.34 99.27 105.63 100.16 98.90 100.50 Valid
8 101.05 100.56 104.96 100.79 100.38 99.90 Valid
9 104.87 104.03 108.31 104.22 103.07 100.63 Invalid
10 96.57 101.25 101.83 97.46 101.75 99.08 Valid
11 97.09 99.52 101.97 97.59 100.02 99.43 Valid
12 106.70 105.23 113.62 105.59 103.29 100.98 Invalid
13 106.21 105.30 109.26 105.29 103.84 100.50 Invalid
14 97.04 100.64 99.74 97.70 101.22 98.95 Valid
15 96.59 100.04 99.67 97.31 100.24 99.56 Valid
16 105.35 103.84 107.63 104.51 102.45 101.10 Invalid
17 105.75 104.60 108.30 104.87 103.07 100.80 Invalid
18 96.79 100.36 97.66 97.48 100.93 99.25 Valid
19 97.36 99.92 100.42 97.81 100.53 99.13 Valid
20 104.47 103.28 105.23 103.86 102.44 100.93 Invalid
21 107.15 105.82 114.60 106.00 103.86 100.68 Invalid
22 96.37 100.96 98.91 97.29 101.36 99.38 Valid
23 96.82 101.36 104.79 97.68 102.06 98.78 Valid
24 106.31 104.58 112.90 105.23 102.74 101.28 Invalid
25 96.88 99.08 103.84 97.41 99.52 99.73 Valid
26 105.33 104.61 111.42 104.63 103.73 100.33 Invalid

Table B.2: Comparative stress (MPa) and strain (microstrain) results of the sensitiv-
ity analyses, represented in percentages: Morganucodon, moving all muscles 1%. Min=
minimum, Max= maximum, STD= standard deviation.
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Strain Stress Validity
Mean Median Max Mean Median Max

1 141.9 92.1 3269.1 3.7 2.8 58.9 Valid
2 133.4 91.9 3255.4 3.5 2.9 54.9 Invalid
3 139.6 93.0 2985.1 3.7 2.8 54.6 Valid
4 134.8 87.2 2760.7 3.5 2.7 56.3 Invalid
5 136.5 92.7 3668.4 3.6 2.9 58.8 Invalid
6 132.1 88.7 2858.1 3.5 2.7 55.8 Invalid
7 140.5 89.4 3366.7 3.7 2.7 56.7 Valid
8 145.1 94.9 3350.9 3.8 2.8 66.0 Valid
9 185.2 122.8 3741.3 4.7 3.6 77.6 Invalid

10 159.8 118.5 3142.6 4.2 3.4 59.3 Invalid
11 145.0 104.0 3706.4 3.8 3.0 57.7 Invalid
12 205.2 136.5 5068.0 5.2 3.9 110.0 Invalid
13 199.2 132.4 4738.0 5.1 3.8 104.0 Invalid
14 151.1 109.6 2829.3 4.0 3.2 52.4 Invalid
15 152.6 108.9 3947.9 4.0 3.1 69.1 Invalid
16 191.5 127.3 4028.7 4.9 3.7 83.0 Invalid
17 194.5 129.3 4363.6 4.9 3.7 93.0 Invalid
18 150.8 109.2 3376.9 4.0 3.1 57.2 Invalid
19 145.5 105.2 3186.8 3.8 3.0 52.9 Invalid
20 181.9 120.4 3339.0 4.6 3.5 66.2 Invalid
21 209.6 139.5 5426.1 5.3 4.0 120.0 Invalid
22 161.6 118.5 3712.8 4.2 3.4 71.4 Invalid
23 160.0 118.6 3222.6 4.2 3.5 52.0 Invalid
24 202.5 134.3 4749.9 5.1 3.8 101.1 Invalid
25 146.6 102.8 4260.1 3.9 2.9 69.7 Invalid
26 190.1 126.2 4175.8 4.9 3.7 89.7 Invalid

Original 136.3 90.9 2590.0 3.6 2.8 55.4
Min 132.1 87.2 2760.7 3.5 2.7 52.0
Max 209.6 139.5 5426.1 5.3 4.0 120.0
STD 25.8 16.8 712.5 0.6 0.42 20.0

Table B.3: Raw stress (MPa) and strain (microstrain) results of the sensitivity analyses:
Morganucodon, moving all muscles 5%. Min= minimum, Max= maximum, STD= standard
deviation.
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Strain Stress Validity
Mean Median Max Mean Median Max

1 104.10 101.35 126.22 103.02 99.60 106.35 Valid
2 97.86 101.15 125.69 98.97 102.99 99.16 Invalid
3 102.42 102.37 115.25 102.15 102.71 98.54 Valid
4 98.90 95.91 106.59 99.03 95.97 101.55 Invalid
5 100.14 101.98 141.64 100.91 103.19 106.12 Invalid
6 96.91 97.55 110.35 98.11 98.94 100.68 Invalid
7 103.08 98.38 129.99 102.10 96.71 102.42 Valid
8 106.50 104.38 129.38 105.23 102.75 119.18 Valid
9 135.89 135.09 144.45 132.06 130.00 140.02 Invalid
10 117.30 130.38 121.34 117.43 122.55 106.99 Invalid
11 106.40 114.47 143.10 106.74 107.84 104.18 Invalid
12 150.61 150.21 195.67 144.79 139.97 198.62 Invalid
13 146.19 145.62 182.93 141.25 137.82 187.64 Invalid
14 110.85 120.62 109.24 111.52 114.83 94.67 Invalid
15 111.96 119.86 152.43 112.00 111.89 124.64 Invalid
16 140.54 140.01 155.55 135.78 131.79 149.79 Invalid
17 142.76 142.28 168.48 137.92 134.95 167.89 Invalid
18 110.66 120.10 130.38 111.12 113.23 103.28 Invalid
19 106.75 115.78 123.04 107.07 109.01 95.55 Invalid
20 133.47 132.44 128.92 129.78 127.20 119.45 Invalid
21 153.83 153.54 209.50 147.95 142.90 216.53 Invalid
22 118.62 130.43 143.35 118.18 121.06 128.82 Invalid
23 117.39 130.49 124.43 117.90 124.55 93.80 Invalid
24 148.61 147.72 183.39 142.84 137.77 182.44 Invalid
25 107.55 113.13 164.48 107.68 106.37 125.90 Invalid
26 139.53 138.82 161.23 135.53 133.09 161.91 Invalid

Table B.4: Comparative stress (MPa) and strain (microstrain) results of the sensitiv-
ity analyses, represented in percentages: Morganucodon, moving all muscles 5%. Min=
minimum, Max= maximum, STD= standard deviation.
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Strain Stress Validity
Mean Median Max Mean Median Max

1 149.9 96.5 3999.5 3.9 2.9 78.8 Valid
2 134.0 95.0 3938.1 3.6 3.0 62.7 Invalid
3 144.8 95.6 3399.8 3.8 2.9 58.9 Valid
4 135.0 82.7 3108.3 3.5 2.5 57.1 Invalid
5 141.3 90.4 4788.6 3.7 2.8 77.9 Invalid
6 134.0 87.6 3130.0 3.6 2.7 56.2 Invalid
7 149.5 93.2 4254.2 3.8 2.7 73.2 Valid
8 157.9 102.3 4305.9 4.1 3.0 92.9 Valid
9 254.7 169.3 5427.7 6.4 4.7 121.3 Invalid

10 246.8 182.6 4815.6 6.3 5.0 114.3 Invalid
11 201.3 148.5 5653.2 5.2 4.1 103.2 Invalid
12 300.9 197.6 8086.2 7.5 5.3 181.8 Invalid
13 287.4 188.7 7566.3 7.2 5.1 172.4 Invalid
14 218.8 155.5 3947.4 5.6 4.4 79.3 Invalid
15 228.2 166.4 6345.2 5.8 4.5 130.2 Invalid
16 269.8 175.8 5918.8 6.7 4.9 127.7 Invalid
17 275.9 183.2 6718.8 6.9 5.0 149.1 Invalid
18 220.4 162.6 5138.7 5.6 4.5 104.6 Invalid
19 199.4 143.3 4469.2 5.1 4.0 77.1 Invalid
20 247.5 162.7 4584.3 6.2 4.6 96.4 Invalid
21 311.2 203.1 8894.3 7.7 5.5 202.6 Invalid
22 253.3 186.0 5986.8 6.4 5.0 139.3 Invalid
23 246.2 177.5 4214.1 6.3 5.0 89.8 Invalid
24 295.9 190.7 7336.5 7.4 5.2 163.1 Invalid
25 209.6 150.2 6856.3 5.4 4.2 129.4 Invalid
26 267.4 175.0 6307.3 6.7 4.8 147.3 Invalid

Original 136.3 90.9 2590.0 3.6 2.8 55.4
Min 134.0 82.7 3108.3 3.5 2.5 56.2
Max 311.2 203.1 8894.3 7.7 5.5 202.6
STD 58.7 40.5 1560.9 1.4 1.00 41.1

Table B.5: Raw stress (MPa) and strain (microstrain) results of the sensitivity analyses:
Morganucodon, moving all muscles 10%. Min= minimum, Max= maximum, STD= standard
deviation.
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Strain Stress Validity
Mean Median Max Mean Median Max

1 110.01 106.18 154.42 107.86 102.95 142.28 Valid
2 98.35 104.54 152.05 100.20 106.74 113.25 Invalid
3 106.25 105.22 131.27 105.67 104.57 106.26 Valid
4 99.11 90.97 120.01 99.16 90.64 103.10 Invalid
5 103.68 99.43 184.89 104.68 100.16 140.60 Invalid
6 98.31 96.36 120.85 99.69 96.53 101.38 Invalid
7 109.70 102.57 164.25 107.49 98.97 132.06 Valid
8 115.90 112.56 166.25 113.50 108.96 167.72 Valid
9 186.89 186.27 209.56 178.71 170.19 218.97 Invalid
10 181.13 200.88 185.93 175.46 181.14 206.28 Invalid
11 147.70 163.43 218.27 144.41 148.58 186.29 Invalid
12 220.82 217.35 312.21 209.10 192.91 328.13 Invalid
13 210.93 207.66 292.14 200.65 185.75 311.20 Invalid
14 160.56 171.06 152.41 157.33 159.33 143.15 Invalid
15 167.48 183.05 244.99 162.00 162.34 235.02 Invalid
16 197.98 193.44 228.52 188.29 175.22 230.51 Invalid
17 202.45 201.58 259.41 192.50 181.05 269.16 Invalid
18 161.73 178.90 198.40 157.41 161.10 188.84 Invalid
19 146.37 157.69 172.55 143.77 144.24 139.24 Invalid
20 181.62 178.99 177.00 173.79 165.25 174.03 Invalid
21 228.39 223.50 343.41 216.40 197.97 365.67 Invalid
22 185.90 204.59 231.15 178.95 180.39 251.46 Invalid
23 180.68 195.27 162.71 176.10 181.44 162.09 Invalid
24 217.19 209.85 283.26 205.70 187.79 294.45 Invalid
25 153.81 165.29 264.72 149.56 150.50 233.64 Invalid
26 196.25 192.52 243.52 187.63 174.37 265.88 Invalid

Table B.6: Comparative stress (MPa) and strain (microstrain) results of the sensitiv-
ity analyses, represented in percentages: Morganucodon, moving all muscles 10%. Min=
minimum, Max= maximum, STD= standard deviation.
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Strain Stress Validity
Mean Median Max Mean Median Max

1 133.9 55.2 5405.7 3.7 1.7 85.0 Valid
2 131.3 56.3 5387.5 3.7 1.6 84.7 Valid
3 133.8 57.3 5272.0 3.7 1.7 82.9 Valid
4 131.3 54.2 5521.2 3.7 1.6 86.8 Valid
5 132.5 57.6 5263.0 3.7 1.7 82.7 Valid
6 130.2 54.6 5512.1 3.6 1.6 86.6 Valid
7 132.7 53.7 5530.4 3.7 1.6 86.9 Valid
8 135.3 56.6 5281.1 3.8 1.7 83.0 Valid
9 132.0 48.9 5701.7 3.7 1.5 89.7 Invalid
10 136.7 64.2 5077.1 3.8 1.8 79.8 Valid
11 137.7 61.5 5094.9 3.8 1.7 80.1 Valid
12 136.4 49.8 5720.2 3.8 1.6 90.0 Invalid
13 135.7 50.8 5586.1 3.7 1.6 87.8 Invalid
14 138.0 63.8 4961.7 3.8 1.8 78.0 Valid
15 136.4 61.8 5210.2 3.8 1.7 81.9 Valid
16 132.7 47.6 5835.8 3.7 1.5 91.8 Invalid
17 134.1 49.3 5710.9 3.7 1.5 89.8 Invalid
18 137.1 62.8 5086.0 3.8 1.7 79.9 Valid
19 138.7 62.9 4970.6 3.8 1.8 78.1 Valid
20 130.7 47.2 5826.5 3.6 1.5 91.6 Invalid
21 138.0 51.5 5595.3 3.8 1.6 88.0 Invalid
22 136.1 63.4 5201.3 3.8 1.7 81.7 Valid
23 137.4 65.0 4952.9 3.8 1.8 77.8 Valid
24 134.9 48.1 5845.0 3.7 1.5 91.9 Invalid
25 136.9 60.5 5219.2 3.8 1.7 82.0 Valid
26 133.6 50.6 5576.9 3.7 1.6 87.7 Invalid

Original 132.5 55.8 5396.6 3.7 1.6 84.8
Min 130.2 47.2 4952.9 3.6 1.5 77.8
Max 138.7 65.0 5845.0 3.8 1.8 91.9
STD 2.5 5.9 285.5 0.1 0.10 4.5

Table B.7: Raw stress (MPa) and strain (microstrain) results of the sensitivity analyses:
Kuehneotherium, moving all muscles 1%. Min= minimum, Max= maximum, STD= standard
deviation.
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Strain Stress Validity
Mean Median Max Mean Median Max

1 101.08 98.94 100.17 100.91 100.67 100.17 Valid
2 99.06 100.80 99.83 99.22 99.82 99.83 Valid
3 100.99 102.59 97.69 100.93 103.30 97.69 Valid
4 99.11 97.02 102.31 99.16 96.81 102.31 Valid
5 99.99 103.19 97.52 100.11 103.36 97.51 Valid
6 98.23 97.82 102.14 98.42 96.31 102.14 Valid
7 100.14 96.18 102.48 100.02 97.18 102.49 Valid
8 102.12 101.38 97.86 101.89 103.83 97.86 Valid
9 99.66 87.53 105.65 99.35 92.80 105.71 Invalid
10 103.15 115.03 94.08 103.08 107.30 94.04 Valid
11 103.95 110.23 94.41 103.70 105.01 94.38 Valid
12 102.94 89.19 106.00 102.17 94.14 106.07 Invalid
13 102.40 91.03 103.51 101.79 95.92 103.57 Invalid
14 104.14 114.36 91.94 103.98 108.17 91.91 Valid
15 102.93 110.69 96.55 102.76 103.55 96.52 Valid
16 100.14 85.24 108.14 99.68 90.03 108.21 Invalid
17 101.22 88.28 105.82 100.70 92.96 105.89 Invalid
18 103.47 112.43 94.24 103.32 105.67 94.21 Valid
19 104.70 112.60 92.11 104.42 107.81 92.08 Valid
20 98.61 84.59 107.97 98.36 89.54 108.03 Invalid
21 104.15 92.17 103.68 103.29 97.17 103.75 Invalid
22 102.70 113.55 96.38 102.58 105.21 96.35 Valid
23 103.73 116.41 91.78 103.67 109.37 91.74 Valid
24 101.82 86.11 108.31 101.14 91.11 108.39 Invalid
25 103.32 108.30 96.71 103.07 102.25 96.69 Valid
26 100.80 90.65 103.34 100.42 96.07 103.39 Invalid

Table B.8: Comparative stress (MPa) and strain (microstrain) results of the sensitiv-
ity analyses, represented in percentages: Kuehneotherium, moving all muscles 1%. Min=
minimum, Max= maximum, STD= standard deviation.
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Strain Stress Validity
Mean Median Max Mean Median Max

1 141.4 52.1 5442.2 3.9 1.6 90.6 Valid
2 128.4 57.9 5351.3 3.6 1.6 84.1 Invalid
3 140.7 62.5 4774.1 3.9 1.9 75.0 Valid
4 127.8 47.3 6020.0 3.6 1.4 94.6 Valid
5 134.8 63.7 4729.1 3.8 1.9 74.3 Invalid
6 125.9 52.3 5974.3 3.5 1.4 93.9 Invalid
7 135.0 43.9 6065.8 3.7 1.4 99.7 Valid
8 150.9 60.0 4819.2 4.1 1.9 82.5 Valid
9 170.1 101.7 7033.5 4.5 2.9 109.6 Invalid

10 203.9 146.8 4236.0 5.4 4.0 76.2 Invalid
11 191.8 123.9 4614.3 5.1 3.4 85.4 Invalid
12 205.2 128.7 7158.7 5.4 3.7 115.2 Invalid
13 196.1 117.9 6460.0 5.2 3.4 100.6 Invalid
14 196.5 132.1 3834.1 5.2 3.7 65.4 Invalid
15 199.7 137.9 4529.2 5.3 3.7 81.8 Invalid
16 180.4 110.8 7731.7 4.8 3.1 120.3 Invalid
17 186.8 115.8 7095.8 4.9 3.3 110.4 Invalid
18 196.5 135.7 4124.8 5.2 3.7 71.4 Invalid
19 193.4 121.9 4011.9 5.1 3.4 71.0 Invalid
20 164.1 95.5 7669.5 4.4 2.7 119.4 Invalid
21 214.9 131.7 6799.7 5.6 3.8 112.2 Invalid
22 208.2 151.2 4528.5 5.5 4.0 82.1 Invalid
23 202.6 141.5 3987.9 5.4 3.9 70.2 Invalid
24 198.4 125.6 7794.5 5.2 3.6 121.1 Invalid
25 193.5 124.0 5259.0 5.1 3.4 100.4 Invalid
26 179.3 105.7 6397.6 4.8 3.0 99.7 Invalid

Original 132.5 55.8 5396.6 3.7 1.6 84.8
Min 125.9 43.9 3834.1 3.5 1.4 65.4
Max 214.9 151.2 7794.5 5.6 4.0 121.1
STD 29.6 35.5 1288.1 0.7 0.93 17.4

Table B.9: Raw stress (MPa) and strain (microstrain) results of the sensitivity analyses:
Kuehneotherium, moving all muscles 5%. Min= minimum, Max= maximum, STD= standard
deviation.
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Strain Stress Validity
Mean Median Max Mean Median Max

1 106.71 93.26 100.84 105.77 99.16 106.78 Valid
2 96.91 103.80 99.16 97.57 97.91 99.13 Invalid
3 106.21 112.00 88.46 105.63 116.68 88.44 Valid
4 96.42 84.69 111.55 96.55 82.17 111.58 Valid
5 101.76 114.03 87.63 102.11 112.88 87.58 Invalid
6 95.00 93.65 110.70 95.48 86.97 110.70 Invalid
7 101.91 78.60 112.40 101.25 83.03 117.52 Valid
8 113.90 107.42 89.30 112.14 115.36 97.22 Valid
9 128.40 182.12 130.33 123.15 175.16 129.20 Invalid
10 153.88 263.05 78.49 145.67 243.04 89.78 Invalid
11 144.76 222.01 85.50 138.12 206.24 100.72 Invalid
12 154.90 230.65 132.65 146.31 224.34 135.78 Invalid
13 148.00 211.25 119.70 140.40 207.04 118.56 Invalid
14 148.32 236.65 71.05 141.45 221.52 77.11 Invalid
15 150.72 246.97 83.93 142.65 225.84 96.41 Invalid
16 136.15 198.58 143.27 129.62 189.43 141.80 Invalid
17 140.95 207.51 131.49 134.03 199.52 130.18 Invalid
18 148.32 243.13 76.43 140.99 224.77 84.17 Invalid
19 145.96 218.38 74.34 139.61 204.71 83.69 Invalid
20 123.87 171.13 142.12 118.88 162.73 140.83 Invalid
21 162.17 235.89 126.00 152.77 231.11 132.31 Invalid
22 157.14 270.78 83.91 148.14 245.60 96.85 Invalid
23 152.91 253.51 73.90 145.25 237.39 82.72 Invalid
24 149.74 224.94 144.43 141.69 215.98 142.77 Invalid
25 146.01 222.13 97.45 138.72 205.17 118.33 Invalid
26 135.31 189.27 118.55 129.42 183.89 117.59 Invalid

Table B.10: Comparative stress (MPa) and strain (microstrain) results of the sensitiv-
ity analyses, represented in percentages: Kuehneotherium, moving all muscles 5%. Min=
minimum, Max= maximum, STD= standard deviation.
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Strain Stress Validity
Mean Median Max Mean Median Max

1 154.4 54.9 6687.8 4.2 1.7 124.3 Valid
2 130.6 66.2 5306.1 3.7 1.8 83.4 Invalid
3 152.3 68.7 4152.7 4.2 2.2 65.2 Valid
4 125.8 38.7 6643.9 3.5 1.1 104.5 Valid
5 144.8 73.0 4064.2 4.0 2.1 63.8 Invalid
6 133.1 62.6 6552.2 3.7 1.7 103.0 Invalid
7 141.9 38.9 8022.6 3.9 1.2 141.7 Valid
8 177.0 70.4 5959.4 4.8 2.2 110.3 Valid
9 250.0 173.8 8832.9 6.5 4.7 139.5 Invalid
10 320.8 245.1 6940.3 8.2 6.6 116.4 Invalid
11 283.7 199.9 6736.7 7.3 5.5 129.6 Invalid
12 322.8 220.4 10873.6 8.2 6.3 179.4 Invalid
13 303.4 201.4 8743.9 7.8 5.7 144.4 Invalid
14 296.2 206.1 6409.1 7.6 5.8 94.9 Invalid
15 311.3 237.7 6416.8 7.9 6.3 132.4 Invalid
16 274.0 199.3 10232.9 7.0 5.3 161.6 Invalid
17 283.3 195.0 8968.9 7.3 5.5 142.2 Invalid
18 298.6 222.5 6411.6 7.6 6.1 106.8 Invalid
19 285.2 188.8 5881.3 7.3 5.4 108.7 Invalid
20 242.0 171.5 10098.4 6.3 4.5 158.9 Invalid
21 343.6 228.2 11083.1 8.8 6.6 179.1 Invalid
22 335.7 259.8 6943.5 8.5 6.8 131.5 Invalid
23 315.8 226.4 6939.6 8.1 6.3 104.5 Invalid
24 311.5 222.7 11561.8 8.0 6.1 187.0 Invalid
25 292.6 211.7 8045.2 7.5 5.6 159.2 Invalid
26 269.0 175.6 8806.6 6.9 4.9 138.5 Invalid

Original 132.5 55.8 5396.6 3.7 1.6 84.8
Min 125.8 38.7 4064.2 3.5 1.1 63.8
Max 343.6 259.8 11561.8 8.8 6.8 187.0
STD 75.4 74.4 2026.5 1.8 1.98 32.8

Table B.11: Raw stress (MPa) and strain (microstrain) results of the sensitivity analy-
ses: Kuehneotherium, moving all muscles 10%. Min= minimum, Max= maximum, STD= standard
deviation.
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Strain Stress Validity
Mean Median Max Mean Median Max

1 116.51 98.37 123.93 114.25 103.84 146.61 Valid
2 98.54 118.53 98.32 99.15 108.98 98.27 Invalid
3 114.96 123.04 76.95 113.19 131.59 76.91 Valid
4 94.96 69.40 123.11 95.02 65.17 123.17 Valid
5 109.30 130.75 75.31 108.63 127.90 75.24 Invalid
6 100.44 112.11 121.41 99.77 103.76 121.41 Invalid
7 107.13 69.60 148.66 105.48 72.63 167.07 Valid
8 133.58 126.13 110.43 129.02 133.29 130.00 Valid
9 188.70 311.28 163.67 175.60 287.73 164.42 Invalid
10 242.09 439.15 128.60 221.56 400.10 137.23 Invalid
11 214.09 358.07 124.83 197.19 333.69 152.80 Invalid
12 243.59 394.76 201.49 223.92 382.55 211.56 Invalid
13 228.98 360.71 162.03 211.22 347.43 170.25 Invalid
14 223.55 369.15 118.76 205.86 350.61 111.88 Invalid
15 234.95 425.86 118.90 214.96 380.50 156.07 Invalid
16 206.78 357.11 189.62 191.30 320.92 190.50 Invalid
17 213.83 349.36 166.19 197.62 331.57 167.64 Invalid
18 225.37 398.56 118.81 206.86 367.71 125.90 Invalid
19 215.24 338.28 108.98 198.99 324.93 128.20 Invalid
20 182.65 307.14 187.12 170.27 273.68 187.33 Invalid
21 259.30 408.79 205.37 237.76 398.00 211.18 Invalid
22 253.34 465.45 128.66 231.38 413.76 155.00 Invalid
23 238.31 405.58 128.59 218.51 380.80 123.22 Invalid
24 235.06 398.96 214.24 216.56 368.47 220.43 Invalid
25 220.86 379.23 149.08 202.54 339.29 187.64 Invalid
26 203.05 314.62 163.19 188.47 299.12 163.30 Invalid

Table B.12: Comparative stress (MPa) and strain (microstrain) results of the sensitiv-
ity analyses, represented in percentages: Kuehneotherium, moving all muscles 10%. Min=
minimum, Max= maximum, STD= standard deviation.
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APPENDIX C

This appendix has the supplementary figures and tables of Chapter 4. It includes details

on the convergence of the mesh used in the finite element analysis study and on the con-

vergence of the intervals used for principal components analysis following the Intervals’

Method of [131].

S4 Data Supplementary Data Chapter 4. All the supporting data used in this manuscript

can be found in the following link: https://data.bris.ac.uk/webshare/Palaeobiology_Users/

6638439a-2000-4e84-bf60-c916680de9d1/ It includes information on the list of taxa used in

this study, basic data on the finite element models, a detailed protocol on how to build the en-

hanced extruded FE models, the code used to run the Intervals’ Method and all the finite element

models analysed in this study.

Table C.1: Convergence test results, showing number of elements per model, approximate size
of elements in the mesh, average and median von Mises stress values (in MPa), and computational
time (in seconds) needed to solve the finite element model. Depicted graphically in Figure C.1a-d

Model Number of elements Element size Average stress Median stress Computational time
Model 1 30402 0.000255 4040573 2579320 45
Model 2 37171 0.000234 3850000 2490000 45
Model 3 46982 0.000213 3740000 3430000 45
Model 4 61714 0.00019125 3880000 3500000 49
Model 5 84619 0.00017 3830000 3560000 55
Model 6 121363 0.00014875 3860000 3550000 71
Model 7 180966 0.0001275 3890000 3580000 82
Model 8 297063 0.00010625 3900000 3580000 116
Model 9 536200 0.000085 3940000 3660000 186
Model 10 1109562 0.00006375 4110000 3790000 420
Model 11 3023174 0.0000425 4090000 3760000 1565
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Table C.2: Comparison of stress values between subsequent pairs of finite element models,
showing average and median von Mises stress in MPa. Expressed as a percentage of how similar
subsequent pairs of models are. Depicted graphically in Figure C.1e

Average stress similarity Median stress similarity
Model 1 vs 2 95.28 % 96.54 %
Model 2 vs 3 97.14 % 62.25 %
Model 3 vs 4 96.26 % 97.96 %
Model 4 vs 5 98.71 % 98.29 %
Model 5 vs 6 99.22 % 99.72 %
Model 6 vs 7 99.22 % 99.15 %
Model 7 vs 8 99.74 % 100.00 %
Model 8 vs 9 98.97 % 97.77 %

Model 9 vs 10 95.69 % 96.45 %
Model 10 vs 11 99.51 % 99.21 %

Table C.3: Coefficient of determination (R2) values, obtained by regressing sequential pairs
of PC scores. Scores obtained from Principal Components Analyses performed using correlation
and variance-covariance matrices of different numbers of intervals (i.e., 5, 10, 15, 25, 50, 75, 100,
125, 150). Convergence was determined when PC1 and PC2 has R2) values higher than 0.99.

Intervals Correlation matrix Variance-covariance matrix
PC1 PC2 PC1 PC2

PCA 5 vs PCA 10 0.99654 0.218498 0.765913 0.069078
PCA 10 vs PCA 15 0.997948 0.940289 0.988337 0.563946
PCA 15 vs PCA 25 0.998931 0.984767 0.978646 0.61307
PCA 25 vs PCA 50 0.999345 0.987628 0.000888 0.000902
PCA 50 vs PCA 75 0.999941 0.999724 0.993213 0.995853

PCA 75 vs PCA 100 0.999988 0.999724 0.99876 0.99998
PCA 100 vs PCA 125 0.999996 0.999984 0.999271 0.999986
PCA 125 vs PCA 150 0.999998 0.999993 0.999509 0.999977
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Table C.4: m1 position along the dentary, as a percentage of the total length of the dentary.
Higher numbers indicate m1 more posteriorly located, while lower numbers indicate m1 more
anteriorly located. Dietary information sources as in Table 1 of the main text.

Extant taxa Extinct taxa
Taxon Observed diet m1 position Taxon Proposed diet m1 position
Lynx rufus Hypercarnivore 81.61 Zalambdalestes lechei Unknown 73.77
Genetta genetta Hypercarnivore 79.64 Peramus tenuirostris Unknown 73.49
Herpestes javanicus Hypercarnivore 79.56 Vincelestes neuquenianus Omnivore 72.64
Tenrec ecaudatus Omnivore 77.83 Barunlestes butleri Insectivore 70.58
Petrogale lateralis Herbivore 75.52 Maelestes gobiensis Unknown 70.24
Mustela nivalis Hypercarnivore 75.29 Sasayamamylos kawaii Unknown 67.41
Taxidea taxus Omnivore 74.75 Kennalestes gobiensis Insectivore 67.41
Bassaricyon gabbii Herbivore 71.71 Teinolophos trusleri Invertivore 67.04
Vulpes vulpes Mesocarnivore 70.32 Montanalestes keeblerorum Unknown 63.97
Lontra canadensis Hypercarnivore 68.71 Triconodon mordax Carnivore 62.32
Pteropus vampyrus Herbivore 66.86 Phascolotherium bucklandi Unknown 61.47
Macrotis lagotis Omnivore 65.96 Trioracodon ferox Carnivore 61.39
Microgale longicaudata Insectivore 64.92 Morganucodon watsoni Insectivore 60.34
Solenodon paradoxus Vermivore 64.37 Alphadon aetoni Insectivore 58.86
Perameles gunnii Omnivore 61.10 Laolestes eminens Unknown 55.07
Elephantulus rufescens Omnivore 60.21 Amblotherium soricinum Unknown 54.00
Petrodomus tetradactylus Omnivore 59.77 Amphitherium prevostii Insectivore 52.55
Tupaia glis Omnivore 56.52 Kuehneotherium praecursoris Insectivore 52.29
Dromiciops gliroides Insectivore 55.65 Didelphodon vorax Carnivore 51.61
Myotis lucifugus Insectivore 54.99 Dryolestes leirensis Insectivore 50.82
Monodelphis theresa Omnivore 54.51 Haldanodon exspectatus Insectivore 49.00
Philander opossum Omnivore 53.30 Gobiconodon haozhouensis Carnivore 47.40
Phalanger orientalis Herbivore 52.97 Docodon victor Insectivore 39.30
Parascalops breweri Vermivore 49.93
Atelerix albiventris Insectivore 49.30
Sminthopsis macroura Insectivore 46.47
Petaurus breviceps Omnivore 44.45
Dasyurus geoffroii Mesocarnivore 42.77
Blarina brevicauda Omnivore 40.17
Noctilio leporinus Piscivore 33.77
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Figure C.1: Mesh convergence study, showing a) element size of the models (note that it
decreases in a linear fashion) b) number of elements in the mesh (note it increases exponentially),
c) average and median von Mises stress (MPa) in each model, d) computational time needed to
solve the finite element models, and e) similarity in average and median stress values when
comparing subsequent pairs of models (expressed as a percentage).
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Figure C.2: Convergence of the R2 values of the PC scores, using both correlation and
variance-covariance matrices. Values shown in Table C.3. Convergence determined at the number
of intervals where the R2 values reached a plateau (and when the R2 values of both PCs were
over 0.99).
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Figure C.3: Correlation matrix PCA plots, showing different intervals (5, 10, 15, 25, 50, 75,
100, 125, and 150) used to determine the convergence of the data in this study.
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Figure C.4: Variance-covariance matrix PCA plots, showing different intervals (5, 10, 15, 25,
50, 75, 100, 125, and 150) used to determine the convergence of the data in this study.
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This appendix has the detailed protocol on how to build enhanced extruded FE models.

It was designed by Nuria Melisa Morales Garcia and modified by Kit Lam Tang. This

protocol was used to build the models in Chapter 4 and it is a slightly updated version of

the models validated in Chapter 3.

D.1 Building enhanced extruded FE models

This protocol describes in detail how to build enhanced extruded finite element models, first

validated in Morales-Garcia et al., (2019) and used in Morales-Garcia et al., (in prep). For this

protocol, we will be using a mammalian jaw which is relatively flat mediolaterally. Enhanced

extruded FE models are built using freely available software: Image J/Fiji, Blender and FreeCAD,

for their posterior analysis using the finite element method (FEM). Here is a list of FEM software,

many of which are free: https://en.wikipedia.org/wiki/List_of_finite_element_software_packages

D.1.1 Choosing the right photographs

Extruded FE models are simplified 3D models built "by hand" using photographs, rather than

using tomographic data. To do so, first we need to choose the right photographs. We need at least

lateral and dorsal view photos (in the case of jaws) with a scale bar visible. You might be using

photographs you have taken, but there are many free online resources where you might find such

photos such as:

1. Animal Diversity Web of the University of Michigan (https://animaldiversity.org/)

2. Natural History Museum online database (https://data.nhm.ac.uk/)
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Figure D.1: Lateral view picture of Procyon lotor

3. Field Museum online database (https://collections-zoology.fieldmuseum.org/)

4. University of Florida online collections (https://www.floridamuseum.ufl.edu/collections/databases/)

5. American Museum of Natural History online database

(https://www.amnh.org/research/paleontology/collections/database)

For this protocol, we will be using the jaw of the Guadeloupe raccoon, Procyon lotor (Figures D.1

and D.2). These pictures were obtained from the Animal Diversity Web (University of Michigan

Museum of Zoology 98905).

D.1.2 ImageJ

ImageJ and Fiji are free image processing programs that we will use to obtain measurements.

Either can be used for helping us build extruded FE models. They can be found in the following

links:

1. https://imagej.net/Welcome.

2. https://imagej.net/Fiji

We will be taking a series of measurements along the jaw of Procyon, starting with the lateral

view picture (Figure D.3):

1. Open the file of the lateral view photo of the jaw (File>Open...)
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Figure D.2: Dorsal view picture of Procyon lotor

2. Using the "Straight Line" tool, draw a line that represents the length of your scale bar.

3. Go to Analyze>Set Scale. In the "Known distance box" indicate the length of your scale bar.

Make sure to also indicate the unit of length in the appropriate box. It is important that

you always use the same units of length when measuring different jaws (and later when

building the model in Blender)

4. Using the "Straight Line" tool, draw a line that represents the maximum length of the jaw

(i.e., from its posteriormost point to its anteriormost point, not including teeth)

5. Go to Analyze>Measure. Write down the length of the jaw (this measurement will be useful

later on).

6. Make a note of the dimensions of the picture (we will use this when we are making our

model in Blender). You can find them in the top left corner of the image (not pictured in

Figure D.3).

Now for the dorsal view photo (Figure D.4):

1. Repeat the first three steps taken with the lateral view picture (i.e., open the photo and set

the scale)
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Figure D.3: Summary of how to take measurements in ImageJ/Fiji using a lateral view photograph
of the jaw of Procyon lotor

2. Take a series of measurements of the width of the dentary. Here I measure the width in

between each tooth, but you decide how many measurements you will take. Record these

measurements and average them.

3. Take a series of width measurements along the back of the jaw (e.g., along the coronoid

process, the condyle, and, if visible, the angular process). You can also have ImageJ/Fiji

open while you are building the model in Blender to take as many measurements as needed.

Record these measurements.

D.1.3 Blender

Blender is the free 3D computer graphics software where we will be building our models. The

following instructions are based on Blender v 2.90; if you are using a previous version of Blender,

some of these instructions might not work for you. You can download the most recent version

here: https://www.blender.org/

To start up Blender:

1. Open Blender. Click anywhere to dismiss the welcome window. You will see three objects on

the screen: the camera, the cube and the lamp. Click on each of them and delete them by

using the "x" key of your keyboard and then clicking OK or Enter. If you are using older

versions of Blender you might have to select them with your right mouse button. The most

recent version of Blender allows you to select objects with the left button of your mouse.
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Figure D.4: Example of measurements taken in ImageJ/Fiji using a dorsal view picture of the jaw
of Procyon lotor

2. Go to View>Viewpoint>Top on the top left corner, next to where it says "Object Mode". It is

very important to do this, especially if you are using Abaqus to perform FEA, because it

will make it easier to manipulate your model later on.

The first thing we will do to start building our model is to upload the lateral view picture of

the jaw (Figure D.1) as reference (Figure D.6). To do so:

1. Drag and drop your image file into Blender. Hit the key "G" on your keyboard or go to

Object>Move to move your object and center it at the cross-hairs of the grid.

2. On the panel on the bottom right of the screen, click on the Scene tab (it looks like

a white cone, with a sphere on the front, and a white circle on the top right corner).

Under Units>Length, change the units to millimeters (or to whatever units you used in

ImageJ/Fiji).

3. On the same panel, click on the "Object Data Properties" tab (it is a red icon, with a triangle

on the bottom left corner and a circle on the top right corner). Under Empty>Size, indicate

the length of your image (remember you made a note of the dimensions of your image in

Image J- this is NOT the length of the jaw, but of the entire image). Click Enter

4. Your image might have disappeared because it might be very small. Zoom in until you find

it! You can use the middle scroll wheel of a mouse, or pinch out with two fingers using a

track pad.

We will now start tracing the outline of the jaw (Figure D.7). To do so:
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Figure D.5: Starting instructions for Blender

1. Go to Add>Mesh>Plane. This will add a square on top of your image. Chances are, it’s a

really big square. To make it smaller, hit they key "S" on your keyboard and move your

mouse towards the center of the cube. The size of the square does not really matter, we just

need it to be small enough to manipulate. Click once on it to stop scaling.

2. Go to Edit Mode. To do so, click on the arrow next to "Object Mode" and select "Edit Mode".

This is located towards the top left corner of the window.

3. Next to "Edit Mode" you will see three squares. The first one, "Vertex Select" should be

selected by default. If not, click on it.

4. We are going to select one of the vertices of our square. It does not matter which one. When

you do so, that vertex will be highlighted in white, while the others will be black.

5. Press "P" on your keyboard. A pop-up menu will appear, make sure "Selection" is highlighted

and hit "Enter" on your keyboard. This will separate one vertex from the rest of the square.

6. Switch back to "Object Mode". On the "Scene Collection" panel on the top right corner

you will see three items: 1) Empty (this is your reference picture), 2) Plane (this is the

square), and 3) Plane.001 (this is the vertex you just separated from the rest of the square).

Right-click on "Plane" and select "Delete".

7. Select "Plane.001". Go to Object>Set Origin>Geometry to Origin
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Figure D.6: Uploading a reference image to Blender

8. Hit "G" on your keyboard or go to Object>Transform>Move. Move the vertex to your

preferred place along the outline of the jaw to start outlining.

Now we will properly outlining the jaw (Figure D.8).

1. Go to Edit Mode. Make sure your vertex is selected (i.e., highlighted in white). Press "E" to

extrude, click wherever you want to set the next vertex. This will allow you to start tracing

the jaw. Keep in mind that we need to do this using as few vertices as possible, while still

capturing the shape of the jaw; otherwise, our outline will be too complicated to convert to

3D. Make sure to ignore the teeth.

2. Keep on pressing "E" until you have outlined the whole jaw. If at any point you want to

delete a vertex, hit "X" of your keyboard, make sure "Vertices" is selected and hit Enter.

You can also move the vertices after you finish outlining by hitting the "G" key.

3. Right before you finish outlining the jaw, you’ll notice that you need to join the first and last

vertices. To join them, while still in Edit Mode, select both vertices using "Shift" on your

keyboard. Go to Mesh>Edges>Make Edge/Face or hit "F" on the keyboard. The vertices

should now be connected.

4. We are now going to fill the outline. To do this, we must select all the vertices in the outline.

While in Edit Mode, go to Select>All, or Hit "A" on your keyboard.

5. Click on any vertex and drag the cursor around the outline of the jaw until you have

selected all the vertices. The selected vertices will be highlighted in orange. Hit Esc on your

keyboard.
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Figure D.7: How to isolate a vertex in Blender: this is the first step to start outlining a jaw

6. While in Edit Mode, press "F" on your keyboard to fill the outline.

Let’s make sure the dimensions of our object are correct (Figure D.9):

1. Go to Object Mode. Hit "N" on your keyboard to bring out the sidebar. Under Item>Transform,

you will find two important things: the scale and the dimensions.

2. We want the "Scale" to be at 1 in X, Y and Z. If it’s not, go to Object>Apply>Scale.

3. Check the dimensions of your jaw are roughly the same as the measurements you took in

ImageJ/Fiji.

We will now add additional vertices and edges to simulate muscle attachment areas. It is up to

you how precise you want to be, but keep in mind: with extruded FE models less is more. If you

make a model too complicated, you might have meshing issues later on and the model will take

too long to make. Here I will only make a simple outline:

1. While in "Object Mode", hit "Z" in your keyboard and choose "Wireframe", so you can see

the image behind.
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Figure D.8: How to outline and fill a jaw in Blender

Figure D.9: How to check the dimensions of your object in Blender
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Figure D.10: How to use the knife tool to indicate the area of muscle attachment. See in blue box
how the new vertices we create are in line with the original outline

2. Go to "Edit Mode". Hit "K" in your keyboard to activate the knife tool. This will allow us to

"cut" through the model.

3. Starting from an existing vertex, let’s trace a line around the area of muscle attachment,

try to add the same (or a similar) number of vertices as in the outline, as they will be

connected later; finish outlining by connecting to an existing vertex (make sure you are

actually clicking on the vertex, otherwise you might inadvertently add new vertices to the

outline that cause you meshing troubles later on). Again, try to not make this too complex.

Hit Enter when you are done.

4. Draw a parallel line towards the inside of the jaw, with the same number of vertices.

Remember to start and finish at existing outline vertices.

5. We can now hide the reference picture. In the Scene Collection Panel on the top right corner,

click on the eye icon next to "Empty" to hide the picture. You can click on this icon again if

you wish to use the picture for reference later on.

We are now going to extrude the model into 3D (Figure D.11):

1. While in Edit Mode, go to View>Front so you can see the jaw in dorsal view (it will appear

as a line as it’s currently in 2D).
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Figure D.11: How to extrude a 2D jaw in Blender (1) and how to check the lengths of edges (2)

2. Make sure the jaw is selected (highlighted in orange), go to Mesh>Extrude>Extrude Faces,

or hit "E" on your keyboard.

3. Drag the cursor up to extrude the jaw. At this point it is irrelevant how much you extrude

it, just click anywhere to release it.

4. Go to Object Mode. In the properties panel (press N to show), under "Dimensions", change

the Z value to the average width of the dentary you calculated beforehand (after taking the

measurements in ImageJ/Fiji)

5. Go to Object>Apply>Scale to apply the scale. In the properties panel, under scale, X,Y and

Z should now all say 1.000. This is very important, so do not skip this step! Otherwise, all

the edits we’ll make later will be wrong.

6. You can also make sure the width of your jaw is accurate by displaying the "Edge Length"

of whichever edge is selected. To do so, go to "Edit Mode" and click on Overlays (you can

find this above the Properties Panel, it looks like two circles intersecting each other). Under

Measurement, activate "Edge Length".

We are now going to create temporary edges linking the extra vertices we created using the knife

tool (Figure D.12).

1. In Object Mode, go to View>Viewpoint>Top.
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Figure D.12: How to join opposing vertices in Blender: 1) Identifying opposing vertices and joining
them, 2) Finished product

2. Hit "R" and then "Y" on your keyboard to rotate your object along the y axis. We want to

make sure we can see the opposing pairs of vertices we created with the knife tool (i.e.,

vertices with the same XY coordinates, but located in different places along the Z axis).

3. Using shift select opposing pairs of vertices and hit "F" on your keyboard to create an edge.

You can make sure you are joining the right vertices by having the "Edge Length" tool

activated: it should display the average width of your jaw; if it’s anything else, you are

joining the wrong vertices.

4. Repeat this for every single pair of opposing vertices that were created with the knife tool.

5. Please note: if you want to rotate the object, do so in "Object Mode", if you try to do so in

"Edit Mode" you won’t rotate the object, but whatever edge or vertex you have selected. You

can also pan the object across the screen by holding Shift while moving the object with your

mouse/trackpad.

You now have a flat extruded model. However, jaws are not completely flat and we must account

for the differences in width at the ascending ramus. To do this, we are going to use the width

measurements we obtained in ImageJ/Fiji (it’s also handy to have ImageJ/Fiji open for any extra

measurements) (Figure D.13):
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1. In Object Mode, rotate the jaw (hit "R" on your keyboard to rotate, plus "X" if you are

rotating on the x axis, "Y" if you are rotating on the y axis, and "Z" if you are rotating on

the Z axis. You can hit Alt-R or Option-R to reset the rotation of the jaw.

2. We are going to be modifying the length of the edges along the ascending ramus of the jaw

(i.e., along the the coronoid process, condyle and angular process).

3. To modify the length of the edges we need to activate a Blender add-on. Go to Edit>Preferences

(on the top left corner of the window). Select the "Add-ons" tab. In the search bar, type

"mesh". Check the box next to "Mesh: Edit Mesh Tools", and close the window.

4. In Edit Mode, click on the "Edge Select" icon (next to Edit Mode, it is the second square on

the right).

5. Select any edge you want, I like starting with the edge representing the widest point of the

condyle. When you select it, if you have the "Edge Length" tool activated, you will see the

average width of the jaw displayed.

6. Look at the sidebar on the top right, you will have a new tab that says "Edit". Click on it

and then on the arrow next to "Mesh Tools". Under Manual>Target Length, indicate the

maximum width of the condyle you obtained in ImageJ/Fiji (or any other measurement fit

for the edge you selected). Click OK.

7. As you see, the length of your edge has changed (the length is displayed next to the edge if

you activated the Edge Length tool). Of course it looks odd, as it is the only one which is

different. Using measurements obtained from ImageJ/Fiji modify the length of the rest of

the edges along the ascending ramus so you have a "natural-looking" jaw. There might be

places where you don’t have exact measurements: for example, with a dorsal view picture

you can measure the base and the top of the back of the coronoid process, but you do not

have the measurements in-between. You can use both measurements to interpolate the

length of the edges in between. The more you practice, the easier it will be to build these

models.

We are now going to modify the length of the internal edges (Figure D.14):

1. Once you are done modifying the length of the outer edges of the ascending ramus, you need

to modify the internal edges we created beforehand. Of course, because we are working

with pictures, we don’t know exactly how much the jaw slopes inwards. But the purpose of

outlining the muscle attachment area is just we have an idea where the muscles attache

when we are loading our model in an FEA software later on, and to avoid meshing problems.

Therefore, we only need to make these internal edges slightly shorter than the outer edges.

We want the jaw to look as if it was slightly sloping inwards.
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Figure D.13: How to modify the length of the edges in Blender using Edge Length Tools (1). Part
2 of the image shows how outer edges look after changing their length.

2. Once you are done modifying the length of these internal edges, select them, hit "X" on your

keyboard, and hit Enter to delete them.

We are now going to join the muscle attachment vertices with the vertices outlining the jaw

(Figure D.15):

1. In Object Mode, make sure you are looking at your jaw from the top (View>Viewpoint>Top)

and that any rotation has been reset (Alt+R or Option+R)

2. Go to Edit Mode and make sure "Vertex select" is selected. Hit "K" to activate the Knife

tool. Because we are now working with a 3D model, hit the key "Z" to activate cut-through

(this means that any cut you make on one side of the jaw is reflected on the other).

3. Use the knife tool to join the vertices along the ascending ramus. This tool will allow you

to connect the outer and inner vertices to generate a gently sloping effect and remove any

artefacts caused by abrupt changes in width along the jaw. This is not necessary to do in

flat parts of the model (e.g., the dentary). Make sure you are actually connecting existing

vertices and not creating any new ones by mistake. If you make any mistakes just hit "Esc"

on your keyboard. When you are done hit "Enter".

We are done! Let’s see the finished model (Figure D.16):
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Figure D.14: How to modify the length of the internal edges (1) and then delete them (2)

Figure D.15: How to join "inner" and "outer" vertices to smooth surface of the jaw
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Figure D.16: The finished enhanced extruded model built in Blender

1. Go to Object Mode. Hit the "Z" key in your keyboard and select "Solid"

2. Your model is not ready to export as an STL, if you wish to scale it to a particular surface

area or volume you have to install the add-on "3D-Print". Go to Edit>Preferences, and

under the Add-on tab search for 3D-Print and check the box next to it.

3. On the sidebar to the right you can click on "3D-Print" and click on "Volume" or "Surface

Area" to obtain this information. While in Object Mode, hit "S" to scale the model up or

down, and query the surface area or volume again until you obtain the size you desire.

4. Under 3D print, you can also export your model as an STL

A few extra recommendations:

1. If you are building a large number of models, it good to work in "batches". That is: do all the

outlines first, then all the extruding, then all the modification of edge lengths, and so on.

2. If you are going to use Abaqus to perform FEA, you have to convert your STL model to

STEP first. This is done in the freely available software FreeCAD, the instructions for doing

so are here: https://www.bantamtools.com/blog/convert-stl-to-step
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This appendix has the detailed protocol on how to perform Finite Element Analysis (FEA)

in Abaqus. This protocol was described extensively by Nuria Melisa Morales Garcia, but

is based on the short protocol of Jennifer J. Hill and Thomas Burgess. This protocol was

used to build run the FEA models in Chapters 3 and 4.

E.1 Performing finite element analysis in Abaqus

This protocol was made with the purpose of performing finite element analysis (FEA) in Abaqus

using enhanced extruded FE models (see Morales-Garcia et al., 2019). However, this protocol is

also useful if you are performing FEA on 3D models built with tomographic data or photogramme-

try. Using Abaqus, we will recreate the material properties of bone and simulate the condutions

under which the adductor muscles of the jaw work. We will then analyse the model using FEA

and observe the stress and strain patterns along the jaw at the moment of biting.

The first thing we will do is import our model into Abaqus (Figure E.1). To do so:

1. Open Abaqus CAE. A window called "Start Session" will pop up. Choose Create Model

Database with standard/explicit model.

2. Go to File>Import>Part. Expand the "File Filter" menu at the bottom of the screen and

choose STEP (*.stp*,*.step*). You can now choose your STEP model and click OK.

3. A window called "Create part from STEP file" will appear. Under "Name-Repair" select

"Combine into single part", and under "Part Attributes" make sure "3D" is selected under

"Modelling Space" and "Deformable" is selected under "Type".
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Figure E.1: How to export a STEP file into Abaqus

4. If you need to scale your model, go to the tab "Scale" and multiply all lengths by the number

of your choice. If you followed my protocol on how to build enhanced extruded FE models in

Blender, this step should not be necessary.

The first thing we are going to do is generate a mesh of our model (Figures E.2 and E.3). To do so:

1. Change the module to Mesh (you were previously in the Part module)

2. Click "Show Mesh Seeds"

3. Click "Seed Edges" on the lateral toolbar (it’s an L-shaped figure with red dots at the

bottom) or go to Seed>Edges on the top menu bar. Drag a box around the object of interest

to complete this action. Click done at the bottom of the graphics window when you are done.

4. A window called "Local Seeds" will appear. Under the "Basic" tab, make sure "Method"

is "By size" and "Bias" is "None". Under sizing controls, indicate the approximate size

you wish the elements in your mesh will have. If it’s your first time making a model, you

probably won’t know which value to put in, that’s ok! To determine the size of the elements

in your mesh, you will have to perform a convergence test (more on this later on), but for

now let’s just choose 0.0001. Click OK.

5. Click on "Assign Mesh Controls" on the lateral toolbar (it’s right underneath "Seed Edges")

or go to Mesh>Controls on the top menu bar. A window called "Mesh Controls" will pop up,

select "Tet" and click OK.

6. Click on "Assign Element Type" on the lateral toolbar (it’s a meshed L-shape with the

letters S4R written on red above it). Under "Element Library" select Standard, under

"Geometric Order" select "Linear", and under "Family" select 3D stress. The tab "Tet"

should be activated and at the bottom it should say "C3D4: a 4-node linear tetrahedron".
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Figure E.2: How to export start the meshing process and assign element size in Abaqus

Click OK. Please note, this type of element suits 3D jaw models, but depending on the

model you are building, the desired element type might be different.

7. Click on "Mesh Part" on the lateral toolbar (it’s a meshed L-shaped icon) or go to Mesh>Part

on the top menu bar. Once you do this, a prompt will appear at the bottom of the graphics

window asking you if it’s okay to mesh the part. Click on yes.

8. You have successfully meshed your jaw. At the bottom of the screen you will get a message

telling you how many elements have been generated in your mesh. If you want to further

query the mesh properties, click on the "Query Information" icon on one of the top toolbars

(it’s a white "i" within a blue circle), you can also find it in the top menu bar under

Tools>Query. Click on "Mesh". At the bottom of the screen, there will be a prompt asking

you whether you want to query the entire part. Click Done. Below, you will see the number

of nodes and elements in your mesh, as well as the element type.

9. If you click on "Verify Mesh" on the lateral toolbar (it looks like a meshed L-shape with a

green arrow on top), you will be able to check if you mesh has any errors.

We will now assign material properties to our jaw (Figure E.4). That is, the physical properties of

bone that describe its stiffness and elasticity. You can find these values in the literature. To do so:
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Figure E.3: How to assign element type and finish the meshing process in Abaqus

1. Change the module to "Property"

2. Click on "Create Material" (it’s the very first icon on the lateral toolbar, it looks like a graph)

or go to Material>Create on the top menu bar.

3. A window called "Edit Material" will pop up. Assign a name to you material and then select

Mechanical>Elasticity>Elastic. You will then be able to assign the desired values of Young’s

Modulus in MPa and Poisson’s ratio. Bone has a a Young’s Modulus of 18,000 and Poison’s

ratio of 0.3. Click OK.

4. Please note that from now on, you will constantly need to assign names to the features you

create, I strongly suggest that you give them easily recognisable names and keep them

uniform if you are making several models.

5. Actions like the above (i.e., creating a new material) can be very repetitive if you are

building a large number of models. You can make python scripts that will help you perform

these actions effortlessly and quickly (I will talk about how to do this at the end of the

protocol).

6. Click on "Create Section" on the lateral bar (it is a yellow beam icon, located right under-

neath the Create Material icon) or go to Section>Create.

7. A window called "Create Section" will appear. You don’t need to change anything here, just

make sure "Solid" and "Homogeneous" are selected. Click Continue.
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Figure E.4: How to create a material and assign it to the jaw

8. A window called "Edit Section" will appear. Make sure the material you just created is

selected under "Material" and click OK.

9. Click on "Assign Section" on the lateral toolbal (it is located underneath "Create Section"

and looks like a yellow beam pointing with a red arrow at a green L-shape), or go to

Assign>Section on the top menu bar. Select your jaw by dragging a box around it and when

you are finished click "Done" at the bottom of the graphics window.

10. A window called "Edit Section Assignment" will appear. Select the section you created

from the drop down menu and click OK. Your jaw will change colour. This means that your

material (i.e., bone) has been assigned to your model.

We will now create an instance, a step and a field output report request (Figure E.5)

1. Change the module to "Assembly". Don’t worry if your object suddenly disappears after you

do this.

2. Click on "Create Instance" from the lateral toolbar (it looks like a 3D L-shape with a red

arrow on top) or go to Instance>Create on the top menu bar. Make sure "Parts" is selected

under "Create instances from:". Select the part you are working with on the list and click

OK.

3. Change the module to "Step".
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Figure E.5: How to create an instance, a step and request a field output report in Abaqus

4. Click on "Create Step" on the lateral toolbar (it looks like a blue circle and a black arrow

pointing to a green square) or go to Step>Create on the top menu bar.

5. A window called "Create Step" will appear. You don’t need to change anything, just make

sure "Static, General" is selected under "Procedure type". Click continue.

6. A new window called "Edit Step" will appear. Default options should be fine in this case, so

just click OK.

7. Click on "Create field output" on the lateral toolbar (it’s right underneath Create Step) or

go to Output>Field Output Requests>Create.

8. A window called "Create Field" will appear, click Continue

9. A window called "Edit Field Output Request" will appear. Here you can select all the

variables you’d like information on upon completion of the FEA job. I usually choose the

following: MISES, Mises equivalent stress (under Stresses); E, Total strain components

(under Strains), and EVOL, Element Volume (under Volume/Thickness/Coordinates). Click

OK when you are done

We will now create the boundary conditions of the model. That is, we are going to indicate where

movement should be impaired along the jaw. For example, is a jaw we might want to restrict

the movement of the condyle (i.e., the articulation with the skull) and the biting point. There

are several ways of doing this. You might choose to select some nodes and apply the boundary

conditions to all of them individually. Here I show you how to constrain a number of nodes on
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the surface of the jaw to a single point "floating in space", where the boundary condition is then

applied upon (Figures E.6, E.7 and E.8). To do so:

1. Change the module to Interaction

2. In the top menu bar, go to Tools>Set>Create.

3. A window called "Create Set" will appear. We are going to start creating a set to include

nodes along the condyle. Therefore, I am going to name this set "Condyle set" (again, these

names should be evident and you should keep them constant throughout). Select "Node"

under "Type" and click OK.

4. You can now see the mesh. Click on "Apply Left View" on one of the top tool bars (the icon

is a set of perpendicular arrows with the letter Y on top and the letter Z facing to the right).

You should now be able to see the back of the jaw. Zoom in and select the nodes along the

condyle where you will be imparing the movement. To select more than one node hold down

the Shift key, to deselect a node hold down the Ctrl key and click on the node of interest.

You can use the Pan (looks like two intersecting arrows) and Rotate (looks like a curved

arrow) tools on one of the top tool bars to help you manipulate the model.

5. Make sure you only select nodes on the surface of the model. To do so, find an icon on one of

the top toolbars that looks like a long orange box (it’s the second icon to the right of the

word "Nodes"). Click on the arrow on the bottom corner and pick the option "Select from

Exterior Entities". When you activate this option, you will only be able to select nodes on

the surface of the model, but be careful! You might still be selecting nodes on the opposite

end of the jaw, rotate your model a little bit to make sure you’ve only selected nodes on the

desired surface.

6. When you are done, click "Done" at the bottom of the screen (where it says "Select nodes

from the set individually". You can also select multiple nodes at once by switching from

"individually" to "by angle" or "by feature edge". However, be careful not to overconstrain

your model, this might lead to very unrealistic results!

7. We will now create a single point that unites the individual nodes. This point is where

the boundary conditions will be applied upon. We want to position this point just hovering

above the surface of the condyle. To do so, we will query the position of one of the points

which already exist on the model. Click on Query Information and select Point/Node. Choose

the point which is located approximately at the middle point of the nodes you just selected.

Click done at the bottom of the screen. Just below, you will see the coordinates.

8. Click on "Create Reference Point" on the lateral toolbar (it looks like a blue cross with the

letters RP above). Fill out the coordinates of the node you just queried and click OK.

159



APPENDIX E. APPENDIX E

9. Go to the model tree on the left side of the screen. Under Assembly>Features, you will find

the reference point you just created. It will be called RP-1. Right-click on it and change its

name to something recognisable: I changed it to Condyle RP.

10. Now we are going to modify the X coordinates of this point, so that it’s just hovering above

the condyle. Double-click on Condyle RP and edit the X coordinate, so to achieve the desired

effect. Click OK when you are done.

11. We now need to transform this reference point into a set. Go to Tools>Set>Create. Change

the name of the set (I will call it Condyle reference set), make sure "Geometry" is selected

under "Type" and click Continue.

12. At the bottom of the screen you will see "Select the geometry for the set". Click on the

Condyle RP we just created and click Done at the bottom of the screen.

13. We will now create a constraint to join the nodes on the surface to the point hovering above

the condyle. To do so, click on "Create Constraint" on the lateral toolbar (it looks like a

blue square tied up to a yellow rectangle) or go to Constraint>Create on the top menu bar.

Rename your constraint (I called it Constraint-condyle) and choose MPC constraint from

the list. Click on Continue.

14. A window might appear automatically, but if it does not, click on Sets... on the bottom

right corner of the screen. You are first going to select the point that will tie all the nodes

together, so choose your Condyle reference set. Click on continue

15. Next, you are going to select the nodes on the surface. Choose "Condyle set", click on

Continue.

16. A windown called "Edit Constraint" will appear, double-check everything is fine, and click

OK.

17. Repeat these steps to create a constraint for the biting point.

18. Now that we have created the MPC constraints of the condyle and biting point, we can now

create the boundary constraints.

19. Change the module to "Load". Click on "Create Boundary Condition" on the lateral toolbar

(it’s on the left of the second row, looks like an L-shape with a series of red lines underneath),

or go to BC>Create on the top menu bar.

20. Rename the boundary condition (I called it BC-Condyle), and choose "Mechanical" under

"Category", and "Displacement/Rotation" under "Types for Selected Step". Click continue.

160



E.1. PERFORMING FINITE ELEMENT ANALYSIS IN ABAQUS

Figure E.6: How to create a node set and a reference point in Abaqus

21. Click on "Sets..." on the bottom right corner of the window. Select the point hovering above

the jaw (i.e., Condyle reference set), and click continue. Choose what degrees of freedom

you’d like the point to be constrained on. U1 is the mesodistal axis, U2 the dorsoventral

axis, and U3 the axis along the length of the jaw; U refers to translational movement and

UR refers to rotational movement. Click Ok when you are done.

22. Repeat for the biting point.

Now that we have created the boundary constraints, we need to simulate the pull of the adductor

muscles on the jaw (Figures E.9 and E.10). This step is very similar to what we just did with the

boundary conditions, but there are some important differences. To do this:

1. Change the module to "Interaction"

2. Follow the same steps as above (steps 2-6) to create node sets for each muscle (i.e., go to the

top menu: Tools>Set>Create, rename the set and choose "Node" under type). You will end

up with several node sets (I usually have external anterior temporalis, internal anterior

temporalis, external posterior temporalis, internal anterior temporalis, superficial masseter

and deep masseter). Make sure you do not use any of the same nodes in different muscle

node sets, otherwise you will have problems later on.

3. Follow the same steps as above (steps 7-12) to create a point that will unite all the nodes in

a set. By uniting all these nodes in a single point, we are simulating the direction the fibers
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Figure E.7: How to create an MPC constraint in Abaqus

Figure E.8: How to create a boundary condition in Abaqus
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of the muscles would be oriented in real life. We don’t have a skull to attach these muscles

to and we don’t want to make a very long constraint that simulates precisely where the

most dorsal attachment of the muscles on the skull would be. We just want this point to

hover relatively close to the jaw (more so than with the condyle and biting point). More

importantly, we want to mimic the direction of the muscle fibers in X,Y and Z (see Figure

E.10 for an example).

4. Before we move on to make the constraint, we need to create a new coordinate system. If

you click on Apply Front View (icon on one of the top toolbars that looks like perpendicular

arrows, with a Y on top and an X facing to the right), you will see that the X axis points

to the right, the Y axis points upwards, and the Z axis points towards you. If we were to

create a load now, said load would only be able to point along these axes. If, for example, we

want our load to pull diagonally, we have to create a new coordinate system.

5. To do so, click on Create Datum CSYS (3 points) on the lateral toolbar (it is the bottom

right icon, looks like 3 arrows with 3 red crosses), or go to Tools>Datum>CSYS>3 points.

6. Rename your coordinate system. I call mine based on the muscle I will be applying them on

(for example, Anterior temporalis CSYS). Make sure "Rectangular" is chosen.

7. On the bottom of the screen, you will be prompted to enter the origin of your coordinate

system. You will notice that there is already a CSYS in place, whose origin is at 0,0,0. I like

having all my CSYSs on a row, so I will enter the origin of this new one slightly to the right

(i.e., more positive values in X).

8. Then you will be prompted to choose a point the X axis will be pointing towards. I want X

to face to the top right of my screen, so I will make it a bit more positive on X and also in Y.

9. Finally, it will ask you to choose a point the XY plane will be facing. I am happy to have it

parallel to the jaw, but if I wanted to tilt it a little, I would modify the Z axis.

10. If you are unhappy with your CSYS, you can always delete it from the Model Tree, under

Assembly>Features. You can also insert reference points to allow you to play around with

the coordinates, until you find some that you are happy with.

11. Create a new CSYS for every muscle you want to load.

12. Repeat the same steps to create an MPC constraint (steps 13-16) as before, but now when

the window "Edit constraint" appears, make sure to indicate the CSYS you created for each

muscle. Select them by clicking on the white arrow next to CSYS (Global).

Now we can load the model, by simulating the force the adductor muscles of the jaw pull with

(Figure E.11). To do so:
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Figure E.9: How to create a new CSYS in Abaqus

Figure E.10: Lateral and posterior view of the jaw of Dromiciops gliroides with all the muscle
nodes constrained, and with unique CSYSs
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Figure E.11: How to load an FE model in Abaqus

1. Change the module to Load.

2. Click on "Create Load" on the lateral toolbar (it looks like an L-shape with a red arrow

facing down at the end), or go to Load>Create on the top menu bar.

3. A window called "Create Load" will appear. Choose a name for the load (e.g., Load-Anterior

temporalis) and select the step you defined earlier (do not choose Initial).

4. A set of options will now appear in the window. Make sure "Mechanical" is selected under

category and "Concentrated force" is selected under "Type of Selected Step". Click Continue

5. Choose the set that represents the points that anchors all respective muscle nodes together

(do not choose the individual muscle nodes).

6. A window called "Edit Load" will pop up. Input the force component CF1 (i.e., load on the x

axis), CF2 (i.e., load on the y axis), or CF3 (i.e., load on the z axis). Choose the corresponding

CSYS. For example, if you choose the original CSYS and write "2" in CF2, your load will

point upwards, if you write "-2" it will face downwards. Click OK when you are done.

7. Repeat this for all the muscles.

The last step is to run your model (Figure E.12). To do so:

1. Go to File>Set Working Directory and choose the folder your CAE file is stored. This is

important because all the files associated with the job will be stored here
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Figure E.12: How to run a job in Abaqus

2. Change the module to Job.

3. Click on the icon "Create Job" on the lateral toolbar (it is the first icon and it looks like a

computer), or go to Job>Create on the top menu bar.

4. Name your job and click Continue. A new window will appear, change nothing and click

OK.

5. Go to Job>Submit and choose your job name from the list. Click OK.

6. Wait for the model to finish running. Look at the Model tree on the left, under Analysis>Jobs,

you will see the status of your job. It will change to "Completed" when it’s done.

7. Right-click on the job and choose "Results", or go to Job>Results on the top menu bar and

choose the name of your job.

You are now in the visualisation modfule and can see the results of your analysis (Figure E.13).

There are many things you can do in this module

1. Plot contours on deformed/undeformed shape: shows you the von Mises stress (or other

metrics) as a heatmap on your jaw. Click on the colorful L-shaped icon on the lateral toolbar

to activate or go to Plot>Contours on the top menu bar and choose one of the options

2. You can hide the mesh by going to Options>Common>Basic and choose "No edges" under

"Visible Edges"
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3. You can modify the limits of the stress scale by going to Options>Contour>Limits. There

you can specify the minimum and maximum values you want to see on your scale. This is

handy for when you want to compare several models with different stress values.

4. You can generate your field output report (i.e., get a detailed spreadsheet telling you the

stress, strain and volume values per element of your mesh). Go to Report>Field Output

to write an RPT file (which can be imported into Excel). Choose Stress and Strain under

Integration Point Position, and Element Volume under Whole Element Position.

5. You can also save the heatmap by going to File>Print. Under Settings>Destination, choose

file, indicate the file name, and format of your image file (I recommend PNG).

6. You can revisit your job files any time you like, just make sure Abaqus is set to the right

working directory.

You have now analysed a 3D jaw model using FEA! I have a few extra tips:

E.2 Convergence tests

To perform a convergence test to determine the size of the mesh, you need to run a series of

analyses in which the models are loaded identically, but the element size changes. Because the

number of elements in your mesh is going to increase exponentially (while the element size

decreases in a linear fashion), perform a rule of three to determine how many nodes you should

select per model. For example, you have 2 models: model 1 has a mesh with an element size of

1 and has 10,000 elements, model 2 has an element size of 0.75 and a mesh size of 20,000. As

you see the element size only decreased by 25% but the number of elements has doubled. So, if

you chose 10 nodes for the condyle in model 1, you have to choose 20 for model 2 (because the

number of elements in the mesh has doubled). So, you have to perform a rule of three based on

the number of elements in your mesh, not the element size.

E.3 Python scripts

If you are going to be analysing a large number of analyses which are built in a similar way,

python scripts are going to make your like much easier (for example, when performing the

convergence tests). Abaqus will basically generate the script for us, we only have to modify it

(Figure E.14). Follow these steps:

1. When you start building a model, set your working directory to wherever folder it is stored

2. Go to File>Macro Manager and click on "Create". Name your macro and choose "Work"

under "Directory".
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Figure E.13: How to visualise the results of FEA in Abaqus

3. Perform whatever repetitive action you would have to do across multiple models, for

example, create a material and assign it to a section. Stop recording the macro when you

are ready.

4. On your work directory, you will find a python script called abaqusMacros.py, that you can

open on a text editor (just double-click it to open).

5. Delete the line that says "def name of your script():"

6. Delete any blank spaces before the start of a line (hit delete/backspace 4 times in all cases)

7. Save your file and copy across to the other folders where you have your other FE models/CAE

files

8. Open another CAE file which, in this example, does not have assigned material properties.

Set the working directory, and go to File>Run Script and open your script.

9. Automatically, whatever instructions were in your script have now been reproduced in this

new model. In this case the material properties have been assigned to your jaw, without

you manually needing to do it.
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Figure E.14: How to edit python scripts for their use in Abaqus

10. I use python scripts for creating and assigning material properties, constraining, loading,

generating new CSYSs, writing field output reports and saving the von Mises stress

heatmaps. Some scripts do not need to be modified on a case by case basis and can be

copied across multiple models (like creating and assigning material properties) but some

others, like loading and constraining muscles and saving field output reports need to be

"personalised". In the case of the field outputs, you need to modify the script to change the

directory your file will be stored in. In the case of loading and constraining the muscles you

need to check the "ID" of the corresponding CSYSs before running the script, you can get

this ID with the Query Information tool in the toolbar and then update it accordingly in

the script.
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